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About This Manual 

This guide tells you how to use CHAOS: The Software to explore 
and demonstrate aspects of chaos theory. 

• The Introduction includes James Gleick's introduction to 
CHAOS: The Software and biographical information about 
James Gleick. 

• Chapter 1 tells you how to install the software and use 
menus, buttons, and fie lds to work with the CHAOS pro­
grams. It's important for you to become familiar with t he 
concepts covered in chapter 1 before continuing with the 
chapters on CHAOS programs. 

• Chapters 2 through 7 are specific guides to each of the six 
programs in CHAOS. You can use the CHAOS programs 
and their corresponding chapters in any order. 

Each chapter begins with James Gleick's introduction to 
the chaos theory demonstrated by the program and h is 
suggestions for "Th ings To Try" with the program . Next, 
you explore the program with step-by-step instructions. In 
later sections, you read about each feature and option of 
the program. Each chapter concludes with Rudy Rucker's 
discussion of the mathematics of that part icular program. 

• Chapt r 8 describes how to save and load files and how to 
use color options-features common to most of the six 
CHAOS programs. Each chapter refers you to chapter 8 for 
this information. 

• At the end of the book, you'll find liThe Genesis of CHAOS: 
The Software" by Rudy Rucker and biograph ical informa­
tion about Rudy Rucker. You'll also find a bibliography on 
chaos theory and an index. 



Conventions Used in This Manual 

Conventions Used in This Manual 

This manual uses the following typographical conventions: 

Keys you press on the keyboard are represented by 
symbols tha t look like the top of the key. For exam­
ple, the symbol to the left represents the n key. 

When you see two key symbols with a + symbol 
between them, you press both keys at the same 
time. For example, the symbols to the left mean 
you hold down the ( Shift ) key while you press the 
o key. 

Keyboard shortcut: CD 

cd \chaos 

In addition to using the mouse and on- creen but­
tons to select options and feahlfes in CHAOS pro­
grams, you can also use keyboard shortcuts. Key­
board shortcut appear below section titles. For 
example, in The Chaos Game program, you see 
Keyboard shortcut: CD below the section t itle 
"Adding Maps." You can press CD as the shortcut 
for adding maps. 

This symbol represents the Return (or Enter) key 
on your keyboard. 

Text you enter appears in boldface type as shown 
in this example. 
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Introduction 

"Probably the main reason these ideas are only now being discov­
ered is that the style of explorat ion is entirely modern," Douglas R. 
Hofstadter wrote a decade ago. "The digital computer plays the 
role of Magellan's ships, the astronomer's telescope, and the phys­
icist's accelerator. /I 

Those were almost the first words I ever read about chaos, then a 
virtually unknown movement in science beginning to uncover 
strange and wonderful patterns that underlie the apparent disor­
der in nature. Yet even today, the extraordinary role played by 
computers in the birth of the science of chaos often goes unappre­
ciated. 

Computers alone were not enough . What finally broke through 
the traditional barriers to understanding turbulence, wildness, 
erratic flows of all kinds was a new style of using computers. 
Instead of treating these big electron ic monsters as problem­
solving devices, a few scientists started to use them as tools for 
exploration . Instead of feeding in gigantiC problems on punch 
cards and waiting for a solution to come out, a few scientists began 
simply to tinker, to fidd le, to play in areas where it was not even 
clear exactly how to specify the problem. 

This new style of exploring via computer required one thing above 
all: graph ics. Again and again in the young history of this new sci­
ence, computer graphics played a key role in the process of discov­
ery. Researchers were able to see patterns that would have 
remained hidden in the numbers on their sheaves of printout. And 
they were able to make slight changes in key parameters-the fer­
t ili ty rate of a wildlife population, or the driving energy in a turbu­
lent fluid-and watch as new patterns emerged before their eyes . 

The kind of computing power available to just a few scientists a 
decade ago has now arrived on everyone's desktop. The set of pro­
grams collected here are not watered-down approximations, but 
fully realized versions of the programs that gave rise to the most 
important discoveries of the science of chaos . 

3 



Introducing james G/eick 

A word that is often heard in late-night discussions of the new sci­
ence is intuition. An appreciation of chaos changes one's intuition 
about the world- one's sense of the orderly and disorderly possi­
bilities lurking in any complex system. 

It is my hope that people who use these programs, who explore the 
strange worlds waiting within them, will experience t his change in 
intuition. I believe that interactive, hands-on exploration reveals 
the magic of chaos in ways that neither photographs nor even 
motion pictures can match. 

To begin to understand fractal images, Mandlebrot sets, strange 
attractors, and the other strang beasts in the chaotic menagerie­
and to understand something about how they were discovered-it 
is necessary, fi rst of all, to play. 

James Gleick 
11 October 1990 

Introducing James Gleick 

• 

4 In troduction 

James Gleick, a former editor and reporter for the New York Time, 
is the author of Chaos: Making a New Science (Viking Penquin) . 
Chaos won a 1987 National Book Award nomination in nonficti on 
and has been translated into sixteen fore ign languages. Gleick is a 
native New Yorker and a graduate of Harvard College. His current 
project is a biography of the physicist Richard Feynman . 



Chapter 1 

Getting Started with 
CHAOS: The Software 

This chapter tells you what equipment you need to run CHAOS: 
The Software, how to install the software, how to start the pro­
grams, and how to work with menus, buttons, and entry fields 
using either a mouse or the keyboard . The chapters on individual 
CHAOS programs assume you've read chapter 1 and know the 
basics of working with the programs. 

Required Equipment 

CHAOS: The Software requires the following minimum equip­
ment: 

• IBM® PC/XT, PC/AT®, 100-percent-compatible personal 
computer, or an IBM Personal System/2® 

• Dual floppy disk drives or a hard disk and single floppy 
disk drive 

• PC-DOS® 2.0 or later 

• 640K of memory 
• IBM Enhanced Graphics Adapter (EGA) and an Enhanced 

Graphics Monitor or IBM Video Graphics Array (VGA) 
with color monitor 

Note: CHAOS should work without conflict with most device 
drivers and terminate-and-stay-resident (TSR) programs. However, 
if you notice problems while runn ing CHAOS, try removing any 
TSRs or device drivers and reboot the computer. 

Optional Equipment 

The following eqUipment is not required, but is recommended: 

• Microsoft®-compatible mouse 
• 8087, 80287, or 80387 math coprocessor 

• 
5 



The CHAOS Package 

The CHAOS Package 

Your CHAOS package includes the following items: 

• This manual 
• Quick Reference Card 

• CHAOS program diskettes 
• License Agreement 

• Registration Card 

Installing CHAOS on a Hard Disk 

CHAOS: The Software comes with an installation program that 
prompts you as you install CHAOS. 

Follow these steps to use the Install program: 

1. Place disk 1 in your floppy disk drive and dose the drive 
door. 

2. Make that floppy disk drive the current one. For example, 
if you are in the root directory on drive C and disk 1 is in 
drive A, enter the following: 

a:B 

3. Start the installation program by entering this command: 

install B 

4. Follow the on-screen instruct ions to install CHAOS. 

Installing CHAOS on Floppy Disks 

6 Chapter 7 

If you don't have a hard disk, you can install CHAOS on a dual­
floppy-disk computer. Instead of starting CHAOS programs from a 
single opening menu, you run each CHAOS program directly from 
the disk. 

When you install CHAOS on floppy disks, you can install one or 
more of the six CHAOS programs on each disk (depending on the 
size of the disk format you use). The Install program verifies that 
there is enough room on the disk before it attempts to install the 
selected program. 



--

Increasing the Size of the Environment Space 

To install CHAOS, you'll need several blank, formatted disks. 

Follow these steps to use the Install program to install CHAOS on 
floppy disks: 

1. Place disk 1 in drive A and close the drive door. 

2. Make drive A the current drive by entering the following: 

a:G 

3. Place a blank, formatted disk in drive B and close the drive 
door. 

4. Start the installation program by entering this command: 

install G 

5. Follow the on-screen instructions to install CHAOS. 

6. Label the disk from drive B with the name of the CHAOS 
program you installed on that disk. 

7. Run the Install program multiple times to install all six 
CHAOS programs. 

Increasing the Size of the Environment Space 

By default, DOS reserves 128 bytes for the environment space. If 
insufficient room has been set aside for the environment space, 
you will see the following message when you boot your computer: 

Out of environment space 

If you are running DOS 3.2 or above, you can set an environment 
variable or specify a SHELL statement in your config.sys file that 
allocates more space for setting the environment variables. For 
example, with DOS 3.2 you can use the following statement: 

SH ELL=c:\command.com /e:750 /p 

This SHELL statement tells DOS which command interpreter to use 
when booting, and to expand the DOS environment space beyond 
its 128 byte default to 750 bytes. Refer to your DOS manual for 
more information about environment space, the SHELL command, 
and your config.sys file . 

http:SHELL=c:\command.com


Starting CHAOS on a Hard Disk Computer 
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Starting CHAOS on a Hard Disk Computer 

Chapter 7 

To start CHAOS: The Software on a hard disk computer, follow 
these steps: 

1. Make sure you're in the directory in which you installed 
CHAOS. The \chaos directory is the default the install pro­
gram suggests. If you are currently in another directory on 
the same drive, enter this at the DOS prompt: 

cd \ chaos B 

Note: If you used another name for the CHAOS directory, 
enter t hat name instead of \chaos. 

2. Start CHAOS from the \ chaos directory by entering this 
command: 

chaos B 

You briefly see a message screen, and then the CHAOS Main menu 
appears. 

The Main menu displays six round program icons that represent the 
six CHAOS programs. There are also six buttons labeled with the 
names of the CHAOS programs and an Alt-X to Exit button that lets 
you quit to DOS. 

To start one of the CHAOS programs, select its program icon or the 
button labeled with the program name. For information on how 
to select buttons and icons, see "Selecting Buttons and Icons" on 
page 9. You can also press the number next to the program name 
to start the program. For example, to start The Mandelbrot Sets, 
press CD. 

Note: You can also bypass the CHAOS Main men u to start an 
individual CHAOS program directly. To do so, make sure you're in 
the chaos directory, then enter the name of one of the program 
batch files listed in "Starting CHAOS from a Floppy Disk" on page 
9 and press B. 



Starting CHAOS from a Floppy Disk 

Starting CHAOS from a Floppy Disk 

To start a CHAOS program from a floppy disk, follow these steps: 

1. Place the disk containing the program you want to start in 
drive A and close the drive door. 

2. Make drive A the current drive by entering the fo llowing: 

a:8 

3. Enter the batch filename for the program you want to start 
and press 8 . 

Batch File Name 

mandel 

magnets 

attract 

game 

forge 

toy 

Selecting Buttons and Icons 

Program Name 

The Mandelbrot Sets 

Magnets and Pendulum 

Strange Attractors 

The Chaos Game 

Fractal Forgeries 

Toy Universes 

You can choose most CHAOS options by selecting buttons . You 
can select buttons with the mouse or the keyboard. 

If you've installed a mouse with CHAOS, you can work with it 
exclusively or use it in combination with keyboard commands. For 
actions such as selecting buttons, you'll find the mouse more con­
venient to use. 

To select program icons and buttons with a mouse, fo llow these 
steps: 

1. Move the mouse until the on-screen pointer (usually 
shaped like an arrow) is on the icon or button. The high­
lighting around the current button changes to indicate 
that it is selected. 

2. Press the left mouse button and release it quickly. 

Getting Started with CHAOS: The Software 9 



Getting Help in the CHAOS Programs 

Note: From now on, when you're instructed to select an icon or 
button, move the pointer to the button or icon and click the left 
mouse button. This action is called "left-clicking." (Most actions in 
CHAOS require that you press the left mouse button.) 

To select program icons and buttons with the keyboard, follow 
these steps: 

1. Move the pOinter or cursor to the icon or button you want 
to select. 

Depending on where you are in a CHAOS program, you 
can move around with the following keys: 

• E), 8, (!), 0 
• (Tab) . ~,~ 
• (Home ), (End) 

The pOinter indicates your current location. As you move 
the pOinter from button to button, their highlighted edges 
change to indicate which button is currently selected. 

2. When the cursor is at the button you want to select, press 
8· 

An alternative way to select buttons is to use function keys and 
keyboard shortcuts. Many buttons in CHAOS programs are labeled 
with a function key that you can press to select the button. For 
example, to select the Fl HELP button, you can press ill). Other 
buttons have a keyboard shortcut that performs the same action as 
the button. For more information about keyboard shortcuts, see 
"Using Keyboard Shortcuts" on page 15 . 

Getting Help in the CHAOS Programs 
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Keyboard shortcut: ill) 

On-line help is available in all CHAOS programs. CHAOS on-line 
help includes useful reference material on keyboard commands, 
program menus, and program terminology. 

CHAOS displays help appropriate to your current location in a pro­
gram. For example, if you're using an Options menu and request 
help, you get help specific to that menu. 



Getting Help in the CHAOS Programs 

• Select the Fl HELP button or press CID to display on-line 
help. 

Help text appears in a window on screen. The following illustra­
tion shows a CHAOS help window: 

LOAD PARAMETERS: [Alt-l] 
The paraMeter files are onlU a few 
hundred bUtes in size. When uou 
reload a paraMeter file, the iMage 
is live, Meaning that all the prograM 
paraMeters have been set to the saved 
values. This is useful for repeating 
experiMents or deMonstrations. Since 
paraMeter files are so sMall, theU 
are good for exchanging with friends 
who have their own copU of JAMES 
GLEICK'S CHAOS: THE SOFTWARE. ParaMeter 
files are in fact text files, so 
uou can edit theM with uour word 
processor. 

earch: ~ ESC to Cancel 
~==-===-=~==~~ 

Search field 

Scroll box 

Scroll bar 

Scroll arrows 

U sing Scroll Bars 

41 

The scroll box, a rectangular box in the scroll bar, indicates your 
location in the help text. If the scroll box is at the top of the scroll 
bar, you're at the beginning of the text. The size of the scroll box 
is relative to the length of the text. A small scroll box indicates that 
you currently see a small portion of the help text. If the scroll box 
is half the length of the scroll bar, then one half of the help text is 
visible in the window. 

You can use the mouse or keyboard to scroll the text in the win­
dow. 

To scroll with the mouse, do one of the following: 

• Left-click on the scroll arrows above or below the scroll bar 
to move text up or down a line at a time. 

• Left-click in the scroll bar above or below the scroll box to 
move text a page at a time. 

• Hold down the left mouse button and drag the scroll box 
up or down to move text more quickly in the window. 
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Getting Help in the CHAOS Programs 

To scroll using the keyboard, do one of the following: 

• Press ffi or (!) to move text up or down a line at a time. 

• Press ~ or ~ to move text a page at a time. 
• Press (End ) or ( Home) to move to the end or beginning of the 

help text. 

Searching for Help Text 

You can use the Search field to locate specific text in the help win­
dow. To use the Search field with a mouse, follow these steps: 

1. Left-cl ick in the Search field. The Search field changes col­
or and a block cursor appears. 

2. Enter the text you want to find. 
3. Press 8. The line where the text appears is highlighted 

and displayed at the top of the help window. 
4. Press CD followed by 8 to locate the next occurrence of 

the search word. 
S. Press CD followed by 8 to search backwards. 

To use the Search field with the keyboard, follow these steps: 

1. Press CD to search forward or press CD to search backward. 
The Search field changes color and a block cursor appears. 

2. Enter the text you want to find. 
3. Press 8. The line where the text appears is highlighted 

and displayed at the top of the help window. 
4. Press CD followed by 8 to locate the next occurrence of 

the search word. 

S. Press CD followed by 8 to locate the previous occurrence 
of the search word. 

Exiting the Help Window 

To exit the help window 

• Right-click anywhere in the help window or press ~ . 

• 
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Changing Options and Parameters in CHAOS 

Changing Options and Parameters in CHAOS 

You work in the CHAOS programs by changing options and 
parameter settings to create new images or simulations. You can 
change settings in CHAOS five ways: 

• Using buttons 
• Using entry fields 
• Using plus ( + ) or minus ( - ) buttons 
• Using horizontal slider bars 
• Using keyboard shortcuts 

U sing Buttons 

Menu buttons 

Throughout the CHAOS programs, you choose menu items and 
change many options by selecting buttons. The opening screen of 
each program has a set of menu buttons in the upper-left side of 
the screen. For example, the opening Mandlebrot program screen 
looks like this: 

You can select buttons with either the mouse or the keyboard, as 
described in "Selecting Buttons and Icons" on page 9. 
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Changing Options and Parameters in CHAOS 

Using Entry Fields 

You can assign specific values to many CHAOS options and param­
eters by entering information in entry fields. Following is an exam­
ple of an entry field: 

To use entry fields with the mouse, fo llow these steps: 

1. Left-click on the entry field. The field turns a different col­
or and a block cursor appears in the field. 

2. Press (Ctrl 1 + (]J or use the ( Backspace 1 key to delete the cur­
rent entry. 

3. Type the new entry and press 8. 

To use entry field s with the keyboard, follow these steps: 

1. Move the cursor or highlighting to the entry field. 

2. Press 8. The field turns a different color and a block cur­
sor appears in the field . 

3. Press (etrl l+(]J or use the ( Backspace 1 key to delete the cur­
rent entry. 

4. Type the new entry and press 8. 

Using Plus (+) and Minus (- ) Buttons 

14 Chapter 7 

Some parameters in CHAOS programs have plus (+) and minus (-) 
buttons that you can use to increase or decrease the value of the 
parameter. For example, in Toy Universes, the Number option on 
the opening screen looks like this: 

To use plus and minus buttons with a mouse 

• Left-click the plus (+) or minus (-) button next to the pa­
rameter name. 

To use plus and minus buttons with the keyboard 

• Move the cursor or highlighting to the plus or minus but­
ton and press 8. 



Changing Options and Parameters in CHAOS 

U sing Horizontal Slider Bars 

Some CHAOS parameters have horizontal slider bars for making 
adjustments. For example, the Palette Editor used in most CHAOS 
programs includes three slider bars: 

R 
G 
B 

To use slider bars with the mouse, follow these steps: 

1. Move the pointer to the slider inside the slider bar. 
2. Hold down the left mouse button and drag the slider to the 

right or left. The parameter value changes to reflect the 
new position of the slider. 

Some slider bars have a set of six decrease/increase buttons below 
the slider. For example, the Fractal Dimension parameter in t he 
Fractal Forgeries program includes a slider bar that looks like this: 

Fractal Di~ension 

--------.J 
2.6~ 

F=-= ~,-=- r-+ r++ r+++ 

You can left-click these decrease/increase buttons to move the 
slider. The greater the number of plus or minus sym bols, the larger 
the move. 

To use slider bars with the keyboard, follow these steps: 

1. Move the cursor to the slider bar. 

2. Press CB or G) to move the slider to the left or right. 
3. Press ( Shift ) + CB or ( Shift ) + G) to move the slider to the left 

or right in larger increments. 

Using Keyboard Shortcuts 

Many options and features in the CHAOS programs have keyboard 
shortcuts. For example, in The Chaos Game, you can display the 
next image by selecting a button or pressing QD , the keyboard 
shortcut. Even if you're using a mouse, you 'll find it more conve­
nient to use the keyboard shortcut for many features. 
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Exiting CHAOS Programs to the Main Menu 

Whenever possible, the shortcut is the first letter of the feature or 
option it represents. For example, in Fractal Forgeries, the shortcut 
for Animate is IT) . 

In some cases, the uppercase le tter shortcut means the opposite of 
the lowercase letter shortcut: in The Chaos Game, 0 displays the 
next image and GElliJ +0 displays the previous image. In cases 
where you can increase or decrease a parameter, the lowercase let­
ter shortcut decreases the parameter and the uppercase one 
increases the parameter. For example, in Magnets, you can 
decrease the Friction parameter by pressing CD ; you can increase 
the friction by pressing ( Shift ) + CD . 

All six CHAOS programs have common keyboard shortcuts, but 
each program has additional unique shortcuts. The on-line help 
and the quick refe rence card list the shortcuts for each program. 
You'll also find a keyboard shortcut listed in the manual below the 
title of the section describing the feature or parameter. 

Accepting Changes 

Many menus and dia logue boxes in the CHAOS programs have an 
ACCEPT button. You select the ACC EPT button to confirm your 
changes and to exit the menu or dialogue box. 

Canceling Changes 

Many menus and dialogue boxes in the CHAOS programs have a 
Cancel button . You select the Cancel button to cancel your changes 
and to exit the menu or dialogue box. 

Exiting CHAOS Programs to the Main Menu 

• 
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Keyboard shortcut: ~ + CD 

From any CHAOS program, you can quickly exit to the CHAOS 
Main menu: 

1. Select the Alt-X to Exit button. A message box appears ask­
ing you to verify that you want to exit. 

2. Select the Yes button or press CD to exit . 



Quitting to DOS 

Quitting to DOS 

Keyboard shortcut: ~ + CJD 

From any CHAOS program, you can also quit the CHAOS program 
and return to the DOS prompt. 

1. Press ~+OD. A message box appears asking you to ver­
ify that you want to exit. 

2. Select the Yes button or press CD to exit. 

To return to DOS from the CHAOS Main menu 

• Select the Alt-X to Exit button. 
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Chapter 2 

The Mandelbrot Sets 

An eternity would not be enough time to see it all, its disks 
studded with prickly thoms, its spirals and filaments curling 
outward and around, bearing bulbous molecules that hang, 
infinitely variegated, like grapes on God's personal villc. 
Examined in color through the adjustable window of a com­
puter screen, the Mandelbrot set seems more tiactal than frac­
tals, so rich is its complication across scales. A cataloguing of 
the different images within it or a numerical description of 
the set's outline would require an infinity ofinfonnation. But 
here is a paradox: to send a full description of the set over a 
transmission line requires just a few dozen characters of code. 
A terse computer program contains enough information to 
reproduce the entire set . .. (Chaos: Making a New Science, 
page 221.) 

A not-so-terse program like this one allows one to do far more than 
reproduce the Mandelbrot set. It lets users become explorers, look­
ing deeper into the heart of this strange object than any mathema­
tician could, barely a decade ago, when it was first discovered. 
Since then the Mandelbrot set has become an emblem for the new 
science of chaos, adorning everything from coffee mugs to T­
shirts, institutional letterheads to art gallery catalogues. 

The computer becomes both a scanner and a microscope. With 
either a mouse or the keyboard's arrow keys, the user pans across 
the set looking for the intriguing complexity at the boundary, and 
then zooms closer and closer in, revealing even more intricate 
complexity. 

The Mandelbrot set is a collection of points (each representing a 
pair of numbers), shown as black on screen. The colors are like the 
colors on a contour map of a mountainous region; if one th inks of 
the set as a plateau, the colors show how steeply the rest of the ter­
ra in falls away from it. The program creates its images by testing 
every point, every pair of numbers. The test is a simple equation 
repeated over and over again: a pair of numbers goes in, a new pair 
is computed; the new pair goes in, and the equation produces a 
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new pair; and so on. (The mathematical details are described in 
liThe Mathematics of the Program" on page 42.) It is like feedback 
through a microphone and speakers-a sound can fade away, or it 
can grow wildly out of control. If the numbers get larger and 
larger, running away to infinity, the original point does not belong 
to the Mandelbrot set. If the original point is in the set, the num­
bers remain within bounds, either locked in a repeating loop or 
bouncing chaotically from one place to the next, but never escap­
ing. 

Benoit Mandelbrot, the Polish-born mathematician best known as 
the father of fracta l geometry, first discovered this unlikely ob ject 
in 1979. It was a crude, bulbous shape on his black-and-white com­
puter printouts. Bug-like tendrils stretched away from it. Scattered 
pOints lay near the main body, and it was impossible to guess how 
rich the object rea lly was. It was not even clear whether the whole 
set-the black region-was a single connected continent or a loose 
assortment of clustered islands. Mathematicians later proved that 
it is connected- though one can zoom in forever on the fine fila­
ments connecting one bulb to the next without ever seeing the 
whole strand. 

Every place in the set is unique. Though one gradually begins to 
sense the shapes and patterns that reappear in different guises, no 
image ever repeats itself exactly. If one imagines that the full Man­
delbrot set is the size of the Earth 's Solar System, one can zoom in 
to see detail the size of individual molecules. Color becomes more 
and more important, as a signpost showing the way to strands that 
have not yet come directly into view. 

A new kind of geometry has emerged from the exploration of such 
iterated processes- processes that are simple in themselves, but 
create complexity through repetition and feedback. Computers are 
essential, with their ability to repeat computations at h igh speed 
and display the results graphically. Traditional forms of geometry 
take equations and ask what numbers satisfy them-the sets that 
result form the circles, ellipses, and parabola familiar from high­
school geometry. But when a geometer iterates an equation 
instead of solving it, the equation becomes a process instead of a 
description. There is good reason to believe that nature operates 
this way, with simple processes repeated again and again, on large 
scales and small. 

The sheer intricacy of the Mandelbrot set, abstract though it is, has 
already helped change scientists' preconceptions about the world. 
The lesson of the Mandelbrot set is a lesson about boundaries, 
especially the sorts of boundaries that arise in complicated 



Julia Sets 

Julia Sets 

processes. An engineer th inking about the design of a bridge must 
worry about a boundary that exists between safety and catastro­
phe. That boundary depends on such things as the speed of the 
wind and the weight of the load that the bridge must carry. An 
electric power company has to worry about a boundary that exists 
between stability and instability in a network of cables and gener­
ating stations spanning thousands of miles. Or a person trying to 
make a decision between two important, attractive, but incompat­
ible alternatives might imagine a sort of boundary between them. 

And what sort of boundary will they imagine? The point is- and 
it came as a surprise- that such boundaries are not necessarily 
smooth. They may be extremely complicated, so that some slight 
change in circumstances th rows one into an altogether di fferent 
region . A bolt of lightning strikes, or a rat gnaws through a cable, 
and suddenly 20 million households are wondering why the lights 
are out. Indeed, boundaries much like the rim of the Mandelbrot 
set appear in a variety of real physical problems. 

Some are like circles that have been pinched and deformed in 
many places to give them a fractal structure. Others are bro­
ken into regions, and still others are disconnected dusts. But 
neither words nor the concepts of Euclidean geometry serve to 
describe them. The French mathematician Adrien Douady 
said: "You obtain an incredible variety of Julia sets: some are 
a fatty cloud, others are a skinny bush of brambles, some look 
like the sparks which float in the air after a firework has gone 
off . . . /1 (Chaos: Making a New Science, page 221.) 

A simpler, older cousin of the Mandelbrot set is the group of 
objects called Julia sets, after Gaston Julia, an early twentieth­
century French mathematician who conceived them long before 
computers made it possible to see their variety. Julia sets are more 
symmetrical and more straightforwardly fractal- that is, tending 
to repeat their structure on smaller and smaller scales. 

Each Julia set is associated with a single complex number and 
therefore with a single point on screen, its starting pOint. The 
Mandelbrot set itself serves as a sort of guide to Julia sets, a sort of 
catalogue. The most interesting Julia sets are those associated with 
pOints near the rim of the Mandelbrot set . Points in the Mandel­
brot set produce Julia sets that are connected, though sometimes 
with great intricacy, like the Mandelbrot set itself. Points outside 
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Cubic Mandelbrots, Cubic julias, and the Rudy Set 

the Mandelbro t set, however, produce Julia sets that are discon­
nected. They are fractal "dusts," clusters of shapes and specks with 
their own special brand of self-similarity across scales, like stars 
and galaxies scattered and clustered through the universe. 

Cubic Mandelbrots, Cubic Julias, 
and the Rudy Set 
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A few years ago, drawing a Mandelbrot set pushed computers to 
their limits. With new, faster machines widely available, generat­
ing an ordinary Mandelbrot set has become less challenging; one 
can in fact "fly around" a Mandelbrot set in real time on some of 
the larger computers. In order to keep the game interesting, math­
ematicians have proposed a simple change in the formula used to 
define the Mandelbrot set : replace an exponent of two by an expo­
nent of three. The new formula leads to the cubic Mandelbrot sets 
and the cubic Julia sets. 

There is only one standard Mandelbrot set, but there are infinitely 
many cubic Mandelbrot sets. By changing two control parameters, 
one can scan through a "stack" of these sets and imagine piling 
them up to produce a three-dimensional (or even a four-dimen­
sional[) fractal object. 

The cubic Mandelbrot sets have their own special symmetry, the 
symmetry of a letter S rather than the symmetry of a letter D. Each 
of them has the full richness of the standard Mandelbrot set; 
remarkably enough, many of them contain small copies of the 
standard Mandelbrot. By varying one of the control parameters, 
one can occasionally make the small Mandelbrots split open like 
ri pe seedpods. 

Associated with each point of a cubic Mandelbrot set is a cubic 
Julia set. These objects can be wholly asymmetrical, and some of 
them break into several separate connected pieces. The visual 
investigat ion of these objects has only just begun, and many new 
shapes are waiting to be found . 

Mathematicians with computers are a bit like explorers with ships, 
and like explorers they enjoy naming new features of their esoteric 
terrain. In the process of writing the algorithms for computing the 
cubic Mandelbrot sets, Rudy Rucker saw a way of combining infor­
mation about all of these sets into a single set, which he then 
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Slarting the Program 

dubbed the Rudy set. This set exists in the parameter space of the 
cubic Mandelbrot sets; choosing cubic Mandelbrot settings from 
inside the Rudy set leads to cubic Mandelbrot sets that are non­
empty. 

Things To Try 

Zoom in agai n and again on the interesting regions of the bound­
ary (use the left mouse button or press ~). Change the color pal­
ette (press @+0) or the width of the color bands (press CR)) 
to reveal new featu res of the landscape . The small windows at the 
left show where you've been, and left-clicking one of them returns 
you to that image. 

You can explore a new fractal type by pressing IT) for a Cubic 
Mandelbrot set or CD for the Rudy set. Pressing GD returns you to 
the Mandelbrot set. From any place in the Mandelbrot set, you can 
see the corresponding] ulia set by pressing Q). 

Starting the Program 

When you start The Mandelbrot Sets, you see the following screen: 

Mandelbrot Set --I!! 

Zoom cursor - --I 

Stamp outlines 
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Exploring the Program 

The main image area of the screen shows the Mandelbrot set, a com­
plex, two-dimensional object showing equations repeated again 
and again. The small white box in the middle of the Mandelbrot 
set is the zoom cursor. 

On the lower left, you see four rectangular outlines called stamps. 
The program stores stamp-sized versions of your four most recent 
images in the stamp outlines. 

Note: The program paints the screen four times (coarse to fine) to 
paint all the pixels in a fractal image. You can make changes to an 
image any time while the program is painting it. 

Exploring the Program 
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You can have fun exploring the five kinds of sets mentioned at the 
start of this chapter. Try out several fea tures without worrying 
about understanding each feature thorough ly. You learn how to 
use these features later in th is chapter. 

Suggestion: Use the parameter status line when you first work with 
the program, to help you identify different types of sets. To display 
the parameter status line, press ~+CD twice (until you see the 
name of the current set on the left side of the status line). for 
details on the status lines in this program, see "Status Line" on 
page 41. 

First, display other sets in the program. 

1. Start by pressing CD to change from a zoom cursor to a se­
lect cursor. 

2. With the Mandelbrot set displayed at the start of the pro­
gram, press QJ to display a Julia set. 
Notice the stamp image that appears in the lower- left 
stamp outline. For details on stamps, see "Using Stamps in 
the Program " on page 26. 

3. The Julia set you see depends on the select cursor's posi­
tion. Try moving the sel ct cursor and left-clicking to see a 
different Julia set . 

4. Press CD to display a cubic Man delbrot set. 

S. Press CD to display the Rudy set. 
6. Press (ill to display the Mandelbrot set again. 
7. Return to the fi rst cursor in the program, the zoom cursor, 

by pressing CD again. 



Moving Around in the Image Area 

Next, try some of the color options in The Mandelbrot Sets. 

1. With the Mandelbrot set displayed, press em to change 
the fill type to Bullseye fill. Press em again to change to 
Feathers fill. Press em again to return to Blank fill. 

2. Press alD +Q) to change the image's color. Cycle through 
add itional color options for the image by contin uing to 
press alD +Q) . 

3. Press alD + m to return to the default color palette. 

You can experiment with sound, too. 

1. Press CD to display a cubic Mandelbrot set. 
2. When the program begins to paint the set, press alD + m 

to turn sound on, and watch all four screen-paints. You 
hear the tone change as the scan lines move to new colors. 
The tone becomes complex-sounding as the lines move 
over multicolored areas. 

3. Left-click or press ffiJ to zoom in once, and listen to the 
tone as the program pain ts the magnified image. 

4. Press alD+m to tum the sound off again . 

Moving Around in the Image Area 

.. 

You can use the mouse or the keyboard to move the cursor around 
in the image area. To move arou nd using the keyboard, make sure 
( Num Lock ) is turned off and refer to the following illustration: 

t 

Numeric keypad keys and direction of cursor movement 
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Using Stamps in the Program 

Using Stamps in the Program 
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The Mandelbrot Sets program generates stamps for changes you 
make, such as zooming in or selecting a new type of set. (The pro­
gram does not generate stamps when you make changes to the pal­
ette.) You can select one of the four images stored in the stamps to 
display in the image area. 

1. Move the cursor to the stamp you want. 
2. Left-click or press (2) to display the new image. 

You can also press @+CD, @+CI) , @+G), or 
@ +GJ to select a stamp image to display in the image 
area (with stamp 1 being at the bottom and stamp 4 at the 
top). 

You can also get parameter information on any of the four stamp 
images. 

1. Right-click on a stamp icon to view the parameter informa­
tion. 
lf you're not using a mouse, you can press @+G) , 
@+W, @+W, or @+CID to display a stamp in for­
mation box (with stamp 5 being at the bottom and stari_p 
8 at the top). 

2. When you've read the pa rameter information, click either 
mouse button or press any key to remove the stamp infor­
mation box from the screen. 
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Zooming, Panning, and Centering 

Zooming, Panning, and Centering 

Zooming In on an Image 

You can zoom in on areas that interest you. For example, you 
might want to examine self-similar areas in greater detail. 

1. Move the zoom cursor (the small white box) to the loca­
tion you want. (The cursor location becomes the center of 
the magnified image.) 

2. Left-click or press ~. 

3. To zoom out, right-click or press @ill . 

Note: Normally, The Mandelbrot Sets program runs in fast mode. 
When you zoom down to small sizes, the program must switch to 
a slower mode. A low-pitched beep signals when the program 
switches to the slower mode, and a high-pitched beep signals 
when the program switches back to the fast mode. 

In addition to using the regular zoom cursor, you can use the zoom 
box. You can resize the zoom box to enclose any area you want to 
magnify. 

1. Press @D+CD or the spacebar to display the zoom box 
cursor. 

2. Move the zoom box to the location you want to zoom in 
on. 

3. Hold down the ( Shift )key and move the mouse to resize the 
zoom box. 
You can also resize the zoom box using the keyboard . 
Make the zoom box larger by pressing ( Shift) + (!) or 
( Shift) + CB . Make it smaller by pressing ( Shift) + ill or 
(Shift )+8 . 

4. Left-click or press ~ to zoom in on the specific area. 
S. With the zoom box displayed, you can also zoom out by 

right-clicking or pressing @ill. (After you zoom in or out 
with the zoom box, the cursor you were previously using 
reappears.) 

6. If you change your mind when working with the zoom 
box, you can press ~ to return to the cursor you were 
previously using. 
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Zooming, Panning, and Centering 

Zoom Box Status Line 

When you turn on the zoom box and move the cursor, a status line 
automatically appears. You can use the zoom box status line to cal­
ibrate the exact size of a window fo r zooming. The first two num­
bers in the status line show the X and Y coordinates that mark the 
center of the zoom box; these numbers change constantly as the 
cursor moves. The third number shows the width of the window 
you are defining with the zoom box. The window-width number 
changes as you enlarge or shrink the zoom box to define the win­
dow. 

Panning an Image 

When you pan an image, you can see the parts of it that are outside 
the edges of the image area. For example, you might want to pan 
after you zoom in to a "fringe" part of an image. 

1. Move the cursor to the location you want to pan to. (The 
cursor location becomes the center of the panned image.) 

2. Press (ill + @) to pan to the new location. 

Centering an Image 

• 
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As you work with images, you might feel unsure of where you are 
in the set. Centering an image moves it to the center of the image 
area, unzooms it, resets any parameters you've changed, and resets 
the fractal type to either Mandelbrot or cubic Mandelbrot. 

• Press ITJ. 

You can also center an image without resetting parameters. 

• Press (ill + ITJ· 



Displaying Sets with the Select Cursor 

Displaying Sets with the Select Cursor 

You can change from the zoom cursor to the select cursor (a white 
box with a diamond inside) and choose other types of sets to dis­
play. 

Note: You cannot display the Rudy set by using the select cursor. 

To use the select cursor to display other sets, first do the following: 

1. Press CD to display the select cursor. 
2. Move the cursor to the area whose parameters you want to 

use to calculate the new set. 

The following table describes how to work with the select cursor. 

If You Want And You Currently Do 
To Display . .. Are Displaying . . . This 

Mandelbrot Julia Right-click or 
press @ill 

Julia Julia or Mandelbrot Left-click or 
press 0!iU 

Cubic Mandelbrot Cubic Mandelbrot, Right-click or 
Rudy, or Cubic Julia press @ill 

Cubic Julia Cubic Julia, Rudy, or Left-click or 
Cubic Mandelbrot press 0!iU 

Creating New Images 

The Mandelbrot Sets program lets you create variations of the five 
types of sets in it. For the Mandelbrot and Rudy sets, you can alter 
only the fill type. For the other sets, you can tweak additional 
parameters that change the shapes of the sets. 

Viewing Preset Images 

The program comes with 21 pr set images that are variations on 
the basic sets. These preset images give you a good idea of some of 
the images you can create. 

1. Press alD + CID to view the first preset. 
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2. Continue to press aJD +CID to view all 21 presets. 

Note: You can also press GJ to cycle forward through presets one 
at a time, or G to cycle backward. 

Selecting Fractal and Fill Types 

To create a new image, begin by selecting the fractal type and fi ll 
type you want. A fractal type is an ob ject such as a Julia set, the 
Rudy set, and so on. A fill type is a pattern of colors (or no colors) 
that you add to the interiors of Mandelbrot, Rudy, and cubic Man­
delbrot sets only. 

To select fractal and fill types, left-click the F3 Types button at the 
upper-left corner of the screen, or press CIT). The Types menu 
appears: 

ractal: 

Fi II: 

F1 for HELP ESC to Cancel ACCEPT [.J 

Selecting a Fractal Type 
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The Mandelbrot Sets program has five different fractal types for 
you to explore. To display the fractal type you want, select one of 
the fo llowing buttons on the Types menu: 

• Mandelbrot 

• Julia 

• Rudy 

• Cu bic Mandelbrot 

• Cubic Julia 

You can also select a fractal type with keyboard shortcuts (shown 
in the sections that follow), or with the select cursor. For details on 
using the select cursor, see "Displaying Sets with the Select Cursor!! 
on page 29. 
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Mandelbrot 

Keyboard shortcut: eM) (with any set displayed) 

The Mandelbrot set is made up of a collection of points (the black 
middle area), each of which represents a pair of numbers. Th pro­
gram creates its image of the set by testing each pair of numbers 
repeatedly. 

Julia 

Keyboard shortcut: CD (only wit !.) a Julia set or the Mandelbrot set 
displayed) 

A Julia set is a two-dimensional fracta l object formed by an itera­
tive process similar to that of the Mandelbrot set. All Julia sets are 
symmetric about the origin, like the le tter s. In connectedJu lias, you 
can reach every part from every other part. In disconnected JuHas, 
there is no all-black path from any point to any other pOint. 

Here's an example of a connected Julia set: 
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And here's an example of a disconnected Julia set: 

Suggestion: Explore connected and disconnected Julia sets. With 
the select cursor displayed, move the cursor into the black interior 
of the Mandelbrot set. Left-click or press 0!iU to see a connected 
Julia set. Right-click or press @ill to return to the Mandelbrot set. 
Then move the cursor to an area far outside the Mandelbrot set. 
Left-click or press 0!iU to see a disconnected Julia set. 

Rudy 

Keyboard shortcut: CD (with any set displayed) 

The Rudy set tries to catalogue all the cubic Mandelbrot slices. 

Suggestion: The details of the Rudy set are quite complicated. With 
the zoom cursor displayed, try zooming in on any of the set's 
edges. Then, with the select cursor displayed, move the cursor into 
the black interior of the set. Right-click or press @ill to see a 
nonempty cubic Mandelbrot. Press CD to display a Rudy set again, 
and repeat the experiment with a different cursor location in the 
black interior. 



-

-

-
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Cubic Mandelbrot 

Keyboard shortcut: CD (with any set displayed) 

A cubic Mandelbrot is made up of a collection of points, each of 
which represents a quadruple of numbers-the A, B, U, and V 
parameters. Two of the parameters are the same for each pOint, and 
two vary from pixel to pixel. The program creates its images by 
repeatedly testing each quadruple of numbers. 

Cubic Julia 

Keyboard shortcut: Q) (only with the Rudy set or a cubic 
Mandelbrot set displayed) 

Like Julia sets, cubic Julias can be either connected or totally dis­
connected. There is also a third possibility: cubic Julias can be 
partly disconnected, meaning that they break up into distinct solid 
chunks. Unlike Julia sets, cubic Julias can be completely asymmet­
ric. 

Here's an example of a partly disconnected cubic Julia set: 
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Selecting a Fill Type 

CHAOS lets you choose from three different fill types- Blank, 
Bullseye, and Feathers-for the interior of the Mandelbrot, Rudy, 
and cubic Mandelbrot sets. The Blank fill type (no pattern of col­
ors) is the defau lt in the program. The Bullseye fill type displays a 
pattern of concentric colors, like contour lines on a map. The 
Feathers fill type is a pattern of plume-like or fan-like colors. 

To display the fill type you want, select one of the follow ing but­
tons on the Types menu: 

• Blank 

• Bullseye 

• Feather 

You can also use a keyboard shortcut to cycle through fills for the 
Mandelbrot set. 

• Press 00. 

You can cycle through fills for the Rudy set. 

• Press CD. 

And you can cycle through fills for cubic Mandelbrot sets. 

• Press CD. 

Note: For more details on the calculat ions for fill types, see liThe 
Mathematics of the Program II on page 42. 

Tweaking Parameters 
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You can use the Tweak menu to adjust an image the way you want. 
You can also enter published parameters using the Tweak menu. 
For example, you can enter the following parameters to see the 
region known as Peitgen's Shepherd Crook in the Seahorse Valley 
of the Mandelbrot set: X = -0.7452; Y = 0.1126; W = 0.008; 1=300. 

CHAOS lets you tweak these parameters: 

• X, Y, and W (for position and width of the window 
through which you view sets) 

• A, B, U, and V (for sha pes of cubic Mandelbrots, Julias, and 
cubic Julias) 

• J (for iteration count controlling the speed and accuracy of 
calculations) 
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Note: For the W parameter, and fo r the A, B, U, and V parameters, 
you can enter a setting in exponential notat ion, such as 7.8e-06. 
If you enter a setting in decimal figures, such as .00004, the 
program converts it to exponential notation (in this case, 4e- 05) . 

To tweak parameters, left-click the F4 Tweak button at the upper­
left corner of the screen, or press @. The Tweak menu appears: 

Changing the Window Position 

Tweaking the X and Y parameters sets the position for the center 
of the window through which you view all sets. The default setting 
for both X and Y parameters is 0, which centers the image on 
screen. You can enter X and Y parameter settings between - 2 and 
2. 

• Enter the new value for X, Y, or both. Then press 8 . 

Changing the Window Width 

Tweaking the W parameter sets the width of the window through 
which you view all sets. For example, making the window 1/2 as 
big has the effect of zooming in. The default setting for the W 
parameter is 5.6. 

You can enter a W parameter sett ing between le- 60 and 5.6. The 
lowest limit for the W parameter, le- 60, is equal to 1 * 10 -60 (in 
decimal format, this number would be written as a decimal point 
followed by 59 zeros followed by a 1). 
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Note: If you set this parameter to a low value (below I, for 
exam ple), you might see only the black interior of a set . 

• Enter the new value for W. Then press B . 

Changing the Shape of Cubic Mandelbrot Sets 

Keyboard shortcut: ( Shift ) +0 and ( Shift ) +OJ to increase; 
o and OJ to decrease 

You can th ink of a cubic Mandelbrot as a slice of a four­
dimensional object . If you change A, B, or both, you change where 
the program makes the slice. This, in turn, affects the shape of the 
set you view. 

• Enter the new value for A, B, or both. Then press B. 

Note: If you've selected a different slice type from the default UV 
slice, then you use the keys not in the name of the slice type to 
change the shape of the cubic Mandelbrot . For example, if you are 
working with the 40 Slice option set to BU, then you use the CD 
and m keys to change the shape of the cubic Mandelbrot. For 
details on working with 40 slice, see 1/40 Slice" on page 40. 

Changing the Shape of Julia Sets 

Keyboard shortcut: ( Shift ) + OD and ( Shift ) + m to increase; 
OD and m to decrease 

Changing U, V, or both parameters chooses different iteration 
starting-paints within the Mandelbrot set for a Julia set. 

• Enter the new value for U, V, or both. Then press B . 

Changing the Shape of Cubic Julia Sets 
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Keyboard shortcut: 0 , OJ, OD, and m to decrease; 
( Shift ) + 0, ( Shift ) + OJ, ( Shift ) + OD, and ( Shift ) + m to increase 

When you tweak A, B, U, and V parameters for a cubic Julia set, 
you select different constants in the four-dimensional space that 
contains the full four-dimensional object. 

• Enter the new value for A, B, V, V, or any combination. 
Then press B . 



-

-
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Using the Options Menu 

Suggestion: There are so many different cubic Julias that you might 
have trouble finding some of them again. Use the Save Pa rameters 
button on the File menu to save your most interesting parameters. 
For details on saving files, see "Saving and Loading Files" on page 
209. 

Changing the Iteration Count 

Keyboard shortcut: ( Shift ) + CD to increase; CD to decrease 

The I parameter changes the iteration count, which is the maxi­
mum number of steps per pixel that the program uses in its calcu­
lations for sets. When you set high values for I, the program calcu­
lates sets slowly but with higher precision. Setting a high iteration 
count also generally reduces the amount of black on screen. For 
example, some black interiors of sets might turn into spirals of col­
ors. When you set low values for I, the program calculates sets 
quickly but with less predsion. The default settings are 50 for th e 
Mandelbrot and Julia sets, and 20 for the Rudy, cubic Mandelbrot, 
and cubic Julia sets. You can enter an I parameter setting between 
10 and 30000. 

Note: Whenever you zoom in or out, the program estimates a 
reasonable value for the I parameter. If you change the W 
parameter, which sets window width, the program does not 
automatically adjust the I parameter to match it. A good rule of 
thumb in this case is to change the I parameter to about 100 times 
the number of decimal places out to the first nonzero digit in the 
W parameter you set. For example, if you enter .002 for the W 
parameter, you count three places to the right of the decimal, 
multiply 3 * 100, and enter 300 for the new I parameter. 

• Enter the new value for I. Then press 8 . 

Using the Options Menu 

Use the Options menu to turn on color, sound, and status line, and 
to adjust bandwidth, change cursor mode, and make a slice 
through various angles of 40 space. 
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To select options, left-click the F5 Opts button at the upper-left cor­
ner of the screen, or press Cill. The Options menu appears: 

Color 

Auto Cycle: 

Palet e: 

Sound: 

Cursor de: 

4D ursor Irac~lng: 

4D SI ice: 

F1 for HELP ESC to Cancel 

Color Options 

The fo llowing color options are common to five of the CHAOS 
programs. For information on these options, see "Using Color 
Options" on page 214. 

• Color Cycle Once 

• Auto Cycle 
• Palette (Default, Random, Preset, Edit) 

• Monochrome 

Bandwidth 
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Keyboard shortcut: ( Shift ) + 0FJ to increase; 0FJ to decrease 

Changing bandwidth affects the lively, flame-like areas near the 
interior of the sets. Increasing bandwidth pushes the flame-like 
areas out from the interior; decreasing bandwidth pulls them in 
toward the interior. The default setting is 1. You can set bandwidth 
between 0.001 and 32767. 

-



Sound 

Using the Options Menu 

• Enter the new value for bandwidth and press B . You can 
also raise and lower bandwidth by using the CD and G 
buttons next to the Bandwidth option. 

Keyboard shortcut: aID + CD 

When you turn sound on in The Mandelbrot Sets, you hear a tone 
as the pixel-scann ing lines move down through the set in the 
image area. This tone changes as the scan lines move to new col­
ors. Sound becomes especially complex as the scan lines move over 
boundary, or multicolored, areas. When the scan lines are moving 
through a black region, the tone becomes a low buzz. On the 
fourth and final scan of the image, the rising and fa lling of the 
tone is smoother. 

• Select the On or Off button to toggle sound in the program. 

Suggestion: Listen to the sound that the program produces when 
you change the fill type for the Mandelbrot set . With the 
Mandelbrot set displayed, press aID+CD to turn on sound. 
Immediately press @ to change to Bullseye fill and listen to the 
sound as the program scans the image. After the final scan, press 
@ again to change to Feathers fill and listen to the sound for th is 
image. 

Cursor Mode 

Keyboard shortcut: CD 

As you work in this program, you can use the zoom cursor or the 
select cursor. The zoom cursor is a small white box; the select cur­
sor is a white box with a diamond inside. To find out about work­
ing with the zoom cursor, see "looming In on an Image" on page 
27. For details on working with the select cursor, see "Displaying 
Sets with the Select Cursor" on page 29. The default setting is zoom 
cursor. 

• Select the Zoom or Select button to work with the cursor 
you want. 
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4D Cursor Tracking 

4D Slice 

• 
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Keyboard shortcut: ([) 

Turning on 40 cursor tracking when you are working with the 40 
Slice option lets you keep a particular cubic Julia set value at the 
center of the screen as you switch from one plane to another. 
Remember to turn this option off after you finish working with 40 
Slice, or any zoom you make will not work correctly. The default 
setting is 40 cursor tracking turned off. 

• Select the On or Off button to toggle 40 cursor tracking. 

Suggestion: With 40 cursor tracking turned on, work with the 
select cursor to display different cubic Julia sets. First, left-click or 
press ~ to set a cubic Julia set's parameters. Press CD to change 
to a different slice type. (See the following section for a discussion 
of slicing along different planes with the 40 Slice option.) Then 
left-click or press ~ to set different cubic Julia parameters. 
Continue to alternate between pressing CD to change slice types 
and left-clicking or pressing ~ to set different cubic Julia 
parameters. 

Keyboard shortcut: CD to move backward through list of planes; 
( Shift) + CD to move forward through list of planes 

The cubic Mandelbrot sets are all slices of a single 40 object. In 
mathematics, this object is called the Cubic Connectedness Map, 
or CCM. The CCM is the set of all parameter quadruples (A, B, U, 
V) such that the cubic Julia set determined by these parameters is 
connected. 

When you use the 40 Slice option, you can slice the CCM along 
the fo llowing list of planes: UV, AB, AU, BV, BU, and AV. The 
default setting is the UV plane. For details on the CCM and the cal­
culations involved in slicing along different planes, see liThe 
Mathematics of the Program" on page 42. 

• Select the UV, AS, AU, SV, SU, or AV button to slice along 
the plane you want. 

Suggestion: You might want to investigate the different slices of 
cubic Mandelbrots by using the select cursor. Right-click or press 
@ill to try different parameter combinations for a given slice type . 
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Status Line 

• 

Keyboard shortcut: alD + CD 

The Mandelbrot Sets program has three different status lines­
t rack, parameters, and zoom box. You can use the Status Line 
option to turn the track and parameters status lines on and off. 
You might want to work with the status lines off so you can see the 
beauty of the Mandelbrot sets clearly, with no clutter at the bot­
tom of the screen. The default setting is status line turned off. 

Note: For more information on the zoom box status line, see 
"Zoom Box Status Line" on page 28. 

To display the status line you want, select one of the following but­
tons on the Options menu: 

• None 

• Track 
• Params 

The program displays a different track status line depending on the 
cursor mode you're working with. The track status line for the 
zoom cursor shows the X and Y coordinates of the cursor in paren­
theses. These numbers change constantly as the cursor moves. The 
numbers in square brackets show the width that the window will 
be when you zoom in or out. When you turn on this status line for 
the zoom cursor, you can use it to calibrate exactly where you are 
working as you zoom in and out. This might be useful, for exam­
ple, when you try to re-create different Julia sets, or when you try 
to study exactly the same spots in the Mandelbrot set. 

When you work with the select cursor, the track status line shows 
how the A, B, U, and V parameter settings change relative to the 
current 40 Slice option. The parameter settings appear beside 
uppercase A=, B=, U=, and V= in the status line. For example, if you 
set 40 Slice to AU and display a cubic Mandelbrot set, you can use 
this status line to watch how different settings of B and V create 
different-looking cubic Mandelbrots. 

The parameter status line shows the current fractal type, fo llowed in 
order by these parameter settings from the Tweak menu: 

• X and Y window-position parameters in parentheses 

• W window-width parameter 
• A, B, U, and V parameters beside lowercase a=, b=, U=, and 

V= 
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This status line helps you ident ify how different A, B, U, and V 
parameter settings affect the set . You can also use the status line to 
watch the effects of changing X, Y, and W settings. In addition, if 
you display this status line when you save an entire screen as a .gif 
file, you can return to the same settings that you see in the param­
eter status line when you reload the .gif file. 

Saving and Loading Files 

Use the options on the File menu to save and reload parameter files 
and .giffiles. For information on saving and reloading files, see 
"Saving and Loading Files" on page 209. 

The Mathematics of the Program 

Computing Sections of the Cubic Connectedness Map 
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A map in the plane is some system for find ing an image P' of each 
pOint P. You m ight, for instance, stretch the plane by moving each 
P twice as far from the origin 0 , or you might rotate the plane, 
moving each point P to a point P' some fixed number of degrees 
further clockwise. 

If you think of each point in the plane as a complex number 
Z = x + yi, you can get a very interesting m ap by taking z into z2. If 
you keep in mind that "i" is meant to be an "imaginary" number 
such that j2= -1, then a little algebra reveals that 
Z 2 = x2 - y2 + (2xy)i . In geometric terms, the operation of lett ing P' 
be the square of P works by actually squaring the length from P to 
the origin and by then rotating P to P' in such a way that the angle 
between op' and the x-axis is exactly twice the angle between op 
and the x-axis. 

If ( is a map in the plane, and (maps z into z', we can express th is 
either by writing z' = (z) or by writing z-f----d . Given an (and a z, 
you can define a sequence zn by: 

Zo = Z 

Zn + I = fCLn) · 

In terms of f: 
I Z-f--7Z1-f--7zr- f--7 Z3-f--7 

-

-
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The norm Izl of z == x + iy is obtained by Jx2 + l and is equal to the 
distance of z from the origin. If Iz nl becomes arbitrarily large as n 
increases, you say that z goes to infinity under the map f, which 
you can symbolize as z-(-7oo . If there is some real BOUND so that 
for all n, IZnk BOUND, then you say that z is bounded under the 
map f, and you write z-f-7FINlTE. Note that z-f-7FINITE does not 
mean that the zn sequence approaches a specific limit; more char­
acteristically, the zn will cycle among being close to some finite 
number of different limits. 

The Julia set for a map { is defined as the set of all z in the plane 
that are bounded under f Symbolically, the Julia set for {is 
(z: z-f-7FINITE). 

The map (c given by fc(z) == z2 + C has been widely studied. The {c 
maps are in some sense the II only" quadratic maps because by 
changing your coordinate system, any general quadratic map 
Aw2 + Bw + C can be put into the form z2 + c, with z a linear function 
of w. The Julia set for {c is named Jc. 

]c = (z : z-fc-7FINITE). 

All the Jc are symmetric about the origin, meaning that if the com­
plex number Z == x + iy is in Jc, then the complex number 
-z = -x - iy is in Jc as well. Some of them are connected with non­
empty interiors (disklike), some are connected with empty interi­
ors (linelike), and the others are totally disconnected (dustlike).Jc 
being totally disconnected means that if A and B are in Jc, there is 
a disk around A that hits no member of Jc and that excludes B. 
lIyou can't get there from here. " No quadratic Julia setJc is ever 
broken into just a few pieces. If it is disconnected, it is totally dis­
connected. Given this fact and the fact that theJc have symmetry 
around the origin, it's not too surprising to learn that Jc is con­
nected if and only if the origin (0,0) is a member of Jc. 

If you imagine varying c through all possible complex values u+vi, 
you can think of a c-plane that has a Jc set defined at each of its 
pOints. Benoit Mandelbrot had the idea of looking at the locus of 
all the c's for which Jc is connected. This is the Mandelbrot set, M. 
Symbolically, 

M == ( c :]c is connected) ; 
= ( c : the origin is in Jc ), because ]c is connected - (0,0) in Jc; 
= ( c: 0 + Oi-fc-7FINITE), by the definition of ]c. 

The maps that the cubic Julias and cubic Mandelbrots are based on 
have the form (kc, with (kc(z) == z3 - 3kz + c. By translating the origin, 
any cubic map Aw3 + Bw2 + Cw + D can be put into the form 
z3_ 3kz + c, with z a linear function of w. (The reason for casting 
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the linear coefficient in the form - 3k is that this k is used to calcu­
late cubic Mandelbrots.) For each fkc you can define a cubic Julia 
setJkc by: 

Jkc = (z: z -fkc~FINITE}. 

Unlike in the quadratic case, these Julia sets are generally not sym­
metric. Some of them are connected, some are disconnected but 
not totally disconnected (made of numerous separate connected 
patches), and some are totally disconnected. It has been proved 
that Jkc is connected if and only if both the complex numbers k = 
a + ib and -k = -a - ib are in Jke. As Jkc is not symmetric, it may hap­
pen that only one of k or -k is in Jke. Jkc is connected only when 
both of these critical pOints are in Jkc. 

The four-dimensional set of all complex pairs k and c such thatJkc 
is connected is known as the Cubic Connectedness map, or the 
CCM. The CCM is four-dimensional since it lies in a space with 
four parameters: a,b, u,v. 

CCM = ((k,c) : Jkc is connected}; 
= ((k,c) : (k -fkc~FINITE) AND (-k -fkc~FINITE)) 

The way the program depicts the CCM is to show various two­
dimensional cross-sections of it. These cross-sections are called 
cubic Mandelbrot sets. If, for instance, k = a + bi is fixed, you speak 
of the cubic Mandelbrot set Mk. Mk is a uv-plane slice of the CCM, 
and 

Mk = (c : Jkc is connected}; 
= (c: (k -fkc~FINITE) AND (-k -fkc~FINITE)} 

Note that computing an Mk is harder than computing the stan­
dard quadratic Mandelbrot set M in two ways. First of all, the map 
fkc involves cubing complex numbers, where the map fc only 
squares the complex numbers it deals with. Secondly, to check if c 
is in M, you need only check for one condition: 0 + Oi-f~FINITE; 
but to check if c is in Mk you need to check two conditions: 
k -fkc~FINITE and -k -fkc~F[NITE. On the other hand, if a cubic 
fkc grows, it grows explosively, so you can make a good guess as to 
whether fkc is tending towards FINITE or INFINITE after fewer iter­
ations (lower I parameter value) than are required for making a 
good guess about an fc map. 

In the software's default cubic Mandelbrot mode, the user has con­
trol of a select cursor in the k-plane, meaning that each cursor 
position selects a two-dimensional value of k = a + bi. Whenever 
you right-click to select a k, you see Mk, the k-section of the cubic 
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connectedness locus. By slightly varying a and/or b, you can look 
at k-sections near each other, and try to visualize stacking them 
one atop the other. 

If k = 0+ Oi, you get a degenerate Mk with four-fold symmetry; this 
is the default cubic Mandelbrot set. If Ikl is large (about 1 or 2), you 
get an empty Mk. All the Mk have symmetry around the origin, 
meaning that if c = u + iv is in Mk, -c = -ll - iv will be in Mk, too. 

The appearance of the Mk is quite interesting. You often see small 
replicas of the quadratic Mandelbrot set, though sometimes with 
wedges cut out of it. (For an example of this, see the preset image 
labeled "Laugh .") Looking at successive sections, you often get the 
impression of the Mk being like a cross-section of a three-dimen­
sional Mandelbrot shape, with buds all over it. But of course the 
full CCM is four-dimensional, and this shows up in the fact that 
many of the bud cross-sections have pieces missing from them. 
Presumably these missing pieces have inappropriate four-dimen­
sional coordinates for intersecting Mk. 

As an aid to mathematical visualization, think of it this way. The 
CCM is like a writhing three-dimensional solid, observed over a 
period of time. If a section of a bud seems to have the right half 
missing, you might think of the left half of the bud as being in 
Monday and the right half of the bud as being in Tuesday, with 
your cross-section being computed at the Monday time coordi­
nate. Time is not used in a physical sense here, but simply for the 
vividness of the image. 

N ow for an explanation of how to compute Mk. The computations 
of M, the Jc, and the Jck are quite similar. The computation of an 
Mk is done by fixing k = a + lb and then varying c = u + iv and check­
ing whether k -fkc~FINITE and -k -fkc~FINITE. On the basis of 
what we learn while doing this checking, we assign an Mk color(c) 
to the pixel representing c. Before starting, we select a BOUND and 
a value of MAXITERA TION, and say that k -fkc~FIN1TE if for all n 
less than MAXITERATION, the nth image of k is has norm less 
than BOUND. We always take BOUND to be the square root of 7, 
and MAXITERATION can be set by the user as the parameter 1. 

Assuming k = a + bi has been set, the computation of the Mk col­
or(c) for a fixed c = u + iv takes place as follows (this pseudocode 
description is not fully optimized): 

initialize: 
iteration = 0; 
tx = a; 
ty = b; 
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a3 = -3*( a*a - b*b ); 
b3 = - 3*( 2*a*b ); 

and then iterate: 
x2 = tx*tx; 
y2 = ty*ty; 
xa = x2 - y2 + a3; 
yb = 2*tx*ty + b3; 
temp = xa*tx - yb*ty + u; 
ty = xa*ty + yb*tx + v; 
tx = temp; 
iteration = iteration + 1; 

until x2 + y2 > BOUND or iteration = MAX ITERATION, saving 
iteration as iteration 1; 

and then re-initialize: 
iteration = 0; 
tx = - a; 
ty = - b; 
a3 = - 3*( a*a - b*b ); 
b3 = - 3*( 2*a*b ); 

and iterate the same computation, 
until x2 + y2 > BOUND or iteration = MAXITERA TION, saving 

iteration as iteration2; 
If iteration 1 and iteration2 both equal MAXITERATION, then 

Mk color(c) = O. 
Otherwise, 

Mk color(c) = TABLE[smaller of iteration 1 and iteration2]. 

What is TABLE? The problem is that there are only sixteen colors 
available on the computer screen, and the iteration counts can 
range over hundreds of possible values, depending on how large 
MAX ITERATION is . The simplest kind of TABLE operation would 
be to simply let TABLE[n] = n MODULO 16, the remainder 
obtained from dividing by 16. In practice, however, it is better to 
use a TABLE that does things like banding the colors across the 
iteration counts with, say, counts 100 through 110 all getting color 
1, counts 111 through 120 getting color 2, and so on. The user can 
alter the structure of TABLE with the BANDWIDTH variables that 
are set using the 0fjJ and ( Shift) +0fjJ keys or the Options menu. 

Recall that the Mk sets are cross-sections of the four-dimensional 
CCM which is, once again, the set of all quadruples (a,b,u,v) such 
that if k = a+ bi and c = u + vi, then the cubic Julia set Jkc is con­
nected. The Mk are obtained by fixing the values of a and band 
looking at the cross-sectional pattern in the uv-plane. You can 
imagine looking at cross-sections taken in different planes; there 
are in fact six d ifferent ways of choosing two out of four axes . If 
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the slice type is set to the ab-plane instead of the uv-plane, then 
the cubic Mandelbrots being shown can be thought of as Mc sets, 
where c = u + vi is fixed and you look at the range of k for whichJkc 
is connected. In other words, 

Me = lk : Jkc is connected). 

By using t he IT) and ( Shift ) + IT) keys or the Options menu, you 
can look at sections of the CCM taken in each of six different 
planes. It is an interesting (though perhaps impossible) challenge 
to fli p through the different views and try to imagine how they fit 
together into a four-dimensional whole. 

The last fractal type that the program shows is what we call the 
Rudy set R. Rudy Rucker invented it as an analogy to the Mandel­
brot set M. Since M can also be defined as { c : C is in Jc }, he defined 
R in a similar "self-refe rent ial" or "diagonal" fashio n as 

R = lk: k is in Mk} 
= {k -fkk---7FINITE AND -k-fkk---7FINITE}. 

If you think in terms of the Mc sets in the ab-plane you get a vari­
ant of the Rudy set, which can be viewed by pressing the IT) key 
when the Rudy set is displayed: 

R' = lc: c is in Mc}. 

Now we can explain the Bullseye and Feathers fi ll methods for col­
oring the interiors of the Mandelbrot, cubic Mandelbrots, and the 
Rudy set. 

In the case of the Mandelbrot set, a point c is in the interior of the 
set provided that Iz nl is less than BOUND for the first MAXITERA­
TION members of the sequence obtained by taking Zo = O+Oi and 
z n + 1 = (z n)2 + C. To do a Bullseye fill, we keep track of the numerical 
values of the IZnl and set MINSIZEc equal to the smallest of these 
values. The color for the pixel corresponding to c is then set equal 
to TABLE[ 16000*MINSIZEc]. We multiply MINSIZEc by such a 
large number so as to amplify the small differences in MINSIZEc 
between nearby c. To do a Feathers fill, we make a note of the value 
of n at which Iznl takes on the small MINSIZEc value, set MIN­
STEPc equal to this n, and give the pixel the color 
T ABLE[MINSTEPc l. 
In t he case of the cubic Mandelbrots and the Rudy sets, we do more 
or less the same thing, except we look at twice as many complex 
numbers' d istance from the origin to find the relevant MINSIZE . 
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Chapter 3 

Magnets and Pendulum 

The laboratory mouse of the new science was the pendulum: 
emblem of cLassical mechanics, exemplar of constrained action, 
epitome of clockwork regularity. A bob swings free at the end of 
a rod. What could be further removed from the wildness of 
turbulence? ... Yet the pendulum still had surprises in store. 
(Chaos: Making a New Science, page 39.) 

One of the stranger by-products of the new science of chaos is th is: 
it has become respectable again for a serious theoretical physicist 
to spend time studying the dynamics of pendulums. Even in this 
purest of mechanical systems, chaotic behavior can occur. 

One simple exam ple is the case of a pendulum swinging above 
some magnets, all capable of attracting and grabbing onto the pen­
dulum's bob. The bob swings back and forth, around and about, 
fi rst looping in the ambit of one or two of the magnets, then sud­
denly jumping to another region. It becomes almost impossible to 
predict where it will finally settle, until the very last minute. As in 
so many chaotic systems, the slightest change in the starting point 
or in the physical setup- the positions and strengths of the mag­
nets, the force and friction on the bob- can entirely change the 
outcome. 

One of the central concepts developed by chaos specialists to 
understand such systems is the idea of basins of attraction . If a bob 
is let go from a certain point, and eventually comes to a halt at a 
certain magnet, then the starting point is in that magnet's basin of 
attraction. The basin is like the area surrounding a bathtub drain; 
it is the collection of pOints drawn toward t he drain. Many real sys­
tems seem to have basins of attraction , from the weather to the 
human brain. The astonishing feature of such basins is that they 
need not form solid regions. If the basins of attraction for a given 
layout are colored according to which magnet finally captures the 
bob- red, blue, and green, say- the colors may end up woven 
together in regions of infinite, fractal complexity. 
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Begin by trying out some of the prestored combinations of mag­
nets. Press CIT) to load each preset layout. Left-click or press B to 
give the bob a push- the closer the cursor is to the bob, the harder 
the push. Press CEJ for a new arrangement of magnets, or capture 
a magnet by moving the cursor over it, and then move the magnet 
to a new spot. You can change the trail left by the bob by pressing 
CD. You can also try magnets that repel (shown red instead of 
b lue) by pressing Don the numeric keypad . To stop a simulation, 
clear the trails, and reset the bob to its default location, press CD . 

To see an example of basins of attraction, press CIT) repeatedly 
until Layout 7 appears. Press G to start the basins of attraction 
simulation. The bob moves around the magnets and colored dots 
appear toward the top of the screen. Gradually, the bob creates 
regions with mixed colors and jagged edges. These fracta l regions 
demonstrate that you cannot predict where the bob will land in 
this simulation. 

The program must make four passes to fully color in the basins of 
attraction. Completing the simulation takes several hours . You can 
observe just the first two passes to get a rough idea of the basins of 
attraction or you can let the simulation run while you do some­
thing else. 

To stop the basins of attraction Simulation, press QJ to turn off 
basins mode, or press CIT) to load another preset layout . 



Starting the Program 

Starting the Program 

When you start the program, the following screen appears: 

Cursor box 

Bob 

Layout nome-----------' 

The image area of the screen shows a preset layout of six blue mag­
nets and a white pendulum bob inside a box called the cursor box. 
You view a Magnets and Pendulum layout as though you were 
looking down on it. 

The name of the preset-Layout I-appears in the lower-left cor­
ner of the image area. 
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Moving Around in the Image Area 

You can use the mouse or the keyboard to move the cursor around 
in the image area. To move around using the keyboard, make sure 
( Num Lock ) is turned off and refer to the following illustration: 

t 

Numeric keypad keys and direction of cursor movement 

Note: You can press CQJ (the letter "Oil key) to toggle between 
smaller and larger steps for cursor movement. 

Experimenting with Preset Layouts 
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The Magnets and Pendulum program has seven preset layouts. 
You can display each preset layout and run a simulation that 
shows the pendulum bob moving around as it is attracted and 
repelled by positive and negative magnet charges. 

As you experiment with the preset layouts and run simulations, 
you can observe three key aspects of chaotic systems. 

• A chaotic system generates complex, highly organized pat­
terns. For example, the pendulum bob might continuously 
circle around a configuration of magnets, almost repeating 
its trails, but not quite. 

• Though seemingly predictable, these patterns are not pre­
dictable at all. For example, you cannot guess with 100 per­
cent accuracy which magnet the bob will stick to, no mat­
ter how simple the layout or "normal" the parameter set­
tings . 
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• Small changes you make cascade upward through the sys­
tem, producing unpredictable results. This ph nomenon is 
known as sensitive dependence on initial conditions. It means 
that when you make changes to parameter settings (even 
though you know generally how the changes should affect 
the simulation or specifically how the equations govern­
ing the program's calculations should affect the results), 
you still will not be able to predict the behavior of the bob. 

Note: You can read more about pendulum systems in James 
Gleick's Chaos: Making a New Science, pages 40-44. For more 
information on sensitive dependence on initial conditions, see 
Chaos: Making a New Science, pages 20-23 . 

Six positive (blue) magnets form a large circle. After you start the 
simulation, the bob eventually sticks to one of the magn ts. 

1. If Layout 1 is not currently displayed, press GD until Lay­
out 1 appears. 

2. Press B to start the simulation running. The bob moves 
around the screen, attracted by the positive magnets. 

3. Press a number key to change the number of magnets in 
the layout. 

4. Press B to start the simulation running again. 
5. Press ( Shift ) + CQJ to increase the radius of the circle of mag­

nets. 
6. Press B to start the simulation running again. 
7. Notice that the cursor turns into a yellow diagonal line 

called the club cursor. 
S. Move the yellow club cursor to the bob to capture it. The 

captured bob is enclosed in a small box. (If you capture a 
magnet by mistake, left-click or press B to release the 
magnet.) 

9. Move the captured bob to a new location and left-click or 
press B to release the bob. Notice that even a small 
change in the starting position greatly changes the bob's 
tra jectory. 

Note: For more information about running a simulation, see 
"Running a Simulation" on page 5S. 
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Layout 2 

Layout 3 
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Five negative (red) magnets form a medium-sized circle. Once you 
start the simulation, the bob can move arou nd the magnets vi rtu­
ally forever. If you let this simulation run long enough, the bob's 
motion will become quite violent. 

1. Press ill) until Layout 2 appears on screen. 

2. Press B to start the simulation run ning. 

3. Press m to reverse time direction for the simulation . 
When you do this, the bob runs backward, erasing all the 
trails it has left so far. 

Reversing the time direction demonstrates that the path of the bob 
is completely deterministic, although it might look random. The 
calculations that move the bob to the point where you press m 
to start reverse can be performed exactly the same in reverse so 
that the bob erases every trail it makes. 

Note: For more information about reversing the time direction, see 
"Reversing Time Direction" on page 70. 

Twenty-four positive (blue) magnets form four rows of six magnets 
each . In this simulation, the bob cannot stick to the magnets. 

1. Press ill) until Layout 3 appears on screen. 

2. Press B to start the simulation running. 

3. Press CD to change the trace type. 

4. Press CD again to see the next available trace type. 

S. Press CID+CI) to erase old trails to see only the new trace 
type. 

Note: For more information about trace type, see "Trace" on page 
73 and "Trace Erase" on page 73. 

You might enjoy a "hunt the butterfly" game with Layout 3. The 
object of "hunt the butterfly" is to capture the bob without captur­
ing a magnet. 

To capture the bob, follow these steps: 

1. Press B to start the simulation running. The cursor turns 
into a yellow diagonal line called the club cursor. 
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Layout 5 
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2. Try to place the club cursor over the bob. If you successful­
ly capture the bob, you enclose it with the cursor box. If 
you capture a magnet by mistake, the computer beeps to 
alert you to the capture. 
You can right-click to release the magnet and send it back 
to its original location, or you can left-click or press 8 to 
release the magnet at its current location. 

Sixteen negative (red) magnets form a random, asymmetrical lay­
out. The trail of the bob is set to a fi xed length and moves snake­
like behind the bob. The parameter settings in this layout make 
the bob settle into "pockets" or areas on the periphery, rather than 
sticking to magnets. 

1. Press CIT) until Layout 4 appears on screen. 

2. Press 8 to start the simulation running. 

3. Press OD to create a random layout of the magnets. 
4. Press 8 to start the simulation running for the new lay­

out. 
S. Press 8 again to give the bob a push. Watch how the bob's 

motion partitions the magnets. 
6. Press CO to assign random charges to the magnets. 

7. Press 8 to start the simulation running. 

Note: For more information about random layouts, see "Random 
Positions" on page 66. For more information about random 
charges, see "Setting Random Charges" on page 63. 

Thirteen negative (red) magnets form a small circle. The parameter 
settings allow the bob to move through the circle of magnets even 
though they repel it. 

1. Press CIT) until Layout 5 appears on screen. 
2. Press 8 to start the simulation running. 

3. Press m to change from lively mode to physical mode, 
and then observe the results when you start the simula­
tion. 
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Layout 6 

Layout 7 
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4. Press B again to push the bob. 
5. Press IT) to make all magnets positive. 

6. Press CD to change back to lively mode. 

Note: For a description of lively and physical mode, see 
"Computation" on page 72. 

Seven dipole (positive and negative) magnet pairs form a random, 
asymmetrical layout, and the trail of the bob is set to a fixed 
length. When you run the simulation, the bob moves from posi­
tive pole to positive pole of the dipole magnets. The preset 's 
default parameter settings make it impossible for the bob to stick 
to any magnet and allow the bob to move around the layout freely 
without settling in one area. 

1. Press CIT) until Layout 6 appears on screen. 
2. Press B to start the simulation running. 
3. Move the yellow club cursor over a blue magnet to captu re 

it . The computer beeps to confirm the capture. 

4. Press 0 to change the charge of the magnet you've cap­
tured so there is now a pair of negative magnets. Left-click 
or press B to release the captured magnet. 

5. Notice how the bob avoids the pair of negative magnets. 
6. Move the yellow club cursor over a red magnet in a dipole 

pair to capture it. The computer beeps to confirm the cap­
ture. 

7. Press IT) to change the charge of the magnet you've cap­
tured so that now you have a pair of positive magnets . Left­
click or press B to release the captured magnet. 

8. Notice what happens to the bob when you run the simula­
tion with two positive magnets next to each other. 

Layout 7 demonstrates basins of attraction. Seven different col­
ored, att racting magnets form a random, asymmetrical layout. 
When you run the Simulation , the program creates basins of 
attraction by repeatedly releasing the bob from a unique starting 
point and coloring that point the same color as the magnet that 
the bob lands on. 
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Although the simulation is set to run as fast as possible, it takes a 
number of hours to fully color in all the basins of attraction. 

1. Press CIT) repeatedly until Layout 7 appears on screen. 

2. Press B to start the simulation runn ing. The simulation 
must run for some t ime before you see the basins of attrac­
tion. The completed basins of attraction screen for Layout 
7 resembles this: 

3. To stop the basins of attraction Simulation, press Q) to 
turn off basins mode, or press CIT) to load another preset 
layout. 

When the basins of attraction simulation is complete, the program 
automatically saves the completed image as a .gif file. 

Once you've run the simulation for Layout 7, you can change the 
layout of magnets and run a new simulation. For example, press CEJ 
to random ize the layout or press CQJ or ( Shift ) + CQJ to arrange the 
magnets in a small or large circle. The new layout produces a com­
pletely different set of basins. 

Note: For more information on basins of attraction, see "Basins of 
Attraction" on page 69. 
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Running a Simulation 

When you run a Magnets and Pendulum simulation, you see a sys­
tem resulting from th e unique combination of magnet and bob 
parameter settings, the layout of the options, and other options 
such as sound or colors. 

Starting the Bob 

After you set up a simulation, you run it by starting the bob. 

• With the cursor anywhere in the im age area, left-click or 
press B . 

Once a simulation starts runn ing, the cursor turns into a yellow 
line called the club. 

Giving the Bob a Push 

To speed up the bob's action temporarily or move the bob to a new 
area of the simulation, you can give the bob a push with the club. 
The closer the club is to the bob, the stronger the push will be. 

• With the club cursor near the bob, left-cl ick or press B . 

Capturing the Bob or a Magnet 
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You can capture either the bob or a magnet and move it to a new 
location. When you capture something, you enclose it with the 
cursor box. 

1. Move the club cursor over the object. Your computer beeps 
to alert you to the capture of a magnet. 

2. Press B to release the captured bob or magnet. 

You can also use the mouse to release a captured magnet: 

• Left-click to release the magnet where it is. 
or 

• Right-click to send the magnet back to its original location. 
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Slowing Down and Speeding Up a Simulation 

Slowing down the speed of a simulation makes it easier to see the 
movement of the bob. You can slow down or speed up a simula­
tion within a range of speeds. The default is set to maximum 
speed. 

• Press 0 (comma key) to slow down a simulation by 0.1 
second per simulation step. 

• Press 0 (period key) to speed up a simulation by 0.1 sec­
ond per simulation step. 

Stopping a Simulation 

You can stop the bob's movement without making any other 
change. 

1. Press the spacebar or select the Stop button to stop the bob 
without erasing trails. 

2. Press ( Shift) and the spacebar or select the Run button to 
start the bob moving again. 

Running a Simulation in Steps 

You can run a simulation one step at a time. 

1. Select the Step button or press the spacebar to stop a sim­
ulation. 

2. Select the Step button or press the spacebar repeatedly to 
run a simulation one step at a time. 

3. Select the Run button or press ( Shift) and the spacebar to 
start running the simulation again. 

Erasing Trails from a Simulation 

Keyboard shortcut: a!D + CTI 

You might find you want to keep the bob moving but erase the 
trails once from a simulation. Erasing the bob's tra ils from a simu­
lation lets you keep closer track of the bob's action around the 
screen. 

• Press a!D+CTI to erase the bob's trails from the screen 
without interrupting a simulation. 
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Erasing Trails and Stopping the Bob 

Reset 

Keyboard shortcut: CD 

You can also erase trails and stop the bob at its current location. 
Then you can start a simulation again from the point where the 
bob stops. 

1. Press CD to erase the bob's trails from the screen and stop 
the bob at its curr~nt location. 

2. Left-click or press B to continue the simulation from the 
current location of the bob. 

Keyboard shortcut: CD 

You can stop a simulation, erase all trails, and return the bob and 
cursor box to the lower-left corner of the image area (the starting 
default location). 

• Press CD to reset a simulation. 

Changing Parameters 

Changing the parameter settings for a simulation lets you observe 
how even small changes in initial conditions can dramatically 
affect the outcome of an experiment with Magnets and Pendulum. 
You can set new parameters before running a Simulation, or you 
can change parameters while the simulation runs. 

Many of the most commonly used parameters appear on the main 
screen of Magnets and Pendulum. 

Note: When you find an interesting set of parameters and magnet 
layout, you can save the layout in memory or in a parameter file. 
For more information, see "Saving and Loading Files" on page 74. 

Changing the Charge of Magnets 

Keyboard shortcut: (Shift ) + m to increase; m to decrease 

Each magnet has a numerical positive or negative charge. Charge 
• sets the strength of the attracting or repelling force of the magnets. 
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The Magnets and Pendulum program gives you several ways of 
changing the charge of the magnets in a layout. 

If All Magnets Have the Same Charge (Charge Button) 

If all magnets in the current layout have the same charge, that 
value appears in the Charge field on the main screen. 

• Enter a value between -500 and 500 in the Charge field to 
change the charge of all magnets in the layout . 

You can also use a keyboard shortcut to adjust the charge. Adjust 
the charge for all magnets like this: 

1. Make sure the cursor box is not enclosing a magnet. 
2. Press ( Shift l+ CD to increase the charge of all magnets or 

press CD to decrease the charge. 

Adjust the charge for one magnet like this: 

1. While running a simulation, move the club cursor to a 
magnet to capture it. 

2. Press ( Shift) +CD to increase the charge of the captured 
magnet or press CD to decrease the charge. 

Note: You can also change the charge of one magnet by pressing 
CIT) to display the Charge Editor. The Charge Editor is described in 
the following section. 

If Magnets Have Different Charges (FS Charges Button) 

If the magnets in a layout have different charges, the F5 Charges 
button appears in place of the Charge field. The F5 Charges button 
lets you display the Charge Editor, which lists the individual 
charge for each magnet in a layout. 
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To use the Charge Editor, follow these steps: 

1. Select the F5 Charges button or press @. The Charge Edi­
tor appears. 

Charge Edi tor 

1 : 

2: 

3: 

4: 

5: 

6: 

7: 

H: 

2. Move the highlight down the list of charges and watch the 
white circle move from magnet to magnet in the layout. 
The white circle lets you match each magnet with its entry 
field in the Charge Editor. 

3. If the current layout has more than 10 magnets, press the 
Next Page button to see additional magnet charges. 

4. When the white circle is on the magnet whose charge you 
want to adjust, enter a value between -500 and 500 in the 
entry field and press G . 

S. Select the ACCEPT button to accept the changes and exit 
the Charge Editor. 

If you set large negative or positive charges, you need to increase 
the center pull force to keep the bob on screen. See "Center Pull 
Force (Pu ll)" on page 6S for details. If you lose sight of the bob on 
the screen, press CD to reset the bob's starting posit ion. 
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Suggestion: To increase your chances of predicting the bob's 
movement, try an experiment. 

1. Select the F5 Charges button to display the Charge Editor. 

2. Move the highlight to two or three of the strongest posi­
tive charges shown in the Charge Editor dialogue box. As 
you move the h ighlight, observe the image area to see 
which positive magnets the white disk lands on. 

3. Press ~ to exit the Charge Editor. 
4. As the simulation continues to run, observe that, although 

you can now see that the bob "prefers" the two or three 
magnets with the strongest positive charge, you still can­
not predict precisely where the bob will move next. 

Switching Positive and Negative Charge for Magnets 

To switch the charge for an individual magnet, follow these steps: 

1. Capture the magnet with the cursor box. 
2. Press IT) to switch the magnet's charge to positive. Press 

8 to switch the charge to negative. 

To switch the charge for all magnets, fo llow these steps: 

1. Make sure the cursor box is not enclosing any magnet. 
2. Press IT) to switch all magnets to positive charge. 

Press 8 to switch to negative charge. 

Setting Random Charges 

Keyboard shortcut: OJ 

You can set random charges for all magnets. 

• Select the Random Charges button at the lower-left corner 
of the screen to assign random positive and negative 
charges. If all magnets had the same charge before you ran­
domized the charge, the Charge field changes to the F5 
Charges button. 

Suggestion: After setting random charges, you can use the Charge 
Editor to view or change each magnet's charge. To use the Charge 
Editor, see "If Magnets Have Different Charges (FS Charges 
Button)" on page 61. 
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Capture Radius (Cap) 

Keyboard shortcut: (Shift) + CD to increase; CD to decrease 

All magnets have the same capture radius, which measures in pixels 
how close the bob can come to a magnet before it sticks. The cur­
rent capture radius appears in the Cap field on the main Magnets 
and Pendulum screen. 

• Enter a value between 0 and 20 in the Cap field to change 
the Capture Radius. 

Suggestion: To start a simulation that runs endlessly, set the 
capture radius at O. 

Magnet Radius (Rad) 
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Keyboard shortcut: (Shift ) + CD to increase; CD to decrease 

Magnet radius shows in pixels the density of all magnets' charges. 
Setting a small magnet radius means that the magnets behave like 
very intense, point-like charges. Setting a large magnet radius 
means that the magnets act like gentle, diffuse charges. CHAOS 
displays the current magnet radius in the Rad field on the main 
screen. 

• Enter a value between 1 and 60 in the Rad field to change 
the Magnet Radius. 

To set the force at the magnets' centers to zero, CHAOS requires 
that when bob-to-radius distance is less than magnet radius, the 
force must be proportional to charge multiplied by distance. You 
can find complete information on calculations for magnet radius 
in liThe Mathematics of the Program" on page 74. 

Suggestion: If you set a small magnet radius, you will probably 
want to set sampling frequency fairly high to keep the bob from 
moving too rapidly and erratically around the screen. See 
"Sampling Frequency (Freq) " on page 65 for details. 
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Center Pull Force (Pull) 

Keyboard shortcut: ( Shift ) +m to increase; m to decrease 

Center pull force shows the st rength of the force pulling the pendu­
lum bob toward th e center. When you change this parameter, it's 
as though you're controlling the size of the restoring force that 
drives the pendulum. The current center pull force appears in the 
Pull field on the main screen . 

• Enter a value between - 500 and 500 in the Pull fi eld to 
change the Center Pull Force. 

Sampling Frequency (Freq) 

Keyboard shortcut: (Shift ) +m to increase; m to decrease 

CHAOS updates the bob's position step-by-step in the program's 
own simulation time. Each step takes the same amount of real time 
to calculate. Sampling frequency measures the number of real-time 
steps the program performs per second of simulation time. When 
you change sampling frequency, you affect how slowly or rapidly 
the bob moves around, and how smooth or jagged the bob's trail 
looks. The current sampling frequency appears in the Freq fie ld on 
the main screen. 

• Enter a value between 2 and 10000 in the Freq field to 
change the Sampling Frequency. 

Suggestion: If you want a smoother trail, set a high sampling 
frequency. When you do, CHAOS divides each second of 
simulation time into many calculation steps and makes the bob 
move around the screen slowly with a smooth trail. Conversely, if 
you want a more jagged trail, set a low sampling frequency. When 
you do, CHAOS skips over a lot of simulation time for each real­
time step and makes the bob move around the screen rapidly with 
a jagged t rail. 

Friction (Fric) 

Keyboard shortcut: ( Shift ) + CD to increase; CD to decrease 

The bob has a numerical friction, which measures the force slowing 
down the bob as it moves. The current frict ion appears in the Fric 
field on the main screen. 
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• Enter a value between 0 and 500 in the Fric fie ld to change 
the friction of the bob. 

Note: CHAOS follows conv ntions of aerodynamics and calculates 
friction as proportional to the square of the bob's speed. You can 
find complete information on these calculations in "The 
Mathematics of the Program" on page 74. 

Changing the Layout of Magnets 

Another way of changing a simulation is to change the layout of 
the magnets. You can arrange magnets in a symmetrical layout 
such as a circle, you can move individual magnets to any location 
on screen, or you can use random layouts. You can also change the 
number of magnets in a layout or add or delete individual mag­
nets . 

Note: If you find a layout you like, you can save it temporarily in 
memory by pressing Cill. To load it again, press em repeatedly 
until that layout appears on scre n. For more information, see 
"Saving and Loading Files" on page 74. 

Random Positions 

Keyboard shortcut: O::D 

To po ition magnets randomly 

• Select the Random Positions button at the lower-left corner 
of the screen. 

Displaying Symmetrically Arranged Magnets 

" 
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You can use the number keys to di play nine different symmetri­
cally arranged magnet layouts. For example, if you press m , 
CHAOS arranges four magnets in a square. If you press 0, CHAOS 
arranges seven magnets in a circle. If you press CD , a single magnet 
is centered on screen. 

To display a symmetrical layout 

• Press a number key from CD through m to display a sym­
metrical arrangement of the corresponding number of 
magnets. 
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Suggestion: If you press ® to remove all magnets from the screen, 
you can run a simulation and watch the bob's center-pulling 
pendulum force at work without interference from magnetic 
attraction or repulsion. 

Moving Magnets 

You can change the location of one or more magnets in any lay­
out: 

1. With a simulation running, move the club cursor to a mag­
net to capture it. The computer beeps and the cursor box 
encloses the magnet. 

2. Move the magnet to the new location and left-click or 
press (0 to release it. 

3. Repeat steps 1 and 2 for as many magnets as you want to 
move. 

4. Press m to stop the simulation and reset the bob to its 
starting position . 

Inserting and Deleting Magnets 

You can insert and delete magnets at the cursor location. You can 
display as many as 31 magnets on screen, or as few as O. 

• Press Cfiii) to insert a magnet at the club cursor location. 

• Capture the magnet with the cursor box and press @ill to 
delete a magnet. 
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Using the Options Menu 

You can use the Options menu to change colors, tum on sound, or 
start a simulation showing the basins of attraction for a configura­
tion of magnets. To display the Options menu, select the F4 
Options button: 

Palette: 

Sound: 

Basina: 

Reue Ible: 

Force type: Inuerse Square 

n.~~IT"Tlon: Liuel!J 

Trace: I -

Trace erase: 
longth: 

Circle Radius: 

F1 for HELP ESC to Cancel ACCEPT f> 

Color Options 

• 
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The following color options are common to five of the six CHAOS 
programs and are described in "Using Color Options" on page 214. 

• Color Cycle Once 
• Auto Cycle 
• Palette (Default, Random, Preset, Edit) 

• Monochrome 



Sound 

Using the Options Menu 

Keyboard shortcut: aiD + CD 

You can turn on sound in Magnets and Pendulum to hear how 
chaotically the bob is behaving in the current magnet configura­
tion. As the movement of the bob becomes more erratiC, the sound 
also becomes more erratic. And the sound's pitch goes up or down 
as the bob moves faster or slower. 

• Select the On or Off button next to Sound on the Options 
menu to turn sound on or off. 

Note: CHAOS temporarily turns sound off whenever you move the 
mouse pOinter into the menu area. 

Basins of Attraction 

Keyboard shortcut: Q) 

To illustrate the unpredictability of the bob's attractions to mag­
nets, you can turn on a feature called basins of attraction. Basins of 
attraction show the patterns of colors the program makes when 
the bob is released from one screen position to the next, with each 
starting position colored like the magnet the bob lands on. 

CHAOS fully colors in the simulation in four passes. First, the pro­
gram tests every eighth pixel, then every fourth, then every sec­
ond, and finally every pixel. The fully colored-in simulation has 
regions of solid colors, but it also has regions of intermixed colors, 
as well as regions where colors have jagged, or Zipper-like, bound­
aries. The regions with mixed colors and jagged boundaries tend 
to be fractals and demonstrate that you cannot completely predict 
where the bob will land. To find out the details of the calculations 
in basins of attraction, see /lThe Mathematics of the Program" on 
page 74. 

When the basins of attraction simulation is complete, the program 
automatically saves the completed image as a .giffile. The program 
names these .gif files MAGNETnn.GIF with /Inn" representing a 
two digit number. 

Although CHAOS sets the basins of attraction simulation to run 
quickly, running the simulation might take a number of hours. 
You can let the simulation run overnight, or you can observe just 
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the first two passes that CHAOS calculates. These two passes give 
you a rough idea of the basins of attraction for a given configura­
t ion of magnets. 

To increase the speed of the basins of attraction simulation, you 
can make the following changes: 

• Set the capture radius above 10. Use the Cap field on the 
main screen to make this change. 

• Set the sampling frequency to about 100. Use the Freq field 
on the main screen to make this change. 

• Make sure you're running the simulation at maximum 
speed. Press 0 (period key) several t imes to increase the 
simulation speed to its maximum. 

You can set up a new configuration of magnets for the basins of 
attraction simulation, or you can use Layout 7. See "Layout 7" on 
page S6 for details on this preset layout showing basins of attrac­
tion . 

To set up, turn on, and start a new basins of attraction simulation, 
follow these steps: 

1. Set up a configuration of any number of positive magnets. 
2. Select the On button next to Basins on the Options menu 

or press GD and then press m to turn on basins and dis­
play each magnet with a unique color. 

3. Press B to start the simulation. 

Suggestion: To focus on where the bob is landing in the basins 
mode, slow down the simulation by pressing 0 (comma key) 
several times. Watch the bob a while, paying special attention 
when it colors in areas with mixed colors and jagged edges . Speed 
up the simulation aga in by pressing 0 (period key) several times. 

Reversing Time Direction 

70 Chapter 3 

Keyboard shortcut: OD reversible toggle; GJ reverse 

When you reverse time direction for a simulation, you see the 
bob's trail running backward. Th is gives you an "instant replay"­
in reverse-for the simulation you just saw. Reversing time direc­
tion works correctly only if reversible mode is on and friction is set 
to O. The default is reversible mode off. 
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Reversing time direction involves several steps: first, you turn fric­
tion off, next, you turn reversible mode on, and finally, when 
you're ready to see the bob's trail running backward, you start 
reverse. You can turn reversible mode on any time while you are 
running a simulation . If you like, you can observe reverse time 
direction in several simulations; whenever you're ready to stop 
doing that, you can turn reversible mode off again. 

Note: For best results wi th Reversible mode, use the Lively 
Computation option and a frequency (Freq) no higher than 300. 
You might find it easier to see the effects of reversing time 
di rection if you press CD to erase trails and reset the simulation 
first. 

To reverse time direction, follow these steps: 

1. Enter 0 in the Fric field on the main screen to turn friction 
off. 

Z. Press ([) or select the On button next to Reversible on the 
Options menu to turn on reversible mode. 

3. If you don't have a forward-runn ing simulation going, left­
click or press B to start a forward-running simulation. 

4. When you're ready to reverse time direction, press m to 
start the bob's trail running backward. 
The bob's trail runs backward to the point where you 
pressed (2) to start the simulation. When it reaches that 
point, it has velocity zero, just as it did when it started, so 
it repeats the same path. You can reverse the bob again by 
pressing m . 

5. When you're ready to stop observing reverse time direc­
tion for the bob's trails, press ([) to turn off reversible 
mode. 

Force Type 

• 

Keyboard shortcut: CD 

Magnet force is one of two types of simulated physical law that the 
magnets obey: Inverse Square force or Inverse Linear force. The 
default force type is Inverse Square. 

When you select Inverse Square force, CHAOS sets magnet force 
proportional to one over the bob-to-magnet distance squared. 
When you select Inverse Linear force, CHAOS sets magnet force 
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proportional to one over the bob-to-magnet distance. You can 
read more about these calcu lations in liThe Mathematics of the 
Program" on page 74. 

• Select the Inverse Square button to use inverse square force. 
• Select the Inverse Linear button to use inverse linear force. 

Computation 

72 Chapter 3 

Keyboard shortcut: CD 

CHAOS lets you change the way the program calculates the move­
ment of the bob. The simulation works by repeatedly calculating 
the net force on the bob, and then moving the bob and calculating 
the net force at the bob's new location. In one way of calculating 
the net force- when the program is running in lively mode- the 
calculation looks only at the bob's current location. In physics, 
this method of calculation is called the Euler method. When you 
run the program in lively mode, you get a less accurate, faster cal­
culation of the bob's movement, and the bob's movement 
becomes quick. The default method of calculating how the bob is 
likely to move is the lively mode. 

In the other way of calculating the movement of the bob- when 
the program is running in physical mode- the calculation of the 
net force examines t he force at several pOints near the bob's loca­
tion and takes a weighted average. In physics, this method of cal­
culation is called the Runge-Kutte method. When you run the pro­
gram in physical mode, you get a more accurate, slower calcula­
tion of the bob's movement, and the bob's movement becomes 
smoother. 

For complete details on the calculations for lively and physical 
modes, see liThe Mathematics of the Program" on page 74. 

• Select the Lively button next to Computation on the Op­
tions menu to use lively mode. 

• Select the Physical button next to Computation on the Op­
tions menu to use physical mode. 



Trace 

Using the Options Menu 

Keyboard shortcut: OJ to cycle through trace and trace erase types 

You can choose from three different trace types, or types of trails for 
the bob: 

• Select the None button if you want no trail behind the bob. 
• Select the Lines Only button to see a thin line behind the 

bob. 
• Select the Lines &: Bobs button to see a trail of lines and bob 

images. 

Trace Erase 

Length 

Keyboard shortcut: OJ to cycle through trace and trace erase types 

The Trace Erase option lets you change how the trace type is 
painted on screen. With Trace Erase off, the trace type (Lines or 
Lines &: Bobs) is shown on screen as one continuous line that 
traces the bob's path from the start to finish of the simulation. If a 
simulation runs long enough, the screen can get very crowded 
with lines. With Trace Erase on, the trace type appears as a con­
stantly moving fixed-length line. (The length of the line is deter­
mined by the value of the Length option.) 

• Select the On or Off button next to the Trace Erase option 
to turn trace erase on or off. 

Keyboard shortcut: (Shift )+CD to increase; CD to decrease 

You can change the length of the displayed trail. The program 
measures trace length as a number of successive calculated bob 
positions, connected by a line. The default length is 300. 

• Enter a value between 0 and 512 in the Length field on the 
Options menu to change the trace length. 

Suggestion: Setting a long trace length, such as 200, makes it easier 
to see where the bob is spending a lot of time. Setting a short trace 
length, such as 30, makes the trail appear like a ribbon waving 
behind the bob. 
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Circle Radius 

Keyboard shortcut: ( Shift ) + rn to increase; rn to decrease 

The Circle Radius option lets you increase or decrease the radius of 
a circle of magnets in a layout. The current radius (measured in 
pixels) appears in the entry field next to Circle Radius on the 
Options menu. 

• Enter a value between 1 and 135 to change the radius for a 
circle of magnets. 

Saving and Loading Files 

You can use the options on the File menu to save and reload 
parameter files and .giffiles. For more information, see "Saving 
and Loading Files" on page 209. 

In Magnets and Pendulum, you can also save a layout temporarily 
in memory. When you do this, CHAOS appends the layout to the 
end of preset layouts. You can save up to 32 layouts in memory. 
You can reload the temporarily saved layout if you have not exited 
Magnets and Pendulum to the Main menu or quit CHAOS to DOS. 

To save a layout temporarily in memory 

• Press 00. The computer sounds two beeps to alert you 
that the layout has been saved in memory. 

To reload a layout temporarily saved in memory 

• Press ill) repeatedly until you find the layout you want. 

The Mathematics of the Program 
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In Magnets and Pendulum, we track the motions of a moving bob. 
The simulation works by keeping track of the bob's position and 
its velocity, repeatedly updating the velocity on the basis of the 
forces felt by the bob, and updating the position on the basis of the 
velocity. To simplify our calculations, the bob has a mass of one, 
and the distances are measured in pixels. 

There are three kinds of forces : "magnetic forces," a pendulum 
force, and the force of friction. 



-
-

-

The Mathematics of the Program 

The phrase "magnetic forces" could be replaced by "gravitational 
forces" if we think of the "magnet" disks as "planets." More logi­
cally, we should really speak of "electrostatic forces" and regard 
the "magnets" as "charged particles." This makes sense because we 
want to have repelling forces as well as att ractive ones. If we accept 
the electrostatic model and think of the bob as bearing a fixed 
charge of minus one, then it is attracted by the positively charged 
disks and repelled by the negatively charged ones. For the rest of 
this section, let's use the phrase "charge forces" to describe the 
forces that the charged disks exert on the bob. 

The size of the charge force that a disk with charge C exerts on the 
bob depends on the distance r between the center of the disk and 
the center of the bob. The charge force's magnitude F is given as 
either 

(1) 

or 

(2) 

depending on whether the force type is set to be inverse square or 
inverse linear. The numbers k and 1 are built-in proportionality 
constants; they are empirically tweaked "magic numbers" that 
make our simulations look good for the ranges of C and r encoun­
tered. Since distances are measured in pixels, the r values in the 
denominator are usually rather large, so it turns out that large val­
ues of the built-in constants k and 1 are needed in the numerator. 
As it happens, our k is 50,000,000. 

One problem with the formulas (1) and (2) is that they give very 
large values when r gets close to zero. Yet we feel intuitively that if 
a metal bob gets near the center of an attracting magnet, it will 
tend to settle down there, rather than being tossed about by infi­
nitely large forces. Or, again, if one were to fall down a tunnel that 
goes right through the Earth, one would come to rest at the Earth's 
center, floating there subject to no gravitational force at all. 

To clarify the ideas, suppose that we're looking at a planet with 
radius R and mass C-and say that the planet is gas instead of rock 
so we can fall "into" it. Now suppose that we have a unit mass bob 
at a distance r from the planet'S center, with r less than R. In 1690, 
Isaac Newton used his newly invented calculus to establish that in 
this situation the bob will be pulled towards the planet's center 
with a force with magnitude F given as 

(3) 
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where Cr is the mass of that part of the planet which is with in r of 
its center, and k is a proportionality constant as before. If we sup­
pose that the planet is uniformly dense, then mass is proportional 
to volume. A sphere with half the radius of another sphere has 
one-eighth the volume, a sphere with one-third the radius has 
one-twenty-seventh the volume, and so on. The mass Cr forms a 
sphere with a volume (r/R) as big as the full sphere, so we expect 
that 

(4) 

If we plug this expression for Cr into formula (3) and simplify, we 
get 

(5) 

This is a nice formula because it makes F go down to zero as r goes 
to zero, which is what we wanted in the first place. 

The quantity R is what the Magnets and Pendulum program ca lls 
If magnet radius." Even though our screens show bob and magnets 
as two-dimensional disks of fixed size, the program actua lly acts as 
if the bob were a point, and as if the magnets were small, three­
dimensional spheres which the bob is capable of moving th rough. 
In the inverse square case, when the bob is further than R from a 
magnet, the force's magnitude is calculated using formula (I), and 
if the bob is less than R pixels from a magnet's center, the force's 
magnitude is obtained by using formula (5). A similar trick is used 
in the inverse linear case. 

Unlike the charge forces, which get weaker with increasing dis­
tance, the pendulum force gets stronger as the bob moves away 
from the center of the screen. Instead of thinking of a pendulum, 
you can also think of a spring with one end attached to the screen 
center and the other end attached to the bob. The further you 
stretch the spring, the harder it pulls back. The intensity of the 
pendulum force is set by means of a center pull parameter P. You 
can think of P as being the strength of the gravitational force 
which drives the pendulum or, in terms of a spring, you can think 
of P as controlling the stiffness of the spring. If r is the distance 
from the center of the bob to the center of the screen, then the 
magnitud of the pendulum force is 

(6) 

where m is a built-in proportionality constant (it's actually 10) . 
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The frictional force depends not on the bob's pOSition, but on the 
bob's speed-actually on the square of the bob's speed. The faster 
the bob moves, the greater is the friction which it encounters; the 
principles of aerodynamics suggest that the friction, or drag, is in 
fact proportional to the square of the speed. The simulations use 
an adjustable friction parameter D. If the bob's present speed is V, 
the drag due to friction has magnitude equal to 

(7) 

where n is a built-in proportionality constant (we use 0.01) 
designed to give good results for the ranges of F and V that we typ­
ically use. 

As mentioned before, the simulation operates by keeping track of 
the bob's position and velocity. A complicating factor is intro­
duced by the fact that velocity is a vector: moving left twenty pix­
els per update is not the same as moving down twenty pixels per 
update. Just as position is an ordered pair of position coordinates 
(x,y), velocity is an ordered pair of speeds (vx,vy). A velocity of 
(-10,20) might mean that the bob wants to move ten pixels left 
and twenty pixels up during the next update. The total speed V 
can be obtained from the velocity by using the Pythagorean 
theorem 

v2 = vx
2 + vy2. 

The charge forces, pendulum force, and friction forces are all vec­
tors as well. That is, each of the forces is really a vector (Fx,Fy). The 
force formulas determine, F, the magnitude of the whole vector, 
rather than the actual components Fx and Fy. How do we break F 
into Fx and Fy? The solution depends on the fact that for each of 
the three kinds of forces, we know what direction the force vector 
is supposed to point in. A magnet's charge force pOints along the 
line between the bob and the magnet's center. The pendulum 
force pOints along the line between the bob and the center of the 
screen. And the retarding force of friction points in the opposite 
direction from the bob's present velocity. 

~1 
Ej~----------------~ 

dx 
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Consider, for instance, the case where the bob is being repe lled by 
a negative magnet charge. Imagine drawing a line fr m the bob to 
a magnet's center, a line with length r. We can break this line into 
a horizontal and a vertical component by making it the hypote­
nuse of a right triangle with a horizontal side and a vertical side. 
Call the respective lengths of the two sides dx and dy' and note 
that dx is the difference between the bob's x-coordinate and the 
magnet's x-coordinate, while dy is the difference between the 
bob's y-coordinate and the magnet's y-coord inate. r is actually cal­
culated by us ing the Pythagorean formula [2 = d/ + d/ Now, the 
fo rce F which the magnet exerts on the bob will be di rected from 
the bob away from the magnet along the line conn cting their 
centers. And if we break F into horizontal and vertical components 
of size Fx and Fy' these component lines will be pa rallel to the lines 
represent ing dx and dy. Since all three pairs of sides are parallel, 
the triangles are similar, so we can know that their sides bear the 
same ratios to each other. Fx is to F as dx is to r; and Fy is to F as dy 
is to r. If we write the ratios as fractions, set them equal to each 
other, and multiply through by P, we get the formulae: 

(8) 

Using formulae like (8) with formulae for F enables us to calculate 
the forces in the x and y directions. If, for instance, we combine (8) 
wi th (I), we get 

(9) 

In the simulation, we first sum up the Fx's and the Fy's contributed 
to the bob by each of the magnet computations. If there are four 
magnets, for instance, then Fx is computed as Fxml + Fxm2 + Fxm3 + 
Fxm4 ' Next the Fxc and Fyc due to the center pull are computed and 
added in. Equation (8) works for center pull as well, provided that 
one views the pendulum center as the "magnet" at the origin. And 
the friction? We don't put in the friction until the last step of the 
velocity update. 

Isaac Newton's second law of motion says that force is equal to 
mass times acceleration. Since the bob's mass is one, force equals 
acceleration. We already know the force, so we turn the equation 
around and see that acceleration equals force. Acceleration is the 
rate velocity changes against time. This rate of change is approxi­
mately equal to 

(NewVelocity - OldVelocity) / (NewTime - OldTime) 
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The change in time per simulation step is controlled by the Freq 
parameter; that is, NewTime - OldTime is equal to 1 / Freq. Thus 
we get this approximating equation for the x component of the 
velocity (and a similar one for y): 

(10) 

This method of computing the new velocity components is called 
the "Euler approximation," and it is the method used by our 
"lively" mode. There is a slower and more accurate algorithm 
called the "Runge-Kutte method," which is the what we use in our 
"physical" mode. The Runge-Kutte method works by evaluating Fx 
and Fy at four carefully selected points near the bob's current posi­
tion and averaging the values to get a better approximation to the 
force which the bob will experience along the entire course of its 
next motion step. 

Once New V x and New Vy have been calculated, friction is applied. 
Friction is proportional to the square of the speed V, so to get the 
final value of V x' we use this formula (and a similar formula for 
V y): 

(11) 

Now that the new values of V x and V y are calculated, we get the 
bob's new position from the equations: 

x = x + V x / Freq, and y = y + V y / Freq (12) 

For increased speed, most of our program variables are long inte­
gers instead of floating-point numbers. Computers without math 
coprocessors do integer operations substantially faste r than 
floating-point operations . Of course, rounding off V x' VY' x, and y 
introduces inaccuracies . To prevent this, the program usually 
keeps track of the total quantities rounded off in floating-point 
"debt" variables, adding or subtracting a unit whenever a debt gets 
larger than one or smaller than minus one. This debt-minding pro­
cess is turned off when the program is put into "reversible mode" 
by pressing ( Shift) + CD and sett ing the friction to zero. When you 
press CD to reverse the bob's motion, the program simply changes 
the sign of V x and V y' Provided that there are no debt variables to 
muddy the waters, this move causes the program to precisely 
retrace its steps . 
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Strange Attractors 

... The strange attractoT began as a mere possibility, marking 
a place where many great imaginations in the twentieth century 
had failed to go. Soon, when scientists saw what computers had 
to show, it seemed Like a face they had been seeing evelywhere, 
in the music of turbulent flows aT in clouds scattered like veils 
across the sky. Nature was constrained. Disorder was chan­
neled, it seemed, into patterns with some common underlying 
theme. (Chaos: Making a New SCience, page 152.) 

A strange attractor is a diagram that shows how a chaotic system 
changes with the passage of time. The system may be as simple as 
a mechanical pendulum or as complex as an epidemic or a finan­
cial market. At each instant in time, a new point is plotted, and the 
position of that point depends on certain variables that sum up the 
state of the system-perhaps the velocity of the pendulum, or the 
percent of the population afflicted by the epidemic, or the price of 
a stock. The behavior of the diagram, often revealing surprising 
patterns within disorder, gives scientists a way of understanding 
the behavior of the full dynamical system. 

The starting point of the attractor may be any plausible state of the 
system-the pendulum set swinging with a certain push. (Often 
you can choose a starting point by left-clicking the mouse at any 
place on screen.) The trail of points then heads toward the attrac­
tor. It is sucked in- attracted- showing how the dynamical system 
itself fa lls into its preferred behavior. The long-term path of the 
pOints shows whether the system is orderly or chaotic. If a spread­
ing disease, for example, eventually reaches a certain level, then its 
attractor will simply be a point . If a system finds a regular oscilla­
tion, like a pendulum swinging back and forth in a clock, its attrac­
tor will be a simple loop. But many systems turn chaotic, never set­
tling down at all, and their attractors are called "strange." A 
strange attractor is infinitely complicated because the path never 
reaches the same point twice. If it did, it would begin to repeat 
itself. 
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The Lorenz Attractor 

The mathematical physicist David Ruelle, with Floris Takens, 
coined the name in 1971, before he had ever actually seen a 
strange attractor. Later he discovered an "esthetic appeal" beyond 
their mathematical beauty: "These systems of curves, these clouds 
of pOints suggest sometimes fireworks or galaxies, sometimes 
strange and disquiet ing vegetal proliferations . A realm lies there of 
forms to explore, and harmonies to discover." 

The Lorenz Attractor 

• 
82 Chapter 4 

Perhaps the first and most famous strange attractor was discovered 
by Edward Lorenz, a meteorologist at the Massachusetts Institute 
of Technology, in 1963. Lorenz made a simple model of the 
weather to help h imself understand why this part icular dynamical 
system was so unpredictable. With the help of many hours of com­
puter time and considerable mathematical intuition, the best piC­
ture he could produce was a very simple image of a curving line. 

He sensed that the shape- a double spiral in three dimensions, 
bent like the wings of a butterfly- must follow an infinitely intri ­
cate path, but th is was hard to imagine, in an era when the word 
fractal had not been invented. He apologized. "It is difficult to rec­
oncile the merging of two surfaces, one containing each spiral, 
with the inabil ity of two traj ectories to merge," he wrote. "We see 
that each surface is really a pair of surfaces, so that, where they 
appear to merge, there are really four surfaces ... and we finally 
conclude that there is an infinite complex of surfaces." 

Decades passed before computer visualization finally made it easy 
to see the full richness of Lorenz's attractor. It exh ibits another 
quality that is characteristic of strange att ractors. The tiniest 
change in the starting point quickly grows to become a great diver­
gence in the outcome. Two paths that start nearby quickly pull 
apart. In the Earth's weather, that tendency is the surprising phe­
nomenon that Lorenz named the Buttert1y Effect: an atmospheric 
perturbation as tiny as the flapping of a butterfly 'S wings can cause 
large transformations in the weather across the globe within about 
a month. Hence the inevitable unpredictability of the weather 
over the long term . 



Yorke's Attractors 

Things To Try 

The screen shows a "flock" of paths, and you can change the flock 
to one, or a few, or many (press CD). Notice how nearby paths pull 
apart. You can see the paths with or without little "airplanes" 
(press CJ!!i) for each airplane) that help show the three-di mension­
ality of the movement. You can use the cursor either to launch 
new paths or to zoom in (press CD to select which of these will be 
active, and left-cl ick to launch the path or start the zoom). 

Yorke's Attractors 

The mathematician James Yorke- who gave the young field of 
chaos its name- has explored an unusual kind of attracto[, giving 
rise to images with an uncanny resemblance to wavy or gnarled 
forms in nature. They ill ustrate the power of a phenomenon called 
"mode locking," or quasiperiodicity, to pull chaos in to new pat­
terns. Mode locking is what causes two pendulum clocks that are 
touch ing each other to start swinging in synchronization; and 
causes the moon to lock into an orbit in which the same face 
always points toward the earth. 

Things To Try 

Slight adjustments cause remarkable changes in the pattern. First, 
press (IT) to display the Types menu and select Yorke on the menu. 
Then you can start exploring by pressing GD to see some of the 
rich possibilities. 

Henon's Attractors 

Around the time Lorenz was starting to use computers to see chaos 
in the weather, a French ast r nomer, Michel Henan, was doi ng the 
same for the stars. Two kinds of attractors bear his name. 

The simplest (the Henon Horseshoe) is a crescent or horseshoe 
shape that can be imagined as the result of repeatedly fold ing and 
stretching, folding and stretching the shape that holds the attrac­
tor. As a pastry chef creates a finely layered mille-feuille by folding 
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and stretching the dough, this astronomer created a strange attrac­
tor with infinitely many layers. Zooming in on what appears to be 
two paths shows that the two are rea lly four ... and then the four 
prove to be eight, and so on. 

Henon's other kind of attractor (the Henon attractor) shows how 
regions of order and chaos can mix in a single space. It grew out of 
his investigations of the way stars orbit around the center of the 
galaxy. Imagine that a single star passes from the front of the com­
puter screen into the screen and out the back, leaving a single 
point where it intersected the screen. Now it orbits around the 
galactic center, off to the side, and comes back around again . If its 
orbit is simple, it will strike the same point again. If it is somewhat 
more complicated, however, its intersections with the screen will 
start to form patterns- perhaps ovals, or groups of ovals. (Think of 
the screen as a slice through a doughnut.) If the orbit is completely 
chaotic, the points of intersection will scatter over a wide region of 
the screen. By releasing many stars at once, a "flock" of paths, we 
can see the interweaving of order and chaos, stability and instabil­
ity. Such patterns also arise in many earthly engineering problems 
involving regions of different energy levels. 

Things To Try 

Press CIT) to display the Types menu and select Henon on the 
menu. Explore the regiOns of order and disorder in Henon by start­
ing new paths with the select cursor (left-click or press ~ to start 
the new path). Each new orbit creates a region of color that may 
spread across the screen in looping patterns or in scattered chaos. 

Next, change to the Henon Horseshoe attractor. Press CIT) to dis­
play the Types menu and select Henon Horseshoe on the menu. 
Zoom in on Henon Horseshoe by first pressing m to change to 
the zoom cursor and then left-clicking or pressing~. 

The Logistic Attractors 

84 Chapter 4 

The most fundamental example of chaos may come from an equa­
tion that describes a highly idealized wildlife population-for 
example, fish in a pond. 



The Logistic Attractors 

The idea is that when there are few fish, they are free to multiply 
rapidly. When the pond starts to fill up, the population growth 
starts to slow. And when there are too many fish for the available 
food supply, the population growth changes depending on how 
big the population already is. 

A graph of the equation looks like an arch- the "hump" that 
appears on screen when you select Logistic Hump on the Types 
menu. If you imagine that low values of the population are on the 
left and high values on the right, the steepness of the arch shows 
what happens to the rate of growth. It is steepest where the popu­
lation is smallest. When the population is at a middle value, the 
curve is flat- population growth levels off. When the population 
is high, the slope is negative, because population growth is nega­
tive. 

There is just one variable added to the equation, to make things 
interesting. That is a parameter called chaoticity, the parameter you 
raise or lower by pressing uppercase or lowercase W, ffi, or IT] 
keys . In the case of a fish population, you might think of this as 
the general fertility of the fish. You can see the effect of changing 
this parameter on the shape of the hump. When the chaoticity is 
low, so is the hump; as it rises, the hump becomes steeper. 

The crucial question is what will happen to the population year 
after year. The answer turns out to depend on the chaoticity 
parameter. 

You might expect that a population will rise each year until it 
reaches an equilibrium. Perhaps it will overshoot the equilibrium 
a little, fall back, and eventually zero in on the stable value. Cer­
tainly that is what ecologists traditionally assumed. And for low 
levels of chaoticity, that is exactly what happens. 

You can watch the year-to-year change in population by choosing 
Logistic Pulse on the Types menu. The line traces the rising or fall­
ing population like the line of a stock-market chart. 

As the chaoticity-the fertility of the fish- increases, something 
unexpected happens. At a certain pOint, instead of settling down 
to an equilibrium, the population goes unstable in a very specific 
way. It starts to rise and fall in alternate years-oscillating between 
two different levels. 
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Continue to increase the chaoticity, and there is another point of 
crisi - another bifurcation. The two levels divide again, and n w 
there is a cycle of four populat ion values. Then they divide again, 
and again, faster and faster, through 8, 16,32 ... and then, sud­
denly, a new kind of behavior appears . The population never 
repeats itself. There are no cycles at all- just pure chaos. 

This phenomenon, studied using the very simple equation repro­
duced here, led to an explosion of chaos research. The phy icist 
Mitchell Feigenbaum discovered extraord inary, intricate structure 
in the pattern of successive bifurca tions and developed a theory to 
explain them. The structure he found has reappeared in many dif­
feren t chaotic systems, from electronic circuits to the human 
heartbeat. 

There are three ways of viewing the ph nomenon, each related to 
the others: 

• The Logistic Pulse shows the year-to-year change in the 
most st raightforward way. 

• The Logistic Hump shows how the curve of the equation 
works to generate the year-to-year values. Imagine that 
you start with a population of X and that there's a scale 
running from left to right across the bottom of the screen . 
You find X across the scale. Now you draw a li ne upward 
until it hits the curve. You determine the new population 
value from the height at that point. Now the new value is 
fed into the same equation in a continual feedback loop. 
This feeding- in of the new value is represented graphically 
by a sort of short cut. You draw a horizontal line until it 
hits the diagonal, and then a new vertical line up (or 
down, as the case may be) to the curve. And so on ... The 
trajectory either zeros in on one stable population level, 
orbits between two or more levels, or runs madly through 
a whole chaotic sequence of values. 

• The Logistic Map is a sort of bird's-eye view of the whole 
range of chaoticity values, from low (on the left) to high. 
The level of the population is represented vertically on 
screen. You can see that as chaoticity increases, the equi­
librium level of the population also increases, for a while. 
But suddenly the equil ibrium divides into two levels, one 
low and one high. Then there are new bifurcations, and 
then chaos- population values running up and down the 
screen wildly. Yet even within the zone of chaos, a surpris­
ing structure appears. You can zoom in on this zone with 
the zoom cursor by left-clicking or pressing ilii). You can 



Starting the Program 

see new cycles-places where there are 3, or 5, or other odd 
numbers of population values in successive years. And like 
so many of the images associated with chaos, this diagram 
is fractal, reflecting the universality of its structure: small 
parts of it turn out to resemble the whole. 

Starting the Program 

Select cursor 

Stamp outlines 

Live-action stamp 

When you start Strange Attractors, you see the following screen: 

The ma in image area of the screen shows the t rails and airplanes 
of the strange attractor ca lled the Lorenz attractor. The small white 
triangle is the select cursor. 

On the lower left, you see three rectangular outlines called stamps. 
The program stores stamp-sized versions of your three most recent 
images in the stamp outlines. Just below the outlines is the live­
action stamp, which shows th current attractor. 
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Exploring the Program 

• 
88 Chapter 4 

Try a few simple experiments with the strange attractors in this 
program before you learn how each feature works. You can learn 
more about the program's features later in this chapter. 

Note: Use the status line when you first work with the program, to 
help you identify different types of attractors. To display the status 
line, press aJD+CD. For details on the status line, see "Using the 
Status Line" on page 93. 

Begin by displaying the other types of attractors . 

1. With the Lorenz attractor displayed at the start of the pro­
gram, press CQ) to display the Yorke attractor. 
Notice the stamp image that appears in the first stamp out­
line, and the new live-action stamp that appears. For de­
tails on stamps, see "Using Stamps in the Program" on 
page 90. 

2. Continue to press CQ) to display the Henon and Henon 
Horseshoe attractors, and the Logistic Map, Logistic Pulse, 
and Logistic Hump attractors. 

3. Finally, press CQ) to display the Lorenz attractor again. 

Now, try several experiments with color. 

1. Display the Yorke attractor. 
2. Press aJD+CD to cycle colors continuously in the attrac­

tor. Watch how different colors enhance the ripples of this 
attractor. You can also press aJD+CD to redraw the image 
and watch the ripples start. 

3. Press 0 (comma key) seven or eight times to slow down 
the attractor. Then press aJD+CD to redraw the image. 
Watch the attractor slowly ripple into view as different col­
ors play across the image. 

4. Press aJD+CD two more times to turn the continuous col­
or cycling feature off. Press aJD+CQ) to return to the de­
fault palette. Press 0 (period key) seven or eight times to 
speed up the attractor again . 



Moving Around in the Image Area 

It's fun to listen to the attractors' "music" with the sound turned 
on. 

1. With the Yorke attractor displayed, press @+CYJtotum 
the sound on. You hear an intense buzzing sound. 

2. Press 0 (comma key) two or three times to slow down the 
attractor again. With the attractor slowed down, you can 
hear individual tones rise and fall. 

3. Press 0 (period key) two or three times to speed up the at­
tractor and the sound you're listening to. 

4. Press CQJ to display the next attractor. 
S. Repeat steps 2-4 until you 've listened to the sound of all 

the attractors in the program. 
6. Press @ +CYJ to turn the sound off. 

Moving Around in the Image Area 

You can use the mouse or the keyboard to move the cursor around 
in the image area. To move around using the keyboard, make sure 
( Num Lock) is turned off and refer to the following illustration: 

t 

Numeric keypad keys and direction of cursor movement 
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Using Stamps in the Program 

Th program generates stamps for changes you make, such as dis­
playing a new type of attractor or zooming in . (The program does 
not gen rate stamps when you make changes to the palette.) You 
can select one of the three images stored in the stamp outlines to 
display in the image area. 

• Select the stamp icon you want by left-clicking on it. The 
new image displays in the image area. 

Note: You can also press alD+CD, alD+W, or alD+G) to select 
a stamp image to display in the image area (with stamp 1 being just 
above the live-action stamp and stamp 3 at the top). 

You can get parameter information on a stamp image, too. 

1. Right-click on a stamp icon to view the parameter informa­
tion . 
If you're using a keyboard, you can press alD+ CIl , 
alD+(I), or alD+W to display a stamp information box 
(with stamp 4 being just above the live-act ion stamp and 
stamp 6 at the top). 

2. Click either mouse button or press any key to remove the 
stamp information box fro m the screen. 

Using the Select Cursor 

• 
90 Chapter 4 

Using the select cursor (the cursor initially shown in the image 
area) works differently for each attractor. 

• For Lorenz, when you left-click or press CJ!ii), you add an 
airplane, a moving trihedron that helps show the thre -
dimensionality of the attractor. You can have up to 80 air­
planes at anyone time in the attractor. When you right­
click or press @ill, you remove an airplane. Once you've 
removed all airplanes, right-clicking or pressing @ill re­
moves one of the moving pOints. You cannot remove the 
last moving pOint. 

• For Yorke and the two Henon attractors, when you left­
cli k or press CJ!ii), you add points to the attractor. When 
you right-click or pres @ill , you remove points . 



Zooming, Panning, and Centering 

The pOints you add and remove for these three types of at­
tractor can be subtle. For the Yorke attractor, the points 
you add are a new color from those already on screen. For 
the Henon attractor, set the Flock Size option on the 
Tweaks menu to Small, and then add pOints. For the Henon 
Horseshoe attractor, set the Flock Size option on the 
Tweaks menu to Medium, and then add points. Again, the 
points you add to Henon and Henon Horseshoe are a new 
color from those already on screen. When you remove 
points, you might help clarify the process by pressing 
(]]D+(]J now and then to redraw the screen. 

• For Logistic Map, when you left-click or press C@, you 
change to Logistic Pulse, and, depending on the pOint you 
have selected in Logistic Map, you set the starting value of 
a parameter called chaoticity. (Right-clicking or pressing 
@ill does not Change anything for Logistic Map.) 

• For Logistic Pulse and Logistic Hump, when you left-click 
or press C@, you change the initial value of t he point 
whose orbit is being tracked. When you right-click or press 
@ill , you return to Logistic Map. 

Zooming, Panning, and Centering 

Zooming In on an Image 

You can change from the select cursor (a small, white triangle) to 
the zoom cursor (a small, white box) and zoom in on different parts 
of attractors. For example, you might want a close-up of the air­
planes in the Lorenz attractor. (You cannot zoom in on Logistic 
Pulse or Logistic Hump.) 

1. Press CD to change back and forth between select cursor 
and zoom cursor. 

2. Move the zoom cursor to the desired location. (The cursor 
location becomes the center of the magnified image.) 

3. Left-click or press C@. 

4. To zoom out, right-click or press @ill. 
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For zooming in, you can also use a resizable zoom box that 
encloses any area you want to enlarge. 

1. Press (]lD +ffi to display the zoom box cursor. 
2. Move the zoom box to the location you want to zoom in 

on. 
3. Hold down the ( Shift) key and move the mouse to resize 

the zoom box. 
If you're using the keyboard, make the zoom box larger by 
pressing ( Shift) + (!) or ( Shift) + CB. Make it smaller by press­
ing ( Shift) + CD or ( Shift) + 8). (When you work with the Lo­
gistic Map attractor, you can automatically adjust the 
height and width of the zoom box independently. This al­
lows you to fit the zoom box to areas of the attractor that 
are compressed-looking.) 

4. Left-click or press ~ to zoom in on the specific area. 
S. With the zoom box displayed, you can also zoom out by 

right-clicking or pressing @ill . (After you zoom in or out 
with the zoom box, the cursor you were previously using 
reappears.) 

6. If you change your mind when working with the zoom 
box, you can press ~ to return to the cursor you were 
previously using. 

Panning an Image 

When you pan an image, you can see the parts of it that are outside 
the edges of the image area. 

1. Move the cursor to the location you want to pan to. (The 
cursor location becomes the center of the panned image.) 

2. Press (]lD+CQJ to pan to the new location. 

Centering an Image 

• 
92 Chapter 4 

Centering an attractor moves it to the center of the image area and 
unzooms it. 

• Press (]lD + CD· 



Examining an Attractor in Steps 

Examining an Attractor in Steps 

You can examine an attractor's activity one step at a time. When 
you look at the attractor in steps, you get a better idea of its move­
ment. 

1. Press the spacebar to stop the attractor's activity. 
2. Press the spacebar repeatedly to examine the activity one 

step at a time. 
3. When you've finis hed viewing the activity in steps, press 

( Shift) and the spacebar to restart the regular activity. 

Using the Status Line 

You can turn on a status line that displays the name of the attrac­
tor currently showing and some parameter information for the 
attractor. (The status line for Henon Horseshoe displays the attrac­
tor's name but no parameter information .) 

The following table summarizes the parameter information you 
can find in each attractor's status line. 

Parameter Lor. Yorke Henon Map Pulse Hump 

Axis (View) x 

Accuracy x 

Topology x 
(World Shape) 

Chaoticity x x x x 

Humpspot x x x 

To toggle the status line on and off 

• Press (ill + m· 
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Selecting an Attractor 

Keyboard shortcut: CQJ 

To select an attractor, left-click the F3 Types button at the upper­
left corner of the screen, or press Cill. The Types menu appears: 

Types Menu 

Lorenz Yorke 

Henon . Henon Horseshoe 

Logistic Hap Logistic Pulse Logistic Hul'lp 

F1 for HELP ESC to Cancel ACCEPT [:;s. 

• Select the button showing the name of the attractor you 
want to see. 

Using the Lorenz Attractor 

• 
94 Chapter 4 

The Lorenz attractor is a set of points moving in thre -dimensional 
space. The attractor is based on three equations for convection dis­
covered by meteorologist Edward Lorenz. The Lorenz attractor's 
moving point shows the chaotic rotation of a flu id. In this pro­
gram's Lorenz attractor, the moving points are shown by dots or 
by "airplanes"-trihedrons that twist and turn to fo llow the three­
dimensional contortions of the attractor's curving trajectory. The 
two "ears" of the attractor correspond to the two directions a cyl­
inder of fluid might rotate in . 



-
Using the Lorenz Attractor 

Tweaking Lorenz 

With the Lorenz attractor displayed, left-click the F4 Tweak button 
at the upper-left corner of the screen, or press ffi). The Lorenz 
Tweaks menu appears: 

Lorenz Tweaks 

Flock size: 

Uiew: 

Accuracy: 

F1 for Help Esc to Cancel " Accept ~ 

Use the options on this menu to change parameters for the Lorenz 
attractor. 

Changing Flock Size 

Keyboard shortcut: m to cycle through small , medium, and large 
flock sizes 

When you change the flock size in the Lorenz attractor, the pro­
gram removes all of the airp lanes, and it changes the number of 
trails shown in the attractor so you can focus on them. (Working 
with t he select cursor, you can add a total of 80 airplanes back in 
when you left-click or press CJ!l.iJ .) You can change the flock size to 
a small, medium, or large number of trails, or you can enter the 
number of trails in the entry field at the right side of the menu. 
The flock size settings on the buttons correspond to 1 (Sma ll), 27 
(Medium), and 64 (Large) . The default setting in the entry field is 9. 

• Select a size button (Small, Medium, Large), or enter a value 
between 1 and 64 and press 8. 

Changing View 

• 

Keyboard shortcut: m to select x-axis; CD to select y-axis; 
CD to select z-axis; CID to select fly view 

Selecting a view sets the viewing orientation showing the axis of 
the Lorenz attractor's spirals. You can view from the X-, y-, or z­
axis. For example, the x view projects the attractor onto the yz 
plane. You can also select fly view, in which the program moves a 
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set of axes to the location of one of the airplanes and projects an 
image of the attractor onto the plane of that airplane's ta il and 
wings. If you've been adding airplanes, it uses the newest one. The 
default setting is the y-axis. 

• Select a view button (X, Y, Z, or Fly). 

Suggestion: When you select fly view, you can observe more ea ily 
with just one airplane in the attractor. Right-click or press @ill to 
delete airplanes until you have just one airplane left. 

Changing Accuracy 

Keyboard shortcut: (Shift) + (]J to increase; (]J to decrease 

CHAOS updates the attractor step-by-step in the program's own 
simulation time. Each step takes the same amount of real time to 
calculate. Accuracy provides an approximate range of steps the pro­
gram performs per second of simulation time. When you change 
accuracy, you affect how slowly or rapidly the attractor moves, and 
how smooth or jagged its trail looks. 

You can select a low, medium, or high accuracy, or you can type 
an accuracy value in the entry field at the right side of the menu. 
You can enter a setting in integers. The default setting in the entry 
field is 100. 

• Select an accuracy button (Low, Medium, High), or enter a 
value between 10 and 10000 and press B. 

Suggestion: If you have a slower computer, you might prefer to set 
a low accuracy until you've found an area you wish to study in 
detail. 

Setting Ribbon Erase 

• 
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Keyboard shortcut: m 
The Ribbon Erase parameter lets you change how the attractor's 
trails are painted on screen. With Ribbon Erase off, trails are shown 
as continuous lines. With Ribbon Erase on (the default), trails 
appear as constantly mOVing, fixed- length li nes. Using this param­
eter helps you see the attractor's trajectory in phase space. 

Note: You can change the length of the displayed trails with the 
Trace Length option on the Options menu. See "Trace Length" on 
page 114 for details. 

• Select the On or Off button . 



Using the Yorke Attractor 

Turning Trails Off and On 

You can turn airplane trails off and on for the Lorenz attractor. 
This helps you see the twisting movement of the trihedrons. 

1. Set the Flock Size option on the Tweak menu to Small. 

2. With the select cursor displayed, left-click or press ~ and 
insert as many ai rplanes as you want. 

3. Press CD to turn trails off. (Press @+CD to clean up old 
trails.) Watch the trihedrons' movement. 

4. When you're ready to work with trails on, press CD again 
and set flock size the way you want. 

Using the Yorke Attractor 

• 

The Yorke attractor is a set of pOints moving in a two-dimensional 
plane. The points for this attractor- and for the Henon and Henon 
Horseshoe attractors- are like fluorescent fleas that hop around 
and mark the attractor's outline. Discovered by mathematician 
James Yorke, this attractor involves the interplay of different 
rhythms (like planetary orbits) that produce a special kind of 
chaos . 
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Tweaking Yorke 

With the Yorke attractor displayed, left-click the F4 Tweak button 
at the upper-left corner of the screen, or press Cill . The Yorke 
Tweaks m nu appears: 

Flock size : 

Randol'lize . Reset 

F1 for Help Esc to Cancel Accept ~ 

Use the options on this menu to change parameters for the Yorke 
attractor. 

Changing Flock Size 

• 
98 Chapter 4 

Keyboard shortcut: m to cycle through small, medium, and large 
flock sizes 

Setting a flock size changes the number of pOints moving around 
on th strange attractor. When you set a lower flock size for Yorke, 
you can see the gnarled patte rns being formed by the points. You 
can change the flock size to a small, medium, or large number of 
points. The default setting is Medium. 

• Select a size button (Small, Medium, La rge) . 
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Using the Yorke Attractor 

Setting Trace Type 

Keyboard shortcut: CD to toggle between pOints and lines 

When you select a trace type, you change how the program releases 
pOints for the strange attractor. The program can release pOints as 
individual dots (the default), or as lines. When you set trace type 
to Line, the program draws lines connecting successive point posi­
tions, erasing the old lines according to the length of the trail. 
Points that wrap around the screen in Yorke are not computed. 

• Select the Poin t or Line button. 

Suggestion: Set trace type to Line, and redraw the screen with 
alD+IT). Then press 0 or ( Shift ) +0 several times to see the 
dance of the attractor. It's also interest ing to do th is experiment 
with the sound turned on (press alD+CD). 

Changing World Shape 

2 

2 

Torus 

Keyboard shortcut: G'D to cycle through Torus, Klein, and 
Projective world shapes 

In th Yorke attractol', pOints wrap, or go off screen and come back 
on at different locations. The three different world shapes of the 
Yorke attractor relate to how points on the screen wrap. The 
default setti ng is Torus. 

The following illustration shows how pOints on the screen wrap 
for each world shape: 

2 2 

3 3 

3 
3 

2 2 

Klein Projective 

• Select a world shape button (Torus, Klein, Projective). 

Suggestion: After you change to a new world shape, you might 
want to randomize repeated ly to see how differen t ca lculations 
change the world shape. Press m repeatedly to randomize the 
attractor. You might also want to try different values of chaoticity 
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after you randomize. See the next section for several keyboard 
shortcuts that allow you to adjust chaoticity. 

Changing Chaoticity 

Keyboard shortcut: (Shift) + GD increases by .1; GD decreases by .1; 
(Shift )+CD increases by .01; CD decreases by .01; 
( Shift ) +0 increases by .001; 0 decreases by .001 

When you set the chaoticity parameter, you change internal calcu­
lations that control how messy or form less the attractor looks. 
Changing chaoticity weakens or strengthens the feedback loop of 
calculations, in which equat ions are repeated again and again. For 
higher chaoticity, the result is more messy looking attractors; for 
lower chaoticity, less messy looking attractors. The default setting 
for chaoticity in Yorke is O.SOO. 

To change the parameter with t he mouse on the slider bar 

• Hold down the left mouse button and drag the box in the 
slider to the setting you want. The sett ing in the entry field 
at the left changes a you move the box. 

or 

• Left-click the plus or minus buttons below the slider bar. 
The greater the number of plus symbols on the button, the 
larger the increment. 

To hange the parameter with the keyboard fo r the slider bar 

• With the cursor in the slider bar, press CB or B to move 
the slider. Press ( Shift) + CB or ( Shift) + B to move the slider 
in larger increments. 

To change the parameter with the entry field 

• Enter a value between 0.0 and 4.0 and press B. 

Changing X Shift and Y Shift 

For each setting of x shift and y shift, there's a different sequence 
of Yorke attractors. If you set chaoticity to 0 with x and y shift 
parameters at their defaults, the program produces diagona l pat­
terns of pOints. The x and y shift parameters control the direction 
of the diagonal patterns. When you increase chaoticity, the pat­
terns become more ridged-looking. Finally, as you continue to 
increase chaoticity, the patterns begin to break up into chaos. The 

• default setting for x shift is 0.486, and for y shift, 0.90S. 
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To change x shift and y shift parameters, follow the instructions 
for u ing the slider bar in the previous section, "Changing Chao­
ticity./I 

To change x shift and y shift with the entry fie lds 

• Enter a value between -1 and 1 and press 8. 

Randomizing Yorke 

Keyboard shortcut: CID 

You can randomize two Yorke parameters: x and y shift. The first 
five times you randomize, you get the same preset values. These 
preset values were discovered by James Yorke and published in one 
of his papers. 

• Select the Randomize button. 

Note: Randomization happens immediately after you select the 
Randomize button, so you don't have to confirm by selecting the 
Accept button . If you want to check what values x shift and y shift 
changed to, check the Yorke Tweaks menu. 

Resetting Yorke 

Keyboard shortcut: (Shift) + CID 

You can reset the original parameters for chaoticity and x and y 
shift. 

• Select the Reset button. 

Note: Resett ing also happens immediately after you elect the 
Reset button, so you don't have to confirm by selecting the Accept 
button. 

Using the Henon Attractor 

Keyboard shortcut: CID toggles two Henon attractor types 
(only when Henon or Henon Horseshoe is displayed) 

The Henan attractor is a set of points moving in a two-dimensional 
plane. Modeled by French astronomer Michel Henon, the Henon 
attractor shows stellar orbits around a galactic center. The points 
outline a torus (a doughnut shape), with separate to ruses around 
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the central toms. Unstable orbits scatter points around randomly. 
The final image is one of disorder surrounding order, of is lands 
around other is lands. With magnification, other islands on smaller 
and smaller scales appear. 

Tweaking Henon 

With the Henon attractor displayed, le ft-click the F4 Tweak button 
at the upper-left corner of the screen, or press (E) . The Henon 
Tweaks menu fo r the Henon attractor appears: 

Henon Tweaks 

Flock size: 

Trace type: 

Chaotlcity 

F1 for Help Esc to Cancel Accept r:.s 

Use the options on this menu to change parameters for the Henon 
attractor. 

Changing Flock Size 

Keyboard shortcut: m to cycle through small, medium, and large 
flock sizes 

Setting a flock size changes the number of pOints moving around 
on the strange attractor. When you change to a lower flock size, 
the program removes the islands and leaves just one or several 
rings of points. (Working with the select cursor, you can add 
points back in when you left-click or press 0!!iJ .) You can change 
the flock size to a small, medium, or large number of pOin ts. These 
correspond to flock sizes of 1, 4, and 64, respectively.) The default 
setting is Large. 

• Select a size button (Small, Medium, Large) . 

Setting Trace Type 
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Keyboard shortcut: OJ to toggle between points and lines 

For a description of this parameter and instructions on how to 
. change it, see "Setting Trace Type" on page 99. 



Using the Henon Horseshoe Attractor 

Note: Setting a line trace type works best for Henon with a medium 
flock size. 

Changing Chaoticity 

Keyboard shortcut: (Shift l+ffi increases by .1; CD decreases by .1; 
( Shift) + m increases by .01; OJ decreases by .01; 
( Shift) + m increases by .001; m decreases by .001 

In Henon, each setting of chaoticity gives a pattern in which 
points either move periodically or race off screen. A point that goes 
off screen is thrown back on screen in search of a periodic orbit. As 
the points hunt for periodic orbits, they draw a messy, chaotic 
outer region, and an orderly inner region. Sometimes it is neces­
sary to zoom out to see both regions. For instructions on how to 
change this parameter, see "Changing Chaoticity" on page 100. 
The default setting for chaoticity in Henon is 1.528. 

Using the Henon Horseshoe Attractor 

• 

Keyboard shortcut: (ill toggles two Henon attractor types 
(only when Henon or Henon Horseshoe is displayed) 

The Henan Horseshoe attractor is a set of points moving in a two­
dimensional plane. Henon Horseshoe shows an attractor where 
phase space is repeatedly stretched and folded into many thin lay­
ers. The points outline a crescent shape consisting of many lines of 
points . 

Strange Attractors 103 



Using the Henon Horseshoe Attractor 

Tweaking Henon Horseshoe 

With Henan Horseshoe displayed, left-click the F4 Tweak button at 
the upper-left corner of the screen, or press @. The Henan 
Tweaks menu for Henan Horseshoe appea rs: 

Henon Tweaks 

Fl ock size: 

F1 for Help Esc to Cancel Accept Ii-

Note: CHAOS dims the chaoticity parameter on th is menu, which 
means that this parameter is not available for Henan Horseshoe. 

Use the options on this menu to change parameters for the Henan 
Horseshoe attractor. 

Changing Flock Size 

Keyboard shortcut: m to cycle through small, medium, and large 
flock size 

Setti ng a flock size changes the number of points moving around 
on the strange attractor. When you change to a lower flock size, 
the program removes points and leaves just one or several lines of 
points. (Working with the select cursor, you can add points back 
in when you left-click or press ~.) You can change the fl ock size 
to a small, medium, or large number of points. These correspond 
to flock sizes of I , 2 and 16, respectively. The default sett ing is 
Large. 

• Select a size button (Small, Med iu m, Large). 

Setting Trace Type 

• 
704 Chapter 4 

Keyboard shortcut: OJ to toggle between points and lines 

For a description of th is parameter and instructions on how to 
change it, see "Setting Trace Type" on page 99 . 



Using the Logistic Map Attractor 

Using the Logistic Map Attractor 

The Logistic Map attractor demonstrates a route to chaos by bifur­
cation, or splitt ing into two. Developed by biologist Robert May, 
the attractor shows how changes in one parameter for an equation 
relating to population behavior affect the behavior of the ent ire 
system. Values of this parameter are shown from left to right, with 
the fina l population plotted on the vertical axis. 

When you look at the Logistic Map, you see the following areas of 
population behavior in the equation: 

With a low parameter set in the equation, the population becomes 
extinct. Increasing the parameter makes the equilibrium level of 
the population rise. At a certain point (known as period two) when 
the population rises, the equilibrium splits in two, and the popu­
lation level begins to alternate. These bifurcations sta rt coming 
more rapidly-and suddenly, the system turns chaotic, with the 
population going to an infinite number of values. 

Although the chaotic region seems to be nothing but disorder, you 
can find order there. Period doubling appears in different parts of 
the chaotic area. When you magnify certajn parts of the seemingly 
random region, you see that they resemble the whole attractor. 
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Note: For the Logistic Map attractor, the screen paints repeatedly, 
with higher and higher precision. After the first few screen paints, 
Logistic Map leaves all points on screen, even though its 
calculat ions get more accurate. After letting it run awhile, you can 
press alD+CD to clean up the image. 

Tweaking Logistic Map 

With the Logistic Map attractor displayed, left-click the F4 Tweak 
button at the upper-left corner of the screen, or press @ . The 
Logistic Tweaks menu fo r Logistic Map appears: 

. F1 for Help Esc to Cancel Accept r:s 

Note: CHAOS dims the Chaoticity parameter on this menu, which 
means that this parameter is not available for Logistic Map. 

Use the options on this menu to change parameters for the Logis­
tic Map attractor. 

Changing Accuracy 

• 
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Keyboard shortcut: ( Shift )+OD to increase; OD to decrease 

When you change accuracy, you control how many separate point 
positions the program computes for each vertical cross-section 
through the map. You can select a low, medium, or high accuracy. 
The default setting is Low. 

• Select an accuracy button (Low, Medium, High). 

Suggestion: You can see much more detail when you zoom in on 
the Logistic Map attractor if you set accuracy to high . 



Using Logistic Pulse 

Changing Humpspot 

Keyboard shortcut: (Shift) + (]J to increase; (]J to decrease 

The Humpspot parameter changes the shape of the curve used to 
compute the function underlying the Logistic imagery. The 
humpspot is the h orizontal location of the h igh point of the curve 
shown in the Logistic Hump attractor. The default Humpspot set­
t ing is O.SOO. 

To change the parameter with the mouse on the slider bar 

• Hold down the left mouse button and drag the box in the 
slider to the setting you want. The setting in the entry field 
at the left changes as you move the box. 

or 

• Left-click the plus or minus buttons below the slider bar. 
The greater the number of plus symbols on the button, the 
larger the increment. 

To change the parameter with the keyboard for the slider bar 

• With the cursor in the slider bar, press (B or B to move 
the slider. Press ( Shift) + (B or ( Shift ) + B to move the slider 
in larger increments. 

To change the parameter with the entry field 

• Enter a value between 0.1 and 0.9 and press B. 

Using Logistic Pulse 

Keyboard shortcut: CD (only with Logistic Map or Logistic Hump 
displayed) 

Logistic Pulse is a pulse line linked to Logistic Map. Each vertical 
cross-section of the Logistic Map corresponds to a diffe ren t Logis­
tic Pulse. When you left-click or press CIiiU in a region of Logistic 
Map, Logistic Pulse demonstrates what kind of periodicity there is 
in the region (period two, period four, and so on), or whether there 
is chaos there. Then you can right-click or press @ill to return to 
Logistic Map. 
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Period two 

Chaos 

(I 
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For example, left-click or press ~ in the region to the right of the 
first bifurcation (the region labeled "Period Two" in the screen 
illustration for Logistic Map). Here's part of what you see on 
screen: 

To find out what periodicity you are looking at, count the pOints 
on the sawtooth curve until the pattern recurs. In the previous 
illustration, you can count just two points before the same pattern 
repeats, so you have period two. 

When you left-click or press ~ in the chaotic region of Logist ic 
Map, here's part of what you see on screen: 

You cannot find a recurring pattern of pOints to count in the illus­
tration of this pulse, so you know you are looking at a chaotic 
region . 



Using Logistic Pulse 

Tweaking Logistic Pulse 

With Logistic Pulse displayed, left-click the F4 Tweak button at the 
upper-left corner of the screen, or press ffi). The Logistic Tweaks 
menu for Logistic Pulse appears: 

Accuracy: 

F1 for Help Esc to Cancel Accept ~ 

Note: CHAOS dims the Accuracy parameter on this menu, which 
means that this parameter is not available for Logistic Pulse. 

Use the options on this menu to change parameters for Logistic 
Pulse. 

Changing Chaoticity 

Keyboard shortcut: (Shift ) +0 increases by .1; 0 decreases by .1; 
(Shift )+CD increases by .01; CD decreases by .01; 
( Shift) +CD increases by .001; CD decreases by .001 

The Chaoticity parameter determines which vertical cross-section 
of Logistic Map the Pulse is based on. Setting chaoticity values 
between 3.5 and 4.0 shows the greatest variety. For instructions on 
how to change this parameter, see "Changing Chaoticity" on page 
100. The default setting for chaoticity in Logistic Pulse is 3.800. 

• Enter a value between 0.001 and 3.999 and press 8. 

Changing Humpspot 

Keyboard shortcut: (Shift) + m to increase; m to decrease 

For a description of this parameter and instructions on how to 
change it using the slider bar, see "Changing Humpspot" on page 
107. 
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Using the Logistic Hump Attractor 

To change the parameter using the en try field 

• Enter a value between 0.1 and 0.9 and press B . 

Using the Logistic Hump Attractor 
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Keyboard shortcut: CD (only with Logistic Pulse displayed) 

The Logistic Hump attractor shows a parabolic curve with li nes 
chasing around it in a spiderweb pattern. This represents the cal­
culations underlying the Logistic Pulse. In trying to understand 
the boundary region between order and chaos, mathematician 
Mitchell J. Feigenbaum discovered the principle of universality. 
Here, universality means that the same pattern of period-doubling 
can be found on differently shaped curves. Feigenbaum saw that 
period-doublings mark a transition near the region between order 
and chaos. 

The Logistic Hump is a way to visualize one year's population and 
the next year's. Instead of a steady, limitless growth for the popu­
lation, or a parabola where the population goes back down, Fei­
genbaum's principle of universality proposed a critical "hump," 
which depended on steepness or the degree of nonlinearity in the 
equation . 

Here's an illustration of how this works: 

The line 
y=x 



Using the Logist ic Hump Attractor 

Suggestion: As you work with the Logistic Hump, you should keep 
pressing alD +ffi to redraw the image. Examining this attractor 
in single steps helps you see its patterns, too. For details, see 
"Examining an Attractor in Steps" on page 93. 

Tweaking Logistic Hump 

With Logistic Hump displayed, left-click the F4 Tweak button at 
the upper-left corner of the screen, or press @ . The Logistic 
Tweaks menu for Logistic Hump appears: 

logistic Tweaks 

Accuracy: fFiiji~:"" 

HUlllpspot 

F1 for Help Esc to Cancel Accept hr 

Note: CHAOS dims the Accuracy parameter on this menu, which 
means that this parameter is not available fo r Logistic Hump. 

Use the options on th is menu to change parameters for Logistic 
Hump. 

Changing Chaoticity 

Keyboard shortcut: (Shift )+0 increases by .1; m decreases by .1; 
( Shift ) +CD increases by .01; CD decreases by .01; 
( Shift )+0 increases by .001; CD decreases by .001 

The Chaoticity parameter determines which vertical cross-section 
of Logistic Map the Hump is based on. Setting chaoticity values 
between 3.5 and 4.0 shows the greatest variety. For instructions on 
how to change this parameter, see "Changing Chaoticity" on page 
100. The default setting for chaoticity in Logistic Hump is 3.800. 

• Ente r a value between 0.001 and 3.999 and press 8 . 
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Changing Humpspot 

Keyboard shortcut: ( Shift ) + m to increase; m to decrease 

For a description of this parameter and instruct ions on how to 
change it, see "Changing Humpspot" on page 107. 

Using the Options Menu 

With the Options menu, you can turn on color, sound, and stamp­
ing options, and you can change cursor mode and set trace length . 

To select options, left-click the F5 Opts button at the upper-left cor­
ner of the screen, or press @ . The Options menu appears: 

Palette: 

Sound: 

Stalllping: 

Cursor: 

F1 for HELP ESC to Cancel ACCEPT ~ 

Color Options 

• 
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The following color options are common to five of the CHAOS 
programs. For details on these options, see "Using Color Options" 
on page 214. 

• Color Cycle Once 

• Auto Cycle 
• Palette (Default, Random, Preset, Edit) 

• Monochrome 



Using the Options Menu 

Cursor Mode 

Stamping 

Sound 

Keyboard shortcut: CD 

When you work with strange attractors in this program, you can 
use either the select cursor or the zoom cursor. For details on work­
ing with the select cursor, see "Using the Select Cursor" on page 
90. To find out how to use the zoom cursor, see "looming In on 
an Image" on page 91. The default setting is select cursor. 

• Select the Zoom or Select button to work with the cursor 
you want. 

Suggestion: If you're unsure where you are afte r zooming, you can 
always re-center the image by pressing C1ID+CD. 

Keyboard shortcut: C1ID + CD 

You can work with automatic stamping or manual stamping. 
Automatic stamping saves a stamp for every change you make. 
Manual stamping saves a stamp only when you press the keyboard 
shortcut shown here. The default is automatic stamping. 

• Select the Automatic or Man ual button to save stamps ei­
ther automatically or only when you request it. 

Keyboard shortcut: C1ID + m 
When you turn the sound on in Strange Attractors, you hear mul­
tiple tones that follow the movement of points in each attractor. 
The default is sound off. 

• Select the On or Off button to turn sound on or off. 

Suggestion: Try slowing down an attractor when you turn the 
sound on . Press 0 (comma key) to slow down the sound and 
listen to individual points being released. Press 0 (period key) to 
speed up the activity again. 
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Saving and Loading Files 

Trace Length 

Keyboard shortcut: (Shift ) +QJ to increase; CD to decrease 

Changing trace length affects the length of the trails in Lorenz, 
Yorke, Henon, and Henon Horseshoe. Changing trace length does 
not affect any of the Logistic attractors. You can change the trace 
length for Lorenz only if you have set the Ribbon Erase option on 
the Lorenz Tweaks menu to On. You can alter the trace length for 
Yorke, Henon, and Henon Horseshoe only if you have selected the 
Line option on each Tweaks menu. 

The default settings are 40 for the Lorenz attractor, and 3 for the 
Yorke, Henon, and Henon Horseshoe attractors. You can enter a 
trace length between 16 and 128 for the Lorenz attractor; and 
between 4 and 128 for the Yorke, Henon, and Henon Horseshoe 
attractors. 

• Enter the new value for trace length and press B . You can 
also increase or decrease trace length by using the CD or 
G buttons next to the Trace Length option. 

Saving and Loading Files 

Use the options on the File menu to save and reload parameter files 
and .giffiles. For details on saving and reloading files, see "Saving 
and Loading Files" on page 209. 

The Mathematics of the Program 

• 

This program shows strange attractors in several kinds of dynami­
cal systems. 

A dynamical system consists of a space plus a "dynamic" that tells 
how particles in this space are supposed to move. The underlying 
space can be a 1D line, a 2D surface, a 3D space, or a space of 
higher dimensions. 

Examples of higher-dimensional dynamical systems occur when 
. physicists talk about systems with many independent variables. If, 

for instance, we were to be interested in a system of three moving 
particles, each with three space coordinates and three velocity 



The Mathematics of the Program 

components, then the complete state of the system would involve 
specifying six numbers per particle for a total of eighteen numbers 
in all. The state of the system would correspond to a location in an 
eighteen-dimensional" phase space." 

Higher-dimensional spaces are hard to visualize, so in the pro­
gram, the Lorenz attractor is part of a th ree-dimensional dynami­
cal system, the Yorke and Henon attractors are in two-dimensional 
dynamical systems, and the Logistic map is based on a one­
dimensional dynamical sys tem. 

The "dynamic" that fills the space of a dynamical system is a sys­
tematic method for moving from point to pOint. This means that 
for each point P of the space, the dynamic picks a unique next 
pOint, which is called new(P). In formal terms, we can call the space 
S and say that the dynamic is a one-to-one fu nction that maps S 
in to S. 

If we pick an arbitrary point P as a starting pOint, we can look at 
the point's orbit, which consists of the pOints P, new(P) , 
new(new(P», and so on . In some cases it's useful to draw lines con­
necting the successive points of the orbit, but keep in mind that it 
may often happen that the successive points of the orbit are not 
close to one another at all. 

We can watch the action of the dynamic by releasing a test particle 
into the dynamical system at a point P. Now if it turns out that the 
orbits of many test pOints tend to cycle around a certain region of 
space, then th is region is called an attl·actor, and if the attractor is 
complicated in an interesting way, it is called a strange attractor. 

The rules by wh ich the dynamic moves a particle from point P to 
the point new(P) are sometimes given as equations that give the 
coordinates of new(P) in terms of the coordinates of P. This is the 
way in which the Yorke, Henon and Logistic attractors are 
described. 

The description of the dynamic that yields the Lorenz attractor is 
a bit more complicated. Here, instead of specifying the coordinates 
of new(P) in terms of P, we specify the velocity in terms of P. If we 
imagine a time interval dt elapsing between the observation of P 
and new(P), we can think of the Lorenz equations as specifying a 
vector velocity (new(P) - P)/dt in terms of P. 
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A vector velocity actually involves three speeds: the speed in the x­
direction, the speed in the y-direction, and the speed in the z­
direction. If the velocity is taken over a very short t ime interval dt, 
we are effectively looking at three derivatives, dx/dt, dy/dt, and 
dz/d t. The Lorenz equations are so-called differen tial equations, 
which affect the motion of a point in 3D space like an odd force 
field. The equations are 

dx/dt = lO*(y - x) 
dy/dt = ( 28*x ) - Y - ( x*z ) 
dz/dt = -( 8/3)*z + ( x*y ) 

Using these equations on a particle at any point P(x,y,z) in the 
space of the Lorenz attractor, we find the direction 
(dx/dt, dy/dt, dz/dt) which the particle should move in next. 
Depending on whether our Accuracy parameter is set to High or to 
Low, the particle then takes a small or a large step in the direction 
given by the equations. To make the simulation even more accu­
rate, we actually take a weighted average of the velocity predicted 
for the particle at several nearby paints. This t rick is known as the 
Runge-Kutte method, and is available as an option in our Magnets 
and Pendulum program as well. 

The exact values of the three parameters 10, 28, and -8/3 were 
found by Lorenz to yield the nicest image. We could have allowed 
the user to try tweaking these parameters to different values-but 
none of the different values look as good. Instead, the user can 
tweak the simulation by changing the accuracy, the direction from 
which the attractor is viewed, the number of particles moving 
around the attractor, and the types of t rails the particles leave. 

The Lorenz equations actually describe the motion of a ring of hot 
and cool air arollnd an atmospheric convection cell. The x param­
eter represents the clockwise or coun terclockwise motion of the 
air, and the y and z parameters measure the distribution of temper­
atures around the ring. The moving pOints correspond to evolving 
states of system; when a point switches from one "ear" of the 
attractor to the other, this corresponds to a rotating ring changing 
its direction of rotation . 

The Henon, Yorke, and Logistic attractors are conceptually much 
simpler. Instead of involving differential equations, these systems 
give the coordinates of new(P) directly in terms of P. In each of 
these systems, we single out one of the parameters for the user to 
tweak, and call the parameter the chaoticity. 



The Mathematics of the Program 

The Henon attractors lie in two-dimensional space. They are gen­
erated by a dynamic that maps a point (x,y) into the poin t 
(newx,newy), where newx and newy are specified by a chaoticity 
parameter A, and by the equations: 

newx = x*cos(A) - (y - x2)*sin(A) 

newy = x*sin(A) - (y - x2)*cos(A) 

On our Henon Tweaks menu, the user can move a parameter B 
between 0 and 4. The parameter A used in the Henon equations is 
actually B*(n/4), so that as the user moves B from 0 to 4, A moves 
from 0 to 1t, covering half of the possible combinations of sine and 
cosine. (Keep in mind that in the so-called radian measure that sci­
entists use, n/2 is 90 degrees, and 2*n is 360 degrees.) If we were to 
let A move through the range n to 2*n, we'd get rotated versions of 
the same images that occur between 0 and 1t. 

As a special case, our program also shows the so-called Henon 
Horseshoe map, which is given by the equations: 

new x = 1 + Y - 1.4*x2 

new y = O.3*x 

The Yorke maps are based on two particular functions TRIGX(x,y) 
and TRIGY(x,y), on two constants x shift and y shift, and on a cha­
oticity parameter A. The equations are 

newx = oldx + x shift + A* ( TRIGX(oldx, oldy) ) WRAP 1 
newy = oldy + Y shift + A*( TRIGY(oldx, oldy) ) WRAP 1 

TRIGX and TRIGY are each a fixed linear combination of four sine 
functions of linear combinations of x and y. WRAP 1 means that if 
a value is larger than 1 or less than 0, Yorke wraps it back around 
to a value between 0 and 1. Thus, for instance, 1.13 becomes 0.13, 
-0.33 becomes (1- 0.33) = 0.67, 2.124 becomes 0.124, and so on. 
This "torus wrap" is analogous to the "modulo" operator for inte­
gers. There are actually two other ways of wrapping that we allow: 
a "Klein bottle" wrap (in which the vertical axis gets a half twist) 
and a "projective plane" wrap (both axes get half twists). In a Klein 
bottle wrap, for instance, the point (x,1.3) gets wrapped to the 
point (1 - x,O.3), provided x is between 0 and 1. 

On our Yorke Tweaks menu, the user can move a parameter B 
between 0 and 4. The parameter A used in the Yorke equations is 
actually B / (2*n ), so that as the user moves B from 0 to 4, A moves 
from 0 to 2/n. 

The TRIGX and TRIGY maps are given in terms of no less than six­
teen parameters! 

• 
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AllO = -0.26813663648754 
B110 = 0.98546084298505 
A210 = 0.0881861167 1542 
B2 lO = 0.99030722865609 
AlOl = -0.9lO67559396390 
BIOI = 0.50446045609351 
A201 = -0.56502889980448 
B201 = 0 .33630697012268 
A111 = 0.31172026382793 
BIll = 0.94707472523078 
A21I = 0.16299548727086 
B21 1 = 0.2980492123097 1 
A11m1 = -0.04003977835470 
Bllm1 = 0 .23350lO5508507 
A21m1 = -0.80398881978155 
B21ml = 0.15506467277737 

TRIGX(x,y) = AllO*sin( 2*1t*( x + B110 )) + 

AlO1*sin( 2*1t*( y + BIOI )) + 

A111*sin( 2*1t*( x + y + Bill) ) + 

A11ml *sin( 2*rr* ( x - y + B11 m1 ) ) 

TRIGY(x,y) = A2lO*sin( 2*n*( x + B2lO )) + . 

A201*sin( 2*rr*( y + B201 )) + 

A211 *sin( 2*1t*( x + y + B211 )) + 

A21m 1*sin ( 2*1t*( x - y + B21m1 )) 

Where on earth did we come up with such a gnarly definition of a 
function? We copied it out of a paper by Yorke! Where did he get 
it? By a process of informed trial and error. And what about the x 
shift and y shift parameters? These are what you change when you 
press the 0 key. The fi rst five times you press 0, you get preset 
values of x shift and y shift which we took from the same paper by 
Yorke. But from then on these values are taken to be random real 
numbers between 0 and 1. The remarkable thing is that no matter 
what values of x shift and y shift you end up with, you can tweak 
the Chaoticity to a value which will make the attractor look good. 

The Logist ic map tracks a pOint in 1D space acting under a 
dynamic that takes x to newx according to the equation: 

new x = A~x* ( 1 - x ) 

In Logistic Pulse and Logistic Hump, the chaoticity parameter A is 
adjusted directly on the Logistic Tweaks menu to lie between 0 and 
4 . 
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In the Logistic Map picture, all the possible values of A from 0 to 4 
are used, wi th this parameter running along the horizontal axis 
from left to right. The successive x values are plotted vertically, 
with a different color used for each successive x value. 

In the Logistic Pulse pictures, we show the successive values of x as 
pOints on a sawtooth curve. Left-clicking the mouse in th is simu­
lation selects different start values for x. 

In the Logistic Hump pictures, we show a graphic image of how 
the successive values of x are computed. The parabola is a graph of 
the equation y = k~x* ( 1 - x ), where x is the horizontal axis. The 
diagonal line is a graph of the equation y = x. Left -clicking the 
mouse chooses a new horizonta l sta rting position for x. Moving up 
to the parabola sets y equal to the newx values A*x*(1 - x). Going 
across from the parabola to the diagonal line finds the value of x 
that is equal to this newx y value. Moving vertically from that line 
point to the parabola again gets the new newx value, and so on. 
(See the illustration in the section "Using the Logistic Hump 
Attractor" on page 110.) 

As it turns out, the same attractor behavior occurs for other simply 
humped graphs besides the parabola A*x* ( 1 - x). In particular, if n 
is any number, then the equation: 

newx = [ f*Xn (1 - xn) 1 (l I n) 

yields the same behavior. 

• 
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Chapter 5 

The Chaos Game 

Barnsley and his co-workers now embarked on an out-or-control 
program of producing pictures, cabbages and molds and 
mud . . . As points flash across the computer screen, no one can 
guess where the next one will appear; that depends on the flip 
of the machine's internal coin. Yet somehow the flow oflight al­
ways remains within the bounds necessary to carve a shape in 
phosphorous. The role of chance is an illusion . .. (Chaos: 
Making a New SCience, page 237.) 

Entranced by the mathematical beauty of Mitchell Feigenbaum's 
attractor and Benoit Mandelbrot's fractals, an Oxford-educated 
mathematician, Michael Barnsley, set out to create one of the most 
intensely practical applications of the new science. He called it the 
Chaos Game. It is a way of taking simple ru les, adding a bit of ran­
domness to the stew, and producing recognizable images. 

Imagine that the computer screen is a map of Colorado. You start 
anyplace-Denver, say. You are going to hop from Denver to a 
new place, according to a certain rule. Then you are going to apply 
the rule again, and again, and again, leaving a dot on the screen 
each time, to trace your progress. 

Only simple rules are allowed. For example, the rule might be, 
move directly north, half the distance to the border (or the edge of 
the screen) . Suppose you applied that rule not just to a single point 
but to a region- say, the entire city of Denver. You would get a 
new region, relocated halfway to Wyoming, the same size as Den­
ver in the east-west direction but only half the size in the north­
south direction. Denver will have been moved and squashed. In 
fact, the way to visualize the rule is to think about what it does to 
any region. In this case, it moves the region north and squashes it 
top and bottom. Other rules might stretch a region east and west; 
or rotate a region clockwise 30 degrees; or "flip" a region into its 
mirror image; or "shear" a region into a parallelogram, by pulling 
the top to the west and the bot~m to the east. In fact those are the 
only rules allowed: shrink or stretch, rotate clockwise or counter­
clockwise, flip or shear. 

121 



Things To fry 

To play the Chaos Game, you take more than one rule, perhaps 
just two or three, perhaps a half-dozen or more. You start at Den­
ver and apply one of the rules. You've moved (perhaps halfway to 
Wyoming). Now you start at the new point and apply one of the 
rules. And so on. How do you decide which rule to apply each 
t ime? At random. You flip a coin, or you let the computer make a 
random choice. Each rule has a "weight" that makes it more likely 
or less likely to be chosen. With six ru les of equal weight, you 
could just roll one die to choose the rule. Or perhaps you would 
like to give rule No.1 more weight, make it more likely to be cho­
sen. The computer will handle the random decision-making. 

Although the process uses randomness, the outcome is not ran­
dom at all. The pOints hop around too rapidly to fo llow. An image 
fo rms on the screen, first faint, then more and more distinct. It is 
a kind of strange attractor, like the horseshoe attractor of Henon. 
By changing the rules, and changing their weights, you can 
change the image. For any particular set of rules, though, the same 
image will always appear, like a ship arriving through the m ist. 

"Randomness is a red herring," Barnsley has said. "The object itself 
does not depend on the randomness. With probability one, you 
always draw the same picture. It's giving deep information, prob­
ing fractal ob jects with a random algorithm. Just as, when we go 
into a new room, our eyes dance around it in some order which we 
might as well take to be random, and we get a good idea of the 
room. The room is just what it is. The object exists regardless of 
what I happen to do." 

Things To Try 

• 
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Press CID until you see the picture of the Fern. Press 0iD to go into 
triangle editing mode. Press m several times so you can see 
images of all the available triangles. Now use the cursor to move 
the corners of one of the triangles, press m to activate another 
map for editing, and use the cursor to move the corners of the next 
triangle. After doing this for a while, press (]J repeatedly to see the 
image step back through all the changes you've just done. 

Next, press CD repeatedly to randomize the maps being used. 
Sooner or later you will get an image that looks good. Use triangle 
editing mode to make it even more attractive. Then save it as a 
parameter file. If you have a friend with CHAOS: The Software, you 
can share the image . 



Starting the Program 

Starting the Program 

Stamp outlines 

When you start The Chaos Game program, the following screen 
appears: 

The image area shows an image named Nautilus, generated with 
The Chaos Game. The upper-left side of the screen displays The 
Chaos Game menu buttons. At the lower-left side of the screen, 
you see four rectangular outlines called stamps. For information 
about stamps, see "Using Stamps" on page 128. 

Viewing Preset Images 
1\ 

Keyboard shortcut: CJD to view next; QElli) +CJD to view previous 

The Chaos Game program comes with 21 preset images created 
using the chaos game. The first image, Nautilus, appears on screen 
when you start the program. 

• Select the F3 Next button or press em to view the next pre­
set image. 

• Press ( Shift) + CJD to view the previous image. 
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Con tinue through all 21 images. After you view the last one, the 
program returns you to the fi rst image. 

Exploring the Program 

124 Chapter 5 
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Before you learn the details of The Chaos Game program, you can 
explore a few features by experimenting with preset images. Don 't 
wo rry if you don 't fu lly understand each feature you use in t his 
section. You'll learn about them in deta il later in the chapter. 

The changes you make here are temporary- at the end of this sec­
tion you return to the origi nal preset images. 

Follow these steps to t ry some color options: 

1. Display a preset image. 
2. Press m to change the way the image is colored. Continue 

to press m to cycle through the nine coloring types. 

Note: For more information about color options, see "Using the 
Opt ions Men u" on page 137. 

In The Chaos Game program, fractals are generated by a fl ock of 
point t hat move arou nd the screen under the influence of two or 
m ore rules (a lso called maps). A map defines a systematic way of 
moving from an initia l position to a new position. The movement 
of a map can consist of on or more of the followi ng: sh ri nking, 
stretching, rotating, fl ipping, or shearing. 

To display graph ical representations of each rule or "map" t hat 
creates a chaos game image, fo llow these steps: 

1. Press @ to display map icons. 
2. Notice the shape, angle, and location of each map, and the 

number of maps in the image. 

3. Press OD to see the map icons for the next image. 
4. Cycle through all the pre et images to get a feeling for how 

maps relate to the image. 
S. Press @ again to turn off map icons. 

Note: You learn more about maps in "Using the Tweak Screen" on 
page 129. For more information about map icons, see "Map Icons" 
on page 138. 
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Exploring the Program 

Each complete turn of the chaos game consists of each flock pOint 
randomly selecting a map, moving under the influence of the 
map, and making a mark at the new position it lands on. As this 
process is repeated over and over, a fractal image emerges. 

To watch the repeated transformation of maps produce a chaos 
game image, follow these steps: 

1. Select the F5 Opts button to display the Options menu. 
2. Select the Rectangle button next to the Flock Type option. 
3. Select the Off button next to the Trace option. 
4. Select the ACCEPT button to accept the changes and exit 

the Options menu. 
S. Press m to redraw the image and watch the repeated 

transformations of the maps produce the image. 
6. Press CR) to see the maps produce the next image. Contin­

ue to press CR) to view all the preset images. 

Follow these steps to reset the Trace and Flock options. 

1. Select the F5 Opts button again. 
2. Select the Dots button next to the Flock Type option. 
3. Select the On button next to the Trace option. 
4. Accept the changes to exit the Options menu. 

Note: For more information about the Flock option, see "Flock" on 
page 139. For more information about the Trace option, see 
"Trace" on page 139. 

Try changing the weight distribution in the image. The weight 
increases or decreases the probability that one map is used instead 
of other rules. 

1. Press O!D to display map icons. Notice the colored circle in 
the center of each map icon. 

2. Move the cursor to a circle at the center of one of the map 
icon outlines. (If you don't have a mouse, hold down the 
( Shift) key and press the arrow keys to move the cursor.) 

3. Left-click or press ( Shift) +CD to increase the weight of that 
map. Notice that an asterisk (*) appears in front of the im­
age name to indicate that you've changed the weight. 

4. Continue to increase the weight until you see a noticeable 
difference in the image. 

S. Increase the weight of another map in the image . 
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Moving Around in the Image Area 

6. Press m to undo all weight changes. A message box asks 
you to confirm that you want to undo all changes. 

7. Select the Yes button or press CD . The image now looks as 
it did before you made weight changes. 

8. Press (ill again to turn off map icons. 

Note: For more information about maps and weight, see "Using 
the Tweak Screen" on page 129 and "Weight Editing Mode" on 
page 139. 

You've completed a quick tour of a few of The Chaos Game fea­
tures. The fo llowing sections provide detailed descriptions of the 
program's menus and options. Once you understand how to use 
the program, you can make up your own rules fo r the chaos game. 

Moving Around in the Image Area 

• 
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You can use the mouse or the keyboard to move the cursor around 
in the image area. To move around using the keyboard, hold down 
the ( Shift) key and press any key on the numeric keypad. The keys 
move you in the direction indicated in this illustration: 

t 

Numeric keypad keys and direction of cursor movement 

-



Zooming, Panning, and Centering 

Zooming, Panning, and Centering 

Zooming In on an Image 

CHAOS lets you zoom in on any point in the image area. Zooming 
is a useful way to explore the self-similarity of chaos game images. 

To zoom in, follow these steps: 

1. Move the cursor to the location you want. The curso r loca-
t ion becomes the center of the magnified image. 

2. Press iliU . 
3. Press iliU again to zoom in fu rther. 
4 . Press ~+m to quickly restore the image to its original 

size and location. 

S. To zoom out, press @ill . 

Note: The program runs in a fa st integer mode. When you zoom in 
or out far enough, it switches to a slower real-number mode and you 
hear a low-pitched beep. When the program switches back to the 
faster mode, you hear a high-pitched beep. 

To zoom in on a specific area using a zoom'box, fo llow these steps: 

1. Press ~+m to change the cursor to the zoom box. 
2. Hold down the ( Shift) key and move the mouse to res ize 

the zoom box. 
You can also press ( Shift ) + ill or ( Shift) + CB to make the box 
larger, and press ( Shift) + mor ( Shift) + 8) to make the zoom 
box smaller. 

3. Move the zoom box to the location you want to zoom in 
on. 

4. Press iliU or left-click to zoom in on that area. 
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Using Stamps 

Panning an Image 

When you pan an image, you can see the parts of it that are outside 
the edges of the image area. Panning is especiaUy helpful when 
you've zoomed in and can see only a small part of the image on 
the screen. 

1. Move the cursor to the location you want to pan to. (The 
cursor location becomes the center of the panned image.) 

2. Press ~+CQ) to pan to the new location. 

Centering an Image 

As you zoom and pan images, you might feel unsure of where you 
are in the image. Centering an image moves it to the center of the 
image area and unzooms it. 

• Press~ +m· 

Using Stamps 

• 
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Keyboard shortcut: ~+CD to create a stamp; 
~+m, ~+m, ~+CD, ~+m to select a stamp 

As you experi ment with The Chaos Game, you can save a stamp­
sized version of up to four images. Then you can select a stamp and 
quickly redisplay the image in the large image area. 

To use stamps, fo llow these steps: 

1. Press ~+CD to create a stamp of the current image. 

2. Display another image and press ~+CD again to create 
a second stamp. 

3. Select a stamp icon to display that image in the large image 
area . 



Using the Tweak Screen 

Using the Tweak Screen 

Tweaking an existing image helps you understand the parameters 
that make up a Barnsley fractal image. To display the Tweak 
screen, select the F4 Tweak button . 

Note: The menu buttons are still vis ible on the left side of the 
screen. You can use any buttons from the Tweak screen. 

Exiting the Tweak Screen 

To exit the Tweak screen and return to the main screen, select the 
F4 Tweak button again. 

Understanding Maps 

" 

A chaos game image is produced by randomly applying a set of 
ru les over and over again. A rule (also known as a map) defines a 
transformat ion consisting of one or more of the following: shrink­
ing, stretching, rotating, flipping, or shearing. 
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Using the Tweak Screen 

In The Chaos Game program, a two-dimensional outline graphi­
cally represents each map. To see an example, look at the Sierpin­
ski triangle in the image area of the Tweak screen . 

1. Select the F4 Tweak button to display the Tweak screen. 
2. Press OD to fli p through the preset images until you reach 

the Sierpinski triangle image. 
3. Notice the outlined rectangle over the upper-left corner of 

the image. This rectangle represents Map 1 for this fractal. 

Each map transforms the entire image area. For example, Map 1 in 
the Sierpinski triangle reduces the entire image area to 1/2 its size 
(in both height and width) and moves it up and to the left. 

Each map is also defined by six numbers (displayed on the right 
side of the Tweak screen). These six numbers are used in an algo­
rithm that generates the transformation . 

Note: For more information about the mathematical meaning of 
maps and parameters, see liThe Ma thematics of the Program" on 
page 143. 

Tweaking Maps 

A good way to learn how the parameters affect maps and the 
resulting fractal image is to experiment with the parameters in an 
existing image. By adjusting one parameter at a time, you can see 
the corresponding transformation in the image. You can adjust 
the parameters in one or several maps and you can add and delete 
maps to see how that affects the image. 

Remember, any changes you make to the 21 images that come 
with the program are just temporary. And if you're working with a 
saved version of an image you created, you can always revert back 
to the saved version if you're not happy with your changes. 

Changing the Current Map 

730 Chapter 5 

Keyboard shortcut: IT] 

When you work on the Tweak screen, you can only change one 
map at a t ime- the current map. The Current Map button in the 
upper-right corner of the Tweak screen tells you which map is cur­
rent. The outline in the image area and the parameters along the 
right side of the screen represent the current map. 
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Using the Tweak Screen 

The bottom of the screen displays the parameters that define the 
other maps in the image . For example, if you're looking at the Sier­
pinski triangle, you see the parameter numbers for the three maps 
that generate this image. 

Note: If an image has more than six maps, the parameters of the 
first six maps appear at the bottom of the screen. To see the other 
maps, left-click the arrow buttons that appear above the fi rst and 
last map. If you don't have a mouse, move the cursor to the arrow 
buttons and press 8 . 

If you want to tweak one of the other maps in an image, you must 
first make that map current. To make the next map current 

• Select the plus button ( + ) next to the Current Map button. 

Th e outlined rectangle in the image area and the parameters on 
the right side of the screen now represent the new current map. 

To make the previous map current 

• Select the minus button ( - ) next to the Current Map but­
ton . 

Note: You can also make a map current by left-clicking in the area 
at the bottom of the screen that contains the numbers for that 
map. 

Changing the Display Mode 

You can tweak map parameters using one of three display modes: 
Matrices, Triangles, and Angles. The Matrices display mode gives 
you mathematical control over the changes to the fractal. The Tri­
angles mode lets you adjust the image quickly and get immediate 
visual feedback. The Angles display mode lets you ad just parame­
ters that have a clear geometric meaning. You'll learn more about 
these display modes in the next sections. 

The current display mode and the corresponding parameter labels 
appear on the right side of the screen. To change from one display 
mode to another 

• Select the Display mode button. 

Suggestion: After you become familiar with the three display 
modes, you can do an experiment. Use each of the three display 
modes to try to invert the Sierpinski triangle (that is, make the 
tr iangle point up) . When the triangle is inverted, the two maps 
originally at the top of the screen are at the bottom, and the map 
originally at the bottom of the screen is at the top. 
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Using the Tweak Screen 

Matrices Display Mode 

Matrices mode displays the IFS (Iterated Function System) param­
eters that define the current map. By changing these numbers 
(labeled A through F), you can change the current map and the 
enti re image. The A and D parameters tend to change the height 
and width of the map; the Band C parameters tend to squash or 
stretch .the map; and the E and F parameters change the location 
of the map. 

IFS parameters are commonly used to publish a description of a 
chaos game fractal and are a convenient way to exchange fractal 
images with your friends. If you know the IFS parameters for any 
fractal, you can use The Chaos Game program to quickly repro­
duce that fractal on screen. 

Note: For information on how to change parameters, see 
"Changing Parameters" on page 133. For information about the 
mathematical meaning of the parameters, see "The Mathematics 
of the Program" on page 143. 

Triangles Display Mode 

In Triangles display mode, you change maps by changing the X 
and Y coordinates of each corner in a triangle. You can change the 
angles of the triangle by changing the coordinate numbers (as 
described in "Changing Parameters" on page 133) or you can use 
the mouse or keyboard to move the corners of a triangle (as 
described in "Triangle Editing Mode" on page 140). 

Of the three display modes, Triangles is the only one that lets you 
change maps from both the Tweak screen and the main image 
screen. For information on working with triangles from the main 
screen, see "Triangle Editing Mode" on page 140. 

Angles Display Mode 
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In Angles display mode, each map is defined by six parameters that 
represent geometric changes to the map on both the x axis and y 
axis. These six parameters are described as follows: 

X-rotation The angle of the top and bottom sides of the 
map in relation to the horizontal axis. This pa­
rameter is specified in degrees (from -180 to 
180) . 

I 



V-rotation 

X-scale 

Y-scale 

X-trans 

V-trans 

Using the Tweak Screen 

The angle of the right and left sides of the map 
in re lation to the vertical axis. This parameter 
is specified in degrees (from -180 to 180). 

The change in size of the map in the horizontal 
direction . The acceptable range for this param­
eter is -100 to 100. 

The change in size of the map in the vertical di­
rection. The acceptable range for this parame­
ter is -100 to 100. 

The change in location of the map in the hor­
izontal direction. This parameter is identical to 
the E parameter in Matrices display mode. The 
acceptable range for this parameter is -100 to 
100. 

The change in location of the map in the verti­
cal direction. This parameter is identical to the 
F parameter in Matrices display mode. The ac­
ceptable range for this parameter is -100 to 
100. 

Changing Parameters 

You can change parameters in increments or you can directly enter 
a new parameter value. 

Changing Parameters in Increments 

You change parameters in the increment displayed in the Incre­
ment button. To use a different increment, see "Changing the 
Increment" on page 134. 

Note: In Angles display mode, the X-rotation and Y-rotation 
parameters change in an amount equal to ten times the increment. 
For example, if the increment is 0.1, the rotation parameters 
change by 1 degree. 

• Select the plus button ( + ) next to any parameter to in­
crease the parameter value. 

• Select the minus button ( - ) next to any parameter to de­
crease the parameter value. 
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Using the Tweak Screen 

Entering a New Value for a Parameter 

To type in a new value for a parameter 

• Enter the new value in the parameter number entry field 
and press 8 . 

Suggestion: To understan d how changing parameters affects the 
fractals, experiment with changing diffe rent parameters in the 
preset images. 

Changing the Increment 

Th Increment button controls how much of a change the plus (+) 
and minus ( - ) buttons make for the parameters (including 
weight) . You can set the increment to 1.000, 0.100, 0.010, or 
0.001, depending on the precision you want to use. 

• Select the plus button ( + ) next to the increment to in­
crease the increment. 

• Select the minus button ( - ) next to the incremen t to de­
crease the increment. 

• Left-click on the Increment number field to quickly cycle 
through the available increments using a mouse. 

Randomizing Map Parameters 

Keyboard shortcut: CD 

134 Chapter 5 

Another quick and often in teresting way you can change map 
parameters is by randomization. By assigning random parameters 
to the existing maps in an image, you completely transform the 
image. The results you get when you randomize are impossible to 
predict. Sometimes the image appears as randomly distributed 
dots, and sometimes interesting shapes appear. 

You can randomize an image from the Tweak screen or from the 
large image screen. 

To randomize the maps in an image, follow these steps: 

1. Press CD. 
2. Continue to randomize the maps by pressing CD again 

and again . 

Suggestion: If you discover a random image that you like, be sure 
to save the parameters. That way, you can load the image again or 
share it wi th friends. For information on saving parameter files, see 

• "Saving Parameters" on page 211. 
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Using the Tweak Screen 

After you've randomized a preset image, you can easily resto re the 
origina l image by following these steps: 

1. Press CID to display the next image. 
2. Press ( Shift) +CID to r turn to the original preset image. 

Changing the Weight or Probability 

Each map in a chaos game image is ass igned a weight. The weight 
represents the probability that a map will be used (relative to the 
use of the other maps). When you add weight to one map, you 
red uce the weight of the other maps: the total weight of all maps 
must add up to 1. Changing the weight of the maps can have a dra­
matic effect on the resulting image. 

To increase the weight of a map 

• Select the plus button ( + ) next to the Weight parameter. 

To decrease the weight of a map 

• Select the minus button ( - ) next to the Weight parameter. 

Note: For information about changi ng weight from the main 
screen, see "Weight Editing Mode" on page 139. For information 
about the most precise way to change the weight for one or more 
maps, see the next section . 

Using the Weight Editor 

Keyboard shortcut: CD 

The Weight Editor gives you the most precise way to change the 
weight of one or more maps in an image. You can display the 
weight editor from any screen or editing mode in The Chaos 
Game. 

• Press CD. The Weight Editor dialogue box appears: 

1: 

3: 

5: 

It 750 

0.000 

Weight Editor 

2: 

4: 

6: 

0.000 

0.000 

I • 

ACCEPT ~ 
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Using the Tweak Screen 

The Weight Editor shows the current weight of each map in the 
image. You can change the weight of any map by entering a new 
weight value for that map. 

• Enter the new weight in one of the weight entry fields and 
press 8 . 

The weights of all maps in a chaos game image must equal!. If you 
change the weight of one map, the program will adjust the weights 
of all maps so they add up to 1. You can use the Norma lize button 
to see the ad justed weight values before you exit the Weight Edi­
tor. 

The Equalize button lets you quickly assign equal weight to all 
maps in the image. 

Adding Maps 

Keyboard shortcut: 0 

You can Change the fracta l by adding a new map. The Chaos Game 
allows up to 20 maps in an image. 

• Select the Add Map button to add a map. 

The new map is a small rectangle in the center of the image. The 
new map is the current map and you can tweak it as you would any 
other map. 

When you add a new map, the weights of all maps in the image 
are equalized. For more information about equalizing weights, see 
"Using the Weight Editor" on page 135. 

Note: If you add several maps in quick succession, the new maps 
will initially be on top of each other. 

Deleting Maps 
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You can change the fractal by deleting an exist ing map. Each 
image must have a minimum of two maps, so you can't delete a 
map when there are only two maps. 

To delete the current map, follow these steps: 

1. Select the Delete Map button. A message box asks you to 
confirm that you want to delete the map. 

2. Select the Yes button or press CD to confirm the delete . 

-
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Using the Options Menu 

Using the Options Menu 

You can use the Options menu from the main screen in The Chaos 
Game or from the Tweak screen. To display the Options menu, 
select the F5 Opts button or press @ . 

Palette: 

loring: 

Flock Type: 

F1 for HElP ESC to Cancel ACCEPT 

Color Options 

Coloring 

The following color options are common to five of the six CHAOS 
programs and are described in "Using Color Options" on page 214. 

• Color Cycle Once 

• Auto Cycle 
• Palette (Default, Random, Preset, Edit) 

• Monochrome 

Keyboard shortcut: Q) cycle forward; (Shift) + Q) cycle backward 

The Chaos Game program lets you choose from various ways of 
coloring the fractals. Different coloring types look best with differ­
ent images. You can cycle through the coloring types to find the 
one you like best for an image. 
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Using the Options Menu 

Map Icons 

" 

138 Chapter 5 

To change from one coloring option to the next, select one of the 
fo llowing coloring type buttons on the Options menu. 

• Mono 

• One Map 

• Pileup 

• Two Map 

• Average 

• Sum 

• Overlay 

• Th ree Sum 

• Product 

Note: For technical details on these coloring options, see liThe 
Mathematics of the Program" on page 143. 

Keyboard shortcut: (ill 

In The Chaos Game, you can turn map icons on and off. Map icons 
are shown as parallelograms with a IIface" that shows you the 
di rectional orientation of the map. The face has a IImouth" and an 
"eye" located in one corner of the map. The following illustration 
shows a map facing righ t and a map facing left . 

• • 

facing right facing left 

The outline of a map indicates its relative weight. The more solid 
the line, the greater the weight of that map. Each map also has a 
small octagon at its center. If a map has zero weight, it appears as 
a hollow octagon: the border of the parallelogram is invisible. 

• Select the On or Off button next to Maps on the Options 
menu to toggle map icons on and off. 



Flock 

Trace 

Weight Editing Mode 

Keyboard shortcut: m 
Images in The Chaos Game program are generated by a flock of 
points that appear in loca tions determined by the maps. The pro­
gram gives you the following three flock options: 

• Dots-paints the image with flocks made up of sixteen 
equally spaced points. The defau lt flock type is Dots. 

• Rectangle-paints the image with flocks made up of the 
rectangular outlines of the maps. 

• Logo-paints the image with flocks that look like the 
Autodesk logo. 

To switch between the three available flock options 

• Select the Dots, Rectangle, or Logo button next to the Flock 
option on the Options menu. 

To redraw the image using the current flock 

• Press (D. 

Note: For more information on flo ks, see liThe Mathematics of 
the Program" on page 143. 

Keyboard shortcut: OJ 

If trace is on (the defaul t setting), each flock point leaves a perma­
nent mark. If trace is off, then only the current position of each 
flock pOint is shown. 

• Select the On or Off button next to Trace on the Options 
menu to toggle trace on and off. 

Weight Editing Mode 

Keyboard shortcut: (Shift l+QJ to increase; QJ to decrease 

When you start The Chaos Game progra m, you're in weight edi ting 
mode and the cursor is an arrow. Weight editing mode lets you eas­
ily change the weight of the maps in the fractal. As you add or 
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remove weight from one map, the weight of the other maps is 
adjusted. 

• To increase the weight of the map whose center is nearest 
the cursor, left-click. 

• To decrease the weight of the map whose center is nearest 
the cursor, right-click. 

• To remove all weight from the map whose center is nearest 
the cursor, press m. 

You can use weight editing mode at t he main screen (with the 
large image area) or from the Tweak screen. 

When you' re in weight editing mode, you can also use any other 
keyboard shortcut to change the frac tal. For example, you can 
change the coloring, display the map icons, or add a new map. 

Note: For other ways of changing weight in The Chaos Game, see 
"Changing the Weight or Probability" on page 135 and "Using the 
Weight Editor" on page 135. 

Triangle Editing Mode 

In triangle editing mode, each map is represented by a triangle that 
is one half of the parallelogram that describes the map. You can 
quickly change a fractal by changing the shape of a t riangle. You 
can use triangle editing mode from the main screen (with the large 
image area) or from the Tweak screen. 

At the main screen, you have the option of adjusting the corners 
of the triangles using the mouse or keyboard. From the Tweak 
screen, you have the additional option of entering new X and Y 
coordinate values. For more information about entering new coor­
dinate values at the Tweak screen, see "Changing Parameters" on 
page 133. 

Starting Triangle Editing Mode 
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To toggle between weight and triangle editing mode from the 
main screen 

• Press ® . 



Triangle Editing Mode 

To use triangle editing mode from the Tweak screen 

• Select the Display Mode button until Triangles appears. 

When you are in triangle editing mode, the current map is repre­
sented by a triangle with numbered corners and the cursor is a 
small triangle. 

Editing Triangles 

• 

You can change the shape of the current map by moving one or 
more corners of the triangle with the mouse or keyboard . 

To change the current triangle using a mouse, follow these steps: 

1. Left-click to move the closest corner to the location of the 
cursor. 

2. Continue to move the corner with a series of small moves. 
(Because the closest corner moves to the cursor location, a 
series of small moves helps prevent you from moving the 
wrong corner.) 

Note: You can also hold down the left mouse button and drag the 
corner to a new location . 
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To change the current triangle using the keyboard, f 1I0w these 
steps: 

1. Hold down the ( Shift) key and use the arrow keys to move 
the cu rsor to the new location fo r the corner. (If the new 
location is close to another corner, you'll have to make the 
move in small increments.) 

2. Press m on the numeric keypad to move the corner to the 
cursor location. 

If you're using triangle editing mode from the Tweak screen, the 
progra m updatesthe corner parameters on the right side of the 
screen and the IFS parameters displayed at the bottom of the 
screen. 

Suggestion: You can often get inter sting results by pulling a 
corner through the opposite side of the triangle, effect ively 
"flipping" the triangle. 

As you edit triangles, it's hel pfu l to turn on the disp lay of map 
icons: 

• Press (0. 

You can also quickly make the next map current: 

• Right-click or press CIJ. 

And you can easily undo changes you make in triangles editing 
mode: 

• Press @). (You can continue to press @) to undo your 
most recent changes one at a time, up to a maximum of 
100 changes.) 

To undo aU changes, follow these steps: 

1. Press (Y) . A message box appears asking if you want to 
undo all changes. 

2. Select the Yes button or press CD to confi rm that you want 
to undo all changes. 

Saving and Loading Files 
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You can use the options on the File menu to save and load param­
eter files and .gi(files. For more information, see "Saving and Load­
ing Files" on page 209 . 
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The Mathematics of the Program 

In The Chaos Game, we see fractals that are generated by having a 
flock of points hop around on the screen under the influence of 
two or more maps. Why such a simple technique can produce such 
intricate fractals is initially a bit of a mystery- but as you play with 
the program, you should eventually begin to understand. 

The weighted set of maps being used is known as the iterated func­
tion system, or IFS for short. Each complete tum of the chaos game 
consists of having each flock paint randomly select one of the cur­
rent IFS maps, move under the infl uence of this map, and make a 
mark at the new position it lands on. If trace is on (as it usually is), 
each flock paint leaves a permanent mark each t ime it touches 
down. If trace has been toggled off with the GJ key, then only 
the current position of each flock point is shown. 

There are three kinds of flocks you can use: Dots, Rectangle, or 
Logo. The Dots flock starts out as sixteen points, equally spaced 
across the image area screen in a four by four grid . The rectangle 
flock starts out as a frame rectangle of about 2,000 dots placed one 
per pixel around the perimeter of the image area. The logo flock 
starts as a block of about 2,500 dots grouped together to make an 
Au todesk logo in the upper··right region of the image area. It is 
interesting to experiment on a simple IFS, such as the Fern, tryi ng 
different combinations of trace and flock. Pressing CD clears the 
screen and refills a flock from scratch. 

There are an endless number of iterated funct ion systems, or 
weighted sets of maps, which you can use. An individual map 
defines a systematic way of moving from any initial plane position 
(x,y) to a new plane position (newx,newy). The maps we use in this 
program are all bilinear or affine maps, meaning that each of them 
can be defined using two linear equations in x and y. The equa­
tions defining a single map have the form: 

newx = a * x + b ", Y + e; 

newy = c '" x + d '. Y + f; 

The effect of such a map is always to move the corners of any rect­
angle in the plane into the corners of a parallelogram somewhere 
else in the plane. Moreover, these maps act in an orderly fashion 
on the paints on a rectangle's edge. That is, if an edge point is half­
way between two corners, its image under the map will be halfway 
between the images of the corners. Such affine maps, defined in 
terms of two linear equations, cannot warp a rectangle into an 
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irregular trapezoid, nor can they bend a straight side into a curved 
arc. The complete inventory of what an affine map can do to a 
rectangle is to shrink or stretch it either vertically or horizontally, 
to rotate its horizontal or vertical edges, or bodily to move the 
whole rectangle from here to there. If an affine map happens to 
rotate one of the edges right through one of the other edges, it will 
also have the effect of performing a mirror flip on the rectangle. 

Sometimes an affine map's two linear equations are wri tten as a 
single matrix equation: 

If you look at the Tweak menu, you will see the parameters a, b, c, 
d, e, and f for each map listed at the bottom of the screen . If the 
Tweak menu Display Mode is set to Matrices, then you can di rectly 
change the values of the matrix parameters a, b, c, d, e, and f. 
Changing e and f simply moves the image rectangle about, but the 
effects of a, b, c, and d are harder to disentangle. 

Another way of characterizing an affine map is to find param ters 
X-scale, V-scale, X-rotation, and V-rotation such that 

la bl = [(X-SCa le) cos (x - rotation) 

Lc c{] (x-sea /e) sin (x - rotation) 

Y-rotation 

X-rotation 

- (y-sca/e) sin (y-ro tation)l 

(y -sca /e) cos (y-ro ta t io n) J 

X-scale is the factor by which the rectangle is stretched or shrunk 
along the horizontal axis, and V-scale is the factor by which the 
rectangle is stretched or shrunk along the vertical axis. A scale fac­
tor of O.S means, for instance, that a distance is made half as big; 
a scale facto r of 3.0 would mean that a distance is to be made t hree 
times as large. X-rotat ion is the number of degrees through which 
the rectangle'S horizontal lines are rotated, and V-rotation is the 
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number of degrees through which the rectangle's vertical lines are 
rotated. Positive rotation is counterclockwise and negative rota­
tion is clockwise, and X and Y rotation are measured, respectively, 
from the horizontal and the vertical positions. In this context, the 
amounts e and f by which the whole rectangle is moved (or trans­
lated) can be renamed X-trans and V-trans. 

If one knows where an affine map moves one specific rectangle, 
then one can actually compute the values of a, b, c, d, e, and f, and 
then one will know where the map moves all rectangles, and all 
pOints, of the plane. This is the basis of the pictures of the maps 
that appear as white rectangles on the Tweak menu, and is also the 
basis of the faint colored pictures of the maps which you can tog­
gle on by pressing the CID key. In each case, the map pictures are 
images of the frame rectangle that makes up the perimeter of the 
starting image. 

Just by looking at a parallelogram, it is sometimes hard to tell what 
combination of rotations and mirrorflips the depicted map is sup­
posed to perform. So that the eye can easily pick this out, our col­
ored map images act as if the original frame rectangle has an eye at 
its northeast corner, and a mouth on its east side. This image is 
modelled on the famous A Square, hero of Edwin Abbott's classic 
book Flatland. 

Yet another way of specifying a map can be arrived at by noting 
that if we know the image position of three of a parallelogram's 
corners, then we can compute the location of its fourth corner. So 
if we specify where three of some specific rectangle's corners are to 
be moved by an affine map, then we have also effectively specified 
where the fourth corner must go, and since we then know where 
one rectangle is taken, we know where all rectangles and all pOints 
are taken. 

In the Tweak menu, if the Display Mode is set to Triangles, then 
you can describe a map by specifying the X and Y coordinates of 
the images of the starting rectangle's three corners: Corner I, Cor­
ner 2, and Corner 3. 

3 

2 
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In the Tweak menu or on the main screen, you can toggle on a 
graphic map-editing mode by pressing the GYJ key. In this case the 
map being edited is shown as a white t riangle. You can alter the 
map simply by dragging the corners of the triangle around. Pleas­
ing effects can often be achieved by dragging one of a triangle's 
corners through one of the Sides, thus incorporating a mirror flip 
into the affi ne map being edited. 

In selecting which map to obey, a flock point uses a weighted ran­
dom izer rather than a pure randomizer. That is, if there are N 
maps, t he different maps need not necessarily all have the same 
likelihood of liN of being picked. The weight of each map is 
expressed as a probability between 0 and 1. The map weights can 
be ad justed numerically on the Tweak menu, or they can be graph­
ica lly changed using the cursor. As all the separate weights must 
jointly sum up to I, changing one map's weight must inevitably 
affect the weights of some of the other maps. 

The basic principle in weighting the maps is that, if one wants an 
evenly lit fractal image, then each map's weight should be propor­
tional to the area of its colored map image. That is, a map wh ich 
only shrinks the frame rectangle a little should have a high weight, 
and a map which shrinks the frame rectangle a lot should have a 
low weight. The colored map images make the weights visible by 
having the brightness of the map's edges be proportional to the 
map's weight. If a map has no weight at all, we indicate its location 
by showing a small hollowed-out octagon. 

Sometimes, as in our Cloud or Mud IFS images, one does not want 
the fractal to be evenly lit . In the case of the Cloud, for instance, 
the weights are tweaked so as to make the points land on the bot­
tom half of the cloud more often than on the top, with the goal of 
making it look as if the sun is setting somewhere below the edge 
of the screen. 

A different use of weight changes is to bring various maps in and 
out of play in a continuous way. In our Nautilus IFS, for instance, 
there are six maps in the IFS, and moving the weights around 
causes dramatic changes in the image. You can always add more 
maps to an IFS by pressing the m key. Eventually you might 
enjoy setting up an IFS with sixteen differently tweaked maps, 
some of them even off screen, and using this to explore the effects 
of weight changes. Remember that you can use the File menu to 
save any of your IFS settings. 

Our program gains speed by using integer arithmetic (instead of 
real number arithmetic) as much as possible. If you zoom in or out 
far enough, the program makes a down-sliding sound to signal 
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that it has switched to the slower real-number mode. When you 
zoom back into the range where integer accuracy suffices, the pro­
gram makes an up-sliding noise. If you zoom in very far, you will 
notice that it takes a long time for the image to become distinct. 
This is because the Chaos Game computation is essentially holistic 
in the sense that no piece of these fractals can be computed with­
out computing the whole thing. 

Now we'll explain the methods by which colors are assigned to the 
positions where the flock pOints land. When a pOint moves, it uses 
a randomizer to pick a MapNumber, giving the number of the 
Barnsley map to be moved by. This map gives the point a new 
screen position to land on. Before it lands, the pOint can look at 
the color presently on the screen, which we call ScreenColor. In 
addition, each flock point has a small memory area in which it can 
keep a record of its last few MapNumbers. So the point has three 
pieces of information: its MapNumber, the Screen Color, and its 
memory of its past MapNumbers. Based on these three numbers it 
computes a NewColor. 

Keep in mind that our programs use only sixteen colors, so any­
time a computed NewColor is greater than 16, we replace New­
Color by the NewColor MOD 16, which is the remainder you get 
when you divide NewColor by 16. The coloring styles work as fol­
lows. 

1) MONO: NewColor is always the maximum palette color, which 
is usually white. 

2) ONE MAP: NewColor is the same as the MapNumber, the num­
ber of the map which just moved the point. This coloring style 
makes it clear what the different maps do. 

3) PILEUP: NewColor is the present Screen Color of the target pixel 
plus one. The more points that land on a pixel, the higher its color 
number becomes-until the numbers get larger than 16 and wrap 
around. This coloring style gives you an idea of the frequency with 
which pOints are hitting certain parts of the image. 

4) TWO MAP: NewColor is based on the sum of the point's Map­
Number and its old MapNumber. The effects of the last two maps 
are thus seen in the coloring. 

S) AVERAGE: NewColor keeps a running average of the MapNum­
bers which the pOint has used. 

6) SUM: NewColor is a running sum of the point's successive val­
ues of (MapNumber MOD 4). 
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7) OVERLAY: NewColor is gotten by XORing together the Map­
Number and the last two values of the point's MapNumbers. To 
uXOR" two numbers means to compare their binary bits and put 
zeroes in the places where the bits are the same, and ones where 
the bits are different. XORing numbers is a good way of preserving 
as much of their information as possible. 

8) THREE SUM: NewColor is the sum of the last thre MapNum­
bers. 

9) PRODUCT: NewColor is the product of the last three MapNum­
bers. 

Many other coloring styles can be imagined. The ones we used 
here were arrived at partly by tria l and error. Some of the effects 
they produce are rather surprising. Certain styles look better with 
certain setups. When you have a new image, it's a good idea to 
press the Q) key many times to see how the image looks with the 
va rious color styles. Note that the effects of some of the coloring 
styles change if you press a!D+CD to extend the color palette . 



Chapter 6 

Fractal Forgeries 

Clouds are not spheres, Mandelbrot is fond of saying. Moun­
tains are not cones. Lightning does not travel in a straight line. 
The new geometry mirrors a universe that is rough, not rounded, 
scabrous, not smooth. It is a geometry of the pitted, pocked, and 
broken up, the twisted, tangled, and intertwined. The under­
standing of nature's complexity awaited a suspicion that the 
complexity was not just random, not just accident . .. Mandel­
brot's work made a claim about the world, and the claim was 
that such odd shapes carry meaning. The pits and tangles are 
more than blemishes distorting the classic shapes of Euclidean 
geometry. They are often the keys to the essence of a thing. 

What is the essence of a coastline, for example? Mandelbrot 
asked this question in a paper that became a turning point for 
his thinking: "How Long is the Coast of Britain?" 

Mandelbrot had come across the coastline question in an 
obscure posthumous a/ticle by an English scientist, Lewis F. 
Richardson, who groped with a surprising number of the issues 
that/ater became part of chaos . .. Wondering about coastlines 
and wiggly national borders, Richardson checked encyclopedias 
in Spain and Portugal, Belgium and the Netherlands and dis­
covered discrepancies of twenty percent in the estimated lengths 
of their common frontiers. 

Mandelbrot's analysis of this question stnlck listeners as either 
painfully obvious or absurdly false . .. 

In fact, he argued, any coastline is-in a sense-infinitely long. 
In another sense the answer depends on the length of your mler. 
Consider one plausible method of measuring. A surveyor takes 
a set of dividers, opens them to a length of one yard, and walks 
them aLong the coastline. The resulting number of yards is just 
an approximation of the tme Length, because the dividers skip 
over twists and turns smaller than one yard, but the surveyor 
writes the number down anyway. Then he sets the dividers to a 
smaller length- say, one foot- and repeats the process. He 
arrives at a somewhat greater length, because the dividers will 
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capture more of the detail alld it will take more than three olle­
foot steps to cover the distance previously covered by a one-yard 
step. He writes this new number down, sets the dividers at fOllr 
inches, and starts again. Th is mental experiment, using imagi­
nary dividers, is a way of quantifying the effect of observing an 
object from different distance , at different scales . .. 

. . . Mandelbrot found that as the scale of measurement becomes 
smaller, the measured length of a coastline rises without limit, 
bays and peninsulas revealillg ever-smaller subbays and sub­
peninsulas- at least down to atornic scales, where the process 
does finally come to an end. Perhaps. (Chaos: Making a New 
Science, pages 94-96.) 

An infinitely long line crowded into a finite space is more than a 
line, yet less than a plane. Mandelbrot expresses this by saying that 
such a line has a fractional dimension which lies between one and 
two. Similarly a mountain range covered with peaks covered with 
jagged rocks is more than a plane, and is accordingly said to have 
a fractional or fractal dimension between two and three. 

By mimicking the shrinking-dividers experiment on maps and 
photographs, scientists have actually arrived at rough estimates of 
the fractal dimensions of such th ings as seacoasts, river networks, 
tree bark, and galaxies. These measurements do not provide an 
explanation for these structures; they are simply a new way of clas­
sifying them. The explanations lie hidden in the chaotic dynamics 
of the motions that create natura l forms . 

Computer graphics artists are perfectly willing, however, to short 
circuit the process of explanation. If, for instance, the Rocky 
Mountains resemble a fractal of dimension 2.61, then why not just 
build such a fractal next time you need a mountain range? 

The process of building a fractal of a desired dimension involves 
synthesizing an image by adding increasing amounts of detail­
the fractal aspect is that at each level one adds more detail than 
might strictly be expected. Line segments get kinks in them, trian­
gular faces acquire humps, and so on. The first programs did this 
in an iterative, face-by-face way; our Fractal Forgeries program uses 
a more sophisticated technique that adds new levels of detail to all 
parts of the image at once . 



Things To Try 

The computer artist Loren Carpenter generated the fractal alien 
landscapes that Lucasfilm supplied for the movie Star Trek ll. 
Describing his experience in The College Mathematics JOllmal, 
Carpenter writes: 

({One ofthe major problems with fractals in synthetic imagery 
is the control problem. They tend to get alit of hand. They will 
go random all over the place on YOll. If you want to keep a good 
tight fist on it and make it look like what YOll want it to look 
like, it reqllires quite a bit of tinkering and experience to get it 
right. There are not many people around who know how to do 
it. ({ 

Using our Fractal Forgeries program, you can have the fun of learn­
ing how to interactively adjust the fractal dimension to produce 
landscapes, clouds, or planets that look the way you want. 

Things To Try 

Take a single setting of the parameters and draw it as Mountain, 
Cloud, Planet, and Contour in the four image boxes. Take one type 
of fracta l, say Mountain, twiddle the parameters till it looks 
decent, and then see how it looks over the different range of fractal 
dimension settings. In the process of adjusting parameters, don't 
neglect to use the Randomize button to see different realizations 
of the same parameter settings. Once you find a parameter setting 
which gives interesting changes, make a ten-frame animation of it, 
so you can see dynamically the effects of changing the fractal 
dimension. 
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Starting the Program 

When you start the Fractal Forgeries program, you see the fo llow­
ing screen: 

Forgery parameters One-dimensional representation 

The upper-left side of the screen di splays the menu buttons. To the 
right of the menu buttons are forgery parameters (three slider bar 
options and four sets of buttons). In the upper-right corner of the 
screen, you see a contour line tha t is a one-dimensional represen­
tation of the current parameters. At th lowe r-right side of the 
screen, you see four sample forgery images generated from a single 
set of para meters. 

Exploring the Program 
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Before you learn all the details of Fractal Forgeries, you can quickly 
explore a few features and generate completely new pictures. 
Don't worry if you don't fully understand each feature you use. 
You'll I am about each param ter and option in detail later in th is 
chapter. 



.. 

Exploring the Program 

The opening screen displays several parameters that you can adjust 
to create unique forgeries. You'll learn about these parameters in 
the next section "Changing Forgery Parameters" on page 155. For 
now, you'll use the Randomize option to create a completely new 
image. 

To randomly create a new mountain landscape, follow these steps: 

1. Select the Randomize button. The program changes the 
number to the right of this button. The contour line at the 
top of the screen also reflects the change. 

2. Select the F6 Mountain button. The program generates the 
image and displays it in the currently selected (upper-left) 
image area. 

Note: You can repeat steps 1 and 2 as often as you like. 

The Fractal Forgeries program generates up to four different types 
of images from a single set of parameters. Without changing any­
thing, you can create planets, mountains, cloud formations, and 
contours. 

To create a planet without changing parameters, follow these 
steps: 

1. Select the upper-right image area by left-clicking in that 
image box or pressing CD. 

2. Select the F4 Planet button. The program generates the im-
age and displays it in the upper-right image area. 

Note: You can also generate cloud and contour imag s from these 
parameters by selecting the F5 Clouds and F7 Contou r buttons. For 
more information, see "Displaying Forgeries" on page 159. 

In addition to the parameters on the opening screen, you can use 
options to change specific image types. 

To use options to change the planet image, follow these steps: 

1. Select the F3 Options button. The Options menu appears. 
2. Select the Planet Options button. The Planet Options menu 

appears. 
3. Enter 3 in the Hour field to create a planet with a rotation 

shadow set to three o'clock. 
4. Select the ACCEPT button to confirm your change and exit 

the menu. 
5. Select the lower-left image area by left-clicking in that im­

age box or pressing CD . 
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6. Select the F4 Planet button. The program generates the 
planet image with a rotation shadow and displays it in the 
lower-left image area. 

Note: For information on all of the options available in the 
program, see "Using the Options Menu" on page 160. 

Once you generate an interesting image, you can display a full­
screen rendering of the image. If you have a VGA monitor, you can 
display the rendering in 256 colors. (The images on the main 
screen are limited to 16 colors.) 

To render an image, follow these steps: 

1. Select the image you want to render by left-clicking in the 
image area or pressing CD, W, W, or m to move to the 
correct image area. 

2. Select the F8 Render button. The Render an Image menu 
appears. 

3. Select the button labeled with the type of image you want 
to render. For example, if you're rendering a planet, select 
the Planet button. 

4. If you have a VGA monitor, select the 256 colors button to 
render in the highest available resolution . 

5. Select the Render to Screen button. 

6. Select the REND ER button. The program displays a fu ll ­
screen rendering of the image you selected. 

7. Click either mouse button or press any key to return to the 
main program screen. 

Note: For more information on rendering an image, see 
"Rendering an Image" on page 166. 

You can also create and play back animations of the forgeries you 
generate in Fractal Forgeries. Before you create an animation, you 
should become familiar with the available parameters and options. 
For more information, see "Animating an Image" on page 168. 
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Changing Forgery Parameters 

The Fractal Forgeries program generates pictures of planets, clouds, 
mountains, and contours from one set of calculated data or param­
eters. But each type of image looks best with a different combina­
tion of parameter settings. And although each parameter has a dif­
ferent effect on the images, the parameters interact in subtle ways. 
By experimenting with many different settings, you'll develop an 
intuitive understanding of the relationship between these param­
eters and the images they create. 

Note: For information on the mathematical meaning of the 
forgery parameters, see "The Mathematics of the Program" on page 
171. 

One-Dimensional Representation of Parameters 

The contour line in the upper-right corner of the screen is a one­
dimensional representation of the current parameter settings. As 
you change the forgery parameters, the line changes to show the 
relative irregularity or smoothness of the resulting image. This line 
is not an outline of the resulting image, but it gives you a general 
impression of the quality of the resulting landscape. 

Changing the Fractal Dimension 

• 

The fractal dimension determines the degree of roughness of the 
terrain or corresponding aspects of other images. A higher fractal 
dimension produces a more irregular or bumpy surface. 

Fractal dimensions are not limited to integers as they are in Euclid­
ean geometry. In Fractal Forgeries, you can set a fractal dimension 
anywhere between 2.0 and 3.0. For example, you can use a fractal 
dimension of 2.5 to create an image that uses more than 2-dimen­
sional space but less than 3-dimensional space. 

To change the fractal dimension using a mouse 

• Hold down the left mouse button and drag the box in the 
slider to the position you want. 
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To change the fractal dimension using the keyboard, follow these 
steps: 

1. Press CI) to move the cursor to the Fractal Dimension slid­
er bar. 

2. Press CB or B to move the slider. Press ( Shift) + CB or 
( Shift ) + B to move the slider in larger increments. 

Note: You can also select the plus or minus buttons below the 
slider bar to change the fracta l dimension. The greater the number 
of plus or minus symbols on the button, the larger the increment. 

Changing the Height 

You can change the height of a forged planet or mounta in land­
scape from 0 (water level) to 2.00 (very high elevations). Low 
numbers generate swamp and lake terrain; high numbers generate 
mountain ranges. With the height set to zero, the image is all 
water. At a height of 2.00, the landscape is mountains with very 
tall peaks. Changes in Height affect only Planets and Mountains­
not Clouds and Contours. 

Note: To change the height using the keyboard, press OD to move 
the cursor to the Height slider bar. Use the slider bar as described 
in the previous section "Changing the Fractal Dimension" on page 
ISS. 

Changing the Power Factor 

• 
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The power factor scales height variations. The power factor has the 
most dramatic effect on mountain images. In mountain forgeries, 
power factors greater than 1.0 re-create the effects of erosion by 
flattening the lower elevations while leaving steep spires. Power 
factors less than 1.0 have the opposite effect-they flatten the 
peaks and increase steepness at water level. A power factor of zero 
creates a plateau effect. You can set a power factor from zero to 2.0. 

Clouds tend to look better when the Power Factor is set to a low 
number. 

Note: To change the power factor using the keyboard, press m to 
move the cursor to the Power Factor slider bar. Use the slider bar 
as described in "Changing the Fractal Dimension" on page ISS . 



Changing Forgery Parameters 

Changing the Mesh Size 

Keyboard shortcut: ( Shift) + ill) to increase; ill) to decrease 

The program generates images by preparing a matrix of random 
data. You can change the size of t his matrix by changing the mesh 
size. Increasing the mesh size means you calculate t he image at 
more points, which produces a more realistic picture. Using a h igh 
mesh size increases the calculation time. 

To change the mesh size 

• Select the button for the mesh size you want to use. 

Suggestion: If you're randomly creating images, you might want to 
use a low mesh number to save time. Then, when you find an 
image you like, increase the mesh size. 

Changing the Terms 

Keyboard shortcut: (Shift) +CD to increase; CD to decrease 

The Terms parameter controls how many Fourier sum terms are 
used in the algorithm that generates the forgery . (For information 
about the Fourier sum and the mathematics used in the Fractal 
Forgeries program, see liThe Mathematics of the Program" on page 
171.) Reducing the number of terms makes the surface smoother. 

To Change the terms 

• Select the button for the number of terms you want to use. 

Setting Animation Parameters 

Keyboard shortcut: CD to set start parameters; 
OJ to set end parameters 

If you have a VGA monitor, you can create an animation of a forg­
ery. The animation shows a forgery transforming from an image 
based on one set of parameters to an image based on another set 
of parameters. For example, you can create an animation of a 
mountain forgery that starts with a height of zero (a ll water) and 
ends with a height of 2.00 (tall peaks). When you play back the 
animation, you'll see tall peaks rise out of the water. 

You can set starting and ending animation parameters from the 
main screen or from the Animation dialogue box. 
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Suggestion: You migh t want to read "Animating an Image" on 
page 168 before setting starting and ending parameters fo r the first 
time. 

To set starting animation param ters from the main screen, follow 
these steps: 

1. Set the parameters for the first image in the an imation. 
2. Select the Animation Sta rt button at the bottom of the 

screen or press CD . The selected parameters are now saved 
as the starting parameters for the animation. 

To set ending animation parameters from the main screen, fo llow 
these steps: 

1. Set the parameters for the fina l image in the animation. 

2. Select the Animation End button at the bottom of the 
screen or press IT). The selected parameters are now saved 
as the ending parameters for the animation . 

Note: When you're ready to create the animation, see" Animating 
an Image" on page 168. 

Randomizing the Forgery 

• 
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Keyboard shortcut: CD 

The Randomize option lets you change the seed or start value used 
by the pseudo-random number generator that creates data for the 
image. Each seed value creates a completely different forgery. You 
can re-create a forgery by using the same seed and parameters. 

You can select the Randomize button to let the program choose a 
random seed, or you can enter a specific seed value. 

To use a random seed value 

• Select the Randomize button. 

To enter a specific seed value 

• Enter a number from 0 to 32767 in the entry field next to 
the Randomize button and press B . 
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Displaying Forgeries 

Displaying Forgeries 

After you change the forgery parameters, you can quickly display 
low-resolution versions of up to four images. To display a forgery 
using the current parameter settings, you select an image area, and 
then select the menu button fo r the type of forgery you want to 
generate. 

Selecting the Image Area 

Keyboard shortcut: CD, CD, cn or m 
The currently selected image area is shown by the highlighted bor­
der around the area. When you create a new forgery, the image is 
displayed in the selected image area. If an image is already in the 
selected box, the new image replaces it. 

To select the image area where the next forgery will appear 

• Left-click in the image box or press CD, w, en or m to 
select one of the fo ur image areas. The highlighted border 
moves to the image area you selected. 

Selecting the Forgery Type 

You can generate planets, clouds, mountains, and contours from a 
single set of parameters. Planet forgeries generate a single planet 
set against a dark background with stars. Cloud forgeries generate 
white clouds against a bright blue sky. Mountain forgeries generate 
a section of a mountain range. Contours are a color representation 
of the data, rather than forgeries of natural phenomena. 

To generate a specific type of forgery, select one of the following 
menu buttons on the main screen: 

• F4 Planet 

• F5 Clouds 

• F6 Mountain 

• F7 Contour 

The program generates a low-resolution image in the currently 
selected image area . 
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You can use the Options menu to further define the image and 
then redisplay it in the same image area or in anoth r area. When 
you find an interesting image, you can render it to the fu ll screen. 
For rendering information, see IIRendering an Image" on page 166. 

Displaying Parameter Settings 

Keyboard shortcut: CID+CTI, CID+ffi, CID+w, CID +0 

The Fractal Forgeries main screen d isplays the parameters for the 
most recently displayed image. However, you can display the 
parameter settings for any image in the four image areas and make 
that image area the current one. 

• Right-click in an image box or press CID +CTI, CID+ffi, 
CID +w, or CID+0 to display the parameters for that 
image. The highlighted border moves to the image you se­
lected. 

Using the Options Menu 

• 
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Left-click the F3 Options button at the upper-left corner of the 
screen or press CIT) to display the Options menu. 

The Options menu lists the names of the Planet, Contour, Moun­
tain, and Other options submenus . 



Using the Options Menu 

Planet Options 

Hour 

To display the Planet Options menu, select the Planet Options but­
ton on the Options menu. 

Options 
Hour: 

Projection: 

The Hour option lets you change the planet's rotation shadow or 
"dark side" relative to its sun (or star) . You can enter an hour from 
-24 to 24 to simulate the planet's rotation around its axis. The 
default setting is 2. 

If the hour is set to 0, the sun is directly in front of the planet and 
no shadow appears on the planet. If the hour is set to 12 (and the 
season is set to zero) the entire planet is in shadow. 

• Enter a number from -24 to 24 and press 8 to change the 
rotation shadow. 

Season 

• 

The Season option lets you change the planet's dark side by chang­
ing the angle of its sun (or star). When the season is set to zero 
degrees, the sun and the planet's orbit are on the same plane. The 
default setting is 19. 

• Enter a number from -360 to 360 and press 8 to change 
the angle of the sun . 
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Projection 

You can project the image of a planet as a globe (the default) or as 
a flat, rectangular map that fills the entire image area. 

• Select the Globe button to display the planet as a globe. 
• Select the Map button to display the planet as a flat, rect­

angular map. 

Note: The Hour and Season options do not affect planets displayed 
as maps. 

Icecaps 

Icecaps gives you the option of displaying a planet with or without 
icecaps at the top and bottom. The default setting is icecaps on. 

• Select the On or Off button to turn the display of icecaps 
on or off. 

Dither 

The Dither option applys only to full-screen renderings and ani­
mations on VGA monitors. Dithering paints the image as a series of 
dots that give the colors a more blended or halftone look. Dithered 
images look very good from a distance. If Dither is off, the image 
is crisper from close up, but the colors do not blend as well. The 
default setting is Dither on. 

• Select the On or Off button to turn dithering on or off. 

Rotation 

• 
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Rotation applies only to animation. When rotation is set to EW 
(east to west) or WE (west to east), the planet rotates from frame to 
frame and completes a full rotation over the course of the anima­
tion. The default setting is none. 

• Select the None button to turn off rotation. 
• Select the EW button to set the rotation from east to west. 
• Select the WE button to set the rotation from west to east . 



Using the Options Menu 

Contour Options 

To use contour options, select the Contour Options button on the 
Options menu. The Contour Options dialogue box appears. 

Smoothing 

Use the Smoothing option if you want the contour to be painted 
with curving, irregular shapes. If the Smoothing is turned off, the 
image is created with squares of separate colors. The default setting 
is Smoothing on. 

• Select the On or Off button to turn Smoothing on or off. 

Wrapping 

The Wrapping option only applies when Smoothing is on. If wrap­
ping is on, the image is continuous in both the east-west and 
north-south direction. The default setting is Wrapping off. 

• Select the On or Off button to turn Wrapping on or off. 
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Mountain Options 

To use mountain options, select the Mountain Options button on 
the Options menu. The Mountain Options dialogue box appears. 

Mountain Options 
AzIl'luth: 

Eleuation: 

Screen Li .. i t: 

Clouds: 

F1 for HELP 

ACCEPT [-:-

Azimuth 

The Azimuth option rotates the entire mountain range in a hori­
zontal direction to give you a different view of the landscape. You 
can change the rotation up to 180 degrees in a negativ or posi tive 
direction. The default setting is 30 degrees. 

• Enter a number from - 180 to 180 and press B to change 
the rotation. 

Elevation 

The Elevation option lets you change the angle of the viewpoint 
in a vertical direction. The elevation angle can be from zero to 90 
degrees. At an elevation of zero, you look head-on at the moun­
tains. At an elevation of 90 degrees, you see a birds-eye view of the 
mountains (which are represented as a flat map). The default set­
ting is 60 degrees. 

• Enter a number from 0 to 90 and press B to change the 
elevation. 

Screen Limit 

• 
164 Chapter 6 

Screen Limit determines the percentage of the screen height that 
is filled by the mountain range. If you set a screen limit of 100 per­
cent, the tallest peak will extend to the top of the screen. The 
default screen limit is 75 . 



-

Clouds 

Using the Options Menu 

• Enter a number from 2 to 100 and press 8 to change the 
screen limit. 

You have the option of displaying clouds in the background of 
mountains on full-screen renderings and in animations. When 
you render mountains with clouds, the program first paints the 
clouds on screen, and then makes a second pass to paint the 
mountains . The default setting is Clouds turned off. 

• Select the On or Off button to turn the display of clouds on 
or off. 

Other Options 

There are two additional options that control whether informa­
tion is displayed on renderings and animations. To display the 
Other Options menu, select the Other Options button on the 
Options menu. 

Other Options 
Para~eter Sta~ping: 

Fra~e Sta~pin9: 

ACCEPT r:t 

Parameter Stamping 

Parameter stamping gives you the option of displaying parameter 
values on a full-screen rendering. The default setting is Parameter 
Stamping turned off. 

• Select the On or Off button to turn the display of parame­
ters on or off. 

Frame Stamping 

Frame stamping gives you the option of displaying animation 
frame numbers on screen. The default setting is Frame Stamping 
turned off. 
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• Select the On or Off button to turn the display of frame 
numbers on or off. 

Note: if the Frame Stamping option is on when you create an 
animation, the frame numbers appear when you view the 
animation, even if you turn Frame Stamping off at that time. 

Rendering an Image 

Keyboard shortcut: m to bypass Render an Image dialogue box 

After you set all the parameters and select the appropriate options 
for the type of image you want to create, you can render the image 
on a fu ll screen or to a file. On VGA monitors, you can render the 
image in 256 colors. 

To render an image, left-click the F8 Render button on the Main 
menu or press @ . The Render an Image dialogue box appears. 

Render an bage 

I I 256 colors 

Render to Screen . Render to File 

F1 for HELP ESC to Cancel ~- ",,~ENDE~ 

In this dialogue box, you specify the type of image you want to cre­
ate, the number of colors you want to use, and whether you want 
to render to the screen or to a file. 

Selecting the Image Type 

• 
766 Chapter 6 

To specify the type of image you want to render, select one of the 
following buttons: 

• Clouds 
• Mountains 

• Planet 

• Contour 



Rendering an Image 

Selecting the Number of Screen Colors 

If you have a VGA monitor, you have the hoice of rendering the 
image in 16 or 256 colors. 

• Select the 16 colors or 256 colors button to choose the 
number of colors for the rendering. 

Rendering to the Screen or a File 

You can render to the full screen or you can save the rendering in 
a file. 

To render to the screen, follow these steps: 

1. Select the Render to Screen button . 

2. Select the RENDER button to render the image with the se­
lect d render options. The program displays the image on 
the full screen. 

To save th rendering in a fil e, follow these steps: 

1. Select the Render to File button. 

2. Select the RENDER button to accept the rendering opt ions. 
A filename dialogue box appears. 

3. Enter a name for the rendering file and select the OK bu t­
ton. The program saves the rendering to that fil e and dis­
plays the image on the full screen . 

Exiting the Full-Screen Rendering 

To exit the full -screen rendering and return to the opening screen 

• Click either mouse button or press any key. 
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Animating an Image 

If you have a VGA monitor, you can animate a forgery. To create 
an animation, you specify starting and ending parameters and tell 
the program how many frames you want to distribute the changes 
over. For example, you can create an animation of a planet forgery 
that starts with the hour set to zero and ends with the hour set to 
24. When you play back the animation, you' ll see the rotation 
shadow move across the planet. 

When you create an animation, the program saves it in an an ima­
tion file with a .fli extension . You can play back the Animation in 
the Fractal Forgeries program or you can use the animation file in 
Autodesk Animator™. 

Creating an Animation 

1/1 
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Keyboard shortcut: CD to display the Animation dialogue box 

To create an Animation, fo llow these steps: 

1. Select Animate from the F2 File menu. The Animation dia­
logue box appears. 

Clouds -, Mountains 

Start 

DiMension: 2.600 

Height: 

Pouer: 0. 7BB 0. 7BB 

Eleuation: 67 -, ~ 

AziMuth: 30 -: ,- -

Hour: 

Season: 

F1 for HELP ESC to Cancel 

-



Animating an Image 

Note: If you have set starting and ending animation param­
eters on the main screen as described in "Setting Anima­
tion Parameters" on page 157, those parameters are shown 
in the Animation dialogue box. 

2. Select one of the following buttons for the type of image 
you want to animate: 

• Clouds 
• Mountains 

• Planet 
• Contour 

3. Make any changes you want to the Start and End parame­
ter fields for the animation sequence. 
Note: Dimension, Height, and Power are described in 
"Changing Forgery Parameters" on page 155. Elevation 
and Azimuth are described in "Mountain Options" on 
page 164. Hour and Season are described in "Planet Op­
tions" on page 161. 

4. Enter the number of frames for the animation in the 
Frames field or use the default setting of 10 frames. The ac­
ceptable range for the number of frames is 1 to 999. 

S. Select the ANIMATE button to create the animation file . 
The Make FLI dialogue box appears. 

Making an Animation File 

When you select the Animate button in the Animation dialogue 
box, the program displays another dialogue box requesting a file 
name for the animation. 

To name the animation file, follow these steps: 

1. Enter an animation filename and press 8. (The program 
automatically adds the .fli extension to your filename.) 

2. Press 8 or select the OK button to start generating the an­
imation. 

The program generates each frame of the animation and displays 
them on screen. When all frames have been generated, you return 
to the main screen in the program. 
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Saving and Loading Files 

Note: If your computer ru ns out of memory while generating the 
animation, you can do one or both of the fo llowing and try again: 
1.) Increase the amount of memory available to CHAOS (for 
example, remove any unnecessary TSRs); 2.) Reduce the Mesh Size 
parameter. 

Viewing an Animation 

Keyboard shortcut: m 
To view an animation, fo llow these steps: 

1. Select View An imation from the F2 File menu. A dialogue 
box appears request ing the name of the .fli (animation) file 
you want to view. 

2. Enter the animation filename and press B or double-click 
a filename in the list box on the left. 

3. Select the OK button or press B to play back the anima­
tion . The program displays the animation over and over 
again. 

To stop the animation, follow these steps: 

1. Click either mouse button or press any key to return to the 
View Animation dialogue box. 

2. At the View Animation dialogue box, press Cli0 to return 
to the main program screen. 

Saving and Loading Files 

You can use the options on the File menu to save and reload 
parameter files, .gl{files, animation files (.fli files), and .dxffiles. 
For information on saving and loading parameters and .giffiles, 
see "Saving and Loading Files" on page 209. For information on 
saving and viewing animation files, see II Animating an Image" on 
page 168. 

Saving DXF Files 

110 Chapter 6 

Keyboard shortcut: m 
DXF (Drawing Interchange Format) is a file format originally 
developed by Autodesk as an exchange format for AutoCAD®. 



The Mathematics of the Program 

DXF file compatibility has since been incorporated into many 
drawing and desktop publishing programs. 

To create a DXF file using the current parameters, follow these 
steps: 

1. Select the Save as DXF button on the F2 File menu. A dia­
logue box appears prompting you for a filename. 

2. Enter a filename and press B . The program automatically 
adds the .dxf extension to your filename. 

3. Press B or select the OK button to save the .dxffile. 

You can import the .dxffile into many desktop publishing and 
graphics programs including AutoCAD and 3D Studio™. 

The Mathematics of the Program 

The Fractal Forgeries program uses a delicately tuned mixture of 
order and randomness to generate shapes that resemble clouds, 
mountains, and planetary landscapes. The random element of 
each image is involved in the way we pick certain coefficients, and 
the orderly element is the way in which the coefficients are used 
to build up a series of curves that are summed to produce the even­
tual pattern. Although the forms of naturally occurring clouds, 
mountains, and planets are probably not determined by algo­
rithms as simple as ours, naturally occurring shapes lie at the same 
kind of chaotic interface between randomness and order. 

Our program works by a technique known as the "spectral synthe­
sis of a Fourier sum." The basic notion is that an arbitrarily com­
plicated curve y = F(x) can be gotten by taking a weighted sum of 
sine waves of various frequencies. The sine function is the familiar 
periodic curve that smoothly wiggles up and down as you move 
out along the x-axis. Sin(2*x) wiggles twice as fast as sin x, sin(3*x) 
has triple the frequency, and so on. (Our Fourier sums actually use 
terms of the form cos(n*x) as well, but we'll leave them out here 
to make the exposition simpler, since this only affects the phase of 
the waves.) In one dimension, a general Fourier sum using n dif­
ferent frequencies looks like this: 

F(x) = ao + a1 " sin (x) + a2 * sin(2"x) + ... + an " sin(n"x). 

Fourier sums also work in two dimensions, where a surface can be 
thought of as the graph of a height function z = G(x,y) . The build­
ing blocks used here are quilt-like surfaces defined by formulas of 
the form sin(x) * sin(y), sin(x) * sin(2*y), sin(2*x) "' sin(y), and so 
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on. These Fourier sums also use terms of the form cos (n*x), but, 
again, we'll leave them out to make the exposition simpler. In two 
dimensions, a Fourier sum using n*n frequencies looks something 
like this: 

G(x,y) =: aoo + aO l * sin (x) + alO * sin(y) + all * sin (x) " sin(y) + 
al2 * sin (x) *' sin(2*y) + a2 1 * sin(2*x) * sin(y) + 
a22 * sin(2*x) * sin(2*y)+ ... + ann * sin(n*x) * sin(n*y). 

If we know in advance exactly what our surface G is supposed to 
look like, then it is possible (though exceedingly complex) to cal­
culate the best choices for the Fourier coefficients aij ' 

Conversely, it is also possible to generate entirely new surfaces by 
picking the aij by some more or less random process, summing up 
the terms, and drawing a picture of the surface that results. 

When our Fractal Forgeries program is used to draw a Mountain, 
this is exactly what is going on. The Cloud, Planet, and Contour 
representations are really just different ways of presenting the 
same calculated data, as will be explained in more detail below. For 
now, however, it is easiest to think of Fractal Forgeries as a pro­
gram that generates 3D views of surfaces. 

When it creates a surface, Fractal Forgeries first picks some reason­
able values for the aij' As these coefficients determine the weights 
assigned to the different possible frequency components, they can 
be thought of as influencing the "spectrum" of frequencies that 
the surface will use. The process of picking the aij is known as 
"Spectral Synthesis." Once the aij are set, the program uses the 
G(x,y) formula from above to evaluate G(x,y) at some (though not 
all) of the possible (x,y) positions. The calculation of the Fourier 
sums is called an "Inverse Fourier Transform." 

How exactly do we perform our spectral synthesis? If we were to 
pick the aij completely at random, we'd get surfaces that looked 
quite unnatural. Instead, we specify for each combination of i and 
j what the expected value of aij ought to be, and then try and pick 
some random value that is near this expectation. The surface G's 
bumpiness or "fractality" depends quite sensitively on the way 
that the expected value of ai' varies with the size of i and j. Keep in 
mind that a term aij*sin(i*,x)*sin(j*y) is able to contribute more 
bumpiness to the surface if both i and j are large-large i and j 
mean a rapidly oscillating surface-also keep in mind that aij 
determines the size, or amplitude, of these oscillations. If we 
request that the expected value of aii be quite small for large values 
of i and j, then the Fourier sum surface will be smooth. If, on the 
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other hand, the expected values of the aij remain reasonably large 
as i and j grow, then the Fourier sum surface will have more ups 
and downs. 

A perfectly smooth surface has dimension 2. From the standpoint 
of fractal mathematics, the more bumpy a surface is, the higher is 
its fractal dimension. If a surface were endlessly spiky- like the 
surface made up of the combined surfaces of the bristles of a brush, 
say- then it would effectively fill up all of a three-dimensional 
region . As a surface gets more and more bumpy and fractured, its 
fracta l dimension gets closer and closer to 3. 

When the user sets the Fractal Dimension parameter between 2 
and 3, he or she is essentially specifying how rapidly the average 
sizes of the aij parameters should fall off with increasing values of 
i and j. Keep in mind, however, that since we only use a relatively 
small number of terms in our Fourier sums, the so-called" random 
fractals" that our program generates do not have anything like the 
detail of the "deterministic fractals" generated by The Chaos Game 
and by the Mandelbrot program. 

What about the other parameters: Height, Power Factor, Mesh 
Size, and Terms? 

The Mesh Size parameter controls two quite disparate things. First 
of all, it controls the size of the maximum frequency number N, 
which is used in the Fourier sum. The Fourier sum potentially 
allows all terms of the form ai j * sin(i*x) '" sin(j*y) with i and j both 
$ Mesh Size. The Mesh Size parameter also happens to be used for 
a wholly unrelated parameter: as a measure of the number M of 
paints (x,y) for which the full Fourier sum is actually calculated. 
We use a grid with Mesh Size points on each edge. You can see the 
mesh quite plainly if you draw a Contour image after using the 
Contour Options menu to turn the Smoothing feature off. 
Another way to see the mesh is to draw a Mountain image after 
using the Mountain Options menu to change the Azimuth to 90. 
The "mountain heights" are calculated at each of the mesh points, 
and eventually the values for the points in between the mesh 
points are interpolated by filling in the spaces between adjacent 
triples of mesh points with triangular pieces of plane. 

The reason that we take the highest frequency number N and the 
mesh edge length M to be the same number is that it would effec­
tively be a waste of computation to include frequencies which 
oscillate much more rapidly than the steps of our mesh. But we do 
allow the user to hand-set the maximum frequency to be lower 
than the number of mesh points. 
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The Terms parameter controls how many of the possible Fourier 
sum terms we actually use. If Mesh Size is M, and Terms is , it 
really only makes sense to have N ~ M. If you select an N > M, the 
pr gram will actually behave as if you had selected N = M. The 
effect of reducing N is to zero out more and more of the Fourier 
terms aij ", sin(i*x) * sin( j*y), making the surface smoother and 
smoother. This is slightly different from the effect of setting a low 
fractal dimension to make the aij be very small. If, for instance, we 
have a high fractal dimension but only use a few terms, then we'll 
get reasonably large aij out to some point-at which they switch to 
being zero. This kind of combination can make pleasingly hilly ter­
rain. 

As we compute the value of the Fourier sum G(x,y) for each mesh 
pOint, we keep track of thei r sizes so as to determine the largest 
value attained, which we can call MaxZ. Once all the Fourier sums 
are calculated, we set all the G(x,y) which came out negative to 0, 
and we divide all the positive G(x,y) by MaxZ. The result of this is 
that all the G(x,y) now lie between 0 and 1. The next step of our 
landscape synthesis is known as "Power Scaling," and is deter­
mined by the value of a user-specified Power Factor, which lies 
between 0 and 2. What we do is to raise each of the G(x,y) to a 
power E, which is based on the Power Factor. 

Keep in mind that 0 ~ G(x,y) ~ 1. If we square a number z that is 
between 0 and I, say 0.4, then we get a smaller number. 0.42 = 0.16 
< 0.4. In general, if E is any exponent greater than 1 and z is any 
number between 0 and I, then ZE is less than z. Conversely, if we 
were to take the square root of, say, 0.49, we would get a larger 
number, in this case 0. 7. Recall that taking a square root of a num­
ber is the same thing as raising that number to the power 0.5. In 
general, if E is any exponent between 0 and I, and z is a number 
between 0 and I, then ZE is greater than z. If P is our power factor, 
then we actually take E to be e<P - I ), so that the effective range of E 
is about 0.28 to 1 to 2.6, as the parameter P ranges from 0 to 1 to 
2. The net effect is that if the power factor is less than I, then it 
pushes all but the highest points up-creating things like mesas­
and if the power factor is greater than one, it drags all but the high­
est pOints down-making spires. 

At this pOint, all the G(x,y) still range from 0 to 1. If we have 
selected Cloud, then we bail out here, and color all the G(x,y) with 
values less than 0.5 blue, and scale all the values between 0.5 and 
1.0 into increasingly saturated shades of wh ite. If you find that 
your clouds are coming out with too much blue, set the Power 
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Factor to a low value so as to make the G(x,y) get bigger. Remember 
that for G(x,y) to show as white it has to be bigger than 0.5. If 
we've selected Contour, we also bail out here, using an unsmooth 
range of colors to show the steps from 0 to l. 

If we're doing Mountain or Planet, then we do one more opera­
tion, multiplying the G(x,y) by the user-specified Height parame­
ter. 

To show a Planet, we use a spectrum of colors that makes points 
less than 0.5 look like they're under water. To show a Mountain, 
we calculate all the heights and rescale one last time to make sure 
the highest peak fits on screen. Before we actually draw a moun­
tain range on screen, we draw a virtual image of it in memory, and 
eliminate aU the pieces that are behind other pieces. This last pro­
cess is called liZ-buffering." 

The wiggly line in the window at the top of the menu is a fast pre­
view of what the more complicated images are expected to look 
like. The line might be thought of as a diagonal cross-section of 
one of the Mountain images, taken from corner to corner. 

The randomizer algorithm uses a certain seed number to start 
with. If you reset the seed to the same value twice, you' ll get the 
same pseudorandom number sequence, resulting in exactly the 
same" random" fractal forge ry. If you like, you can use something 
like your birthday for the random seed. Just make sure to order the 
digits of your birthday in such a way that the leading digit is less 
than 3, because the largest "seed" that our randomizer likes to eat 
is about 32,000. 

All of our "random" fractals are based on sine waves, and sine 
waves are periodic. They repeat themselves. This fact is evident if 
you look at one of our images closely- the left edge always 
matches the right edge, and the top matches the bottom. If you 
could print out lots of them, you could set them edge to edge like 
Escher tiles. This periodicity comes in handy when we wrap the 
images arou nd a spherical planet and let the planet rotate. 
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Chapter 7 

Toy Universes 

In our world, complexity flouris hes . . . Somehow, after all, as 
the universe ebbs toward its final equilibrium in the feature­
less heat bath of maximum entropy, it manages to create 
interesting structures . .. the changing degree ofform and 
formlessness in the creation of amino acids, of micro organ­
isms, of self-reproducing plants and animals, of complex 
information systems like the brain. (Chaos: Making a New 
Science, page 308.) 

Imagine a forest where every tree tries to grow higher than its 
neighbors. Say that every spring, each tree takes account of the 
average height of its nearest neighbors and then grows ten feet 
higher than that average over the coming year. Suppose also that 
once a tree gets to a maximum height of sixty feet, it stays at that 
height for a year, and then dies, leaving a blank space. Finally, sup­
pose that a blank space will sprout a new tree provided that there 
are living trees nearby. 

What kind of growth pattern would such a fo rest display? If the 
forest started out from a single tree, one would expect orderly cir­
cles of growth and decay, endlessly radia ting out from the position 
of the first tree. But what if the forest were started with a random 
scattering of seeds, some bunched together, and some far apart? 

As it turns out, even a randomly started forest will develop orderly 
waves of growth. Rather than being perfect circles, the waves will 
be curved arcs that look like spirals at either end. Several kinds of 
chaotic systems generate these shapes, which resemble the capitals 
of Ionic columns. The Soviet chemists B.P. Beluzov and A.M. 
Zhabotinsky first observed these shapes in petri-diSh experiments 
in the late 1950s. To set off the so-called BZ reaction, they would 
mix some reactive chemicals with an indicator fluid whose color 
changes made visible the solution's local acidity at each point. To 
set the BZ reaction in motion, they would sprinkle in a catalyzing 
dust of palladium crystals. Each crystal acts like a "seed" in the for­
est example described above. Though the pattern is thoroughly 
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random to start with, before long the characteristic double-spi ral 
scrolls, now known as BZ-scrolls, always appear. 

Building on the work of Beluzov and Zhabotinsky, the biologist 
Arthur T. Winfree ran computer simulations to show that BZ­
scrolls can occur in three-dimensional reactive media, and con jec­
tured that the wave-fronts of excitation that keep our hearts beat­
ing can be fru itfully thought of as BZ-scrolls. 

The BZ-scrolls shown in the Toy Un iverses program are examples 
of a kind of computer simulation known as cellular automata. Cel­
lular automata were invented by John von Neumann and Stanis­
law Ulam in the late 1940s as a way of modeling a kind of artificial 
life. Von Neumann 's goal was to show that there can be man-made 
patterns of information tha t reproduce themselves, just as do all 
the truly living creatures around us. Ini tially, he tried to couch his 
argument in terms of robots that assemble other robots, but the 
details of this approach grew too unwieldy. Ulam, a mathemati­
cian who helped invent th hydrogen bomb, gave von Neumann 
the idea of modeling a computer creature as a certain pattern in a 
grid of squa re cells. By the mid-19S0s, von Neumann was able to 
prove that there are cellular automata worlds in which some of the 
patterns do indeed build copies of themselves. Presciently enough, 
his proof h inges on the idea of having h is cellular automata crea­
tures carry copies of their blueprin ts; years later, Watson and Crick 
would es tab lish that real living creatures carry blueprints in the 
form of D A. 

A very simple cellular au tomaton rule kn own as the Game of Life, 
created by the mathematician Joh n Horton Conway, became pop­
ular among computer hackers in the 1970s. In Life, each cell looks 
at its eight nearest neighbors and decides at each generation 
whether to turn itself on o r off. 

The four fam ili s of cellular automata shown in Toy Universes can 
use many more than Life 's two states. Each of their initial param­
eter settings is tuned to produc one of the patterns that cellular 
automata seem to do best: BZ-scrolls. It is striking to see how this 
apparently universal shape emerges from the run ning of ach of 
the quite different rules. In t he Hodge ru le, in particular, the scrolls 
have a hauntingly organiC look to them. 

In some chaotic computer Si mulations, we see very simple equa­
tions generating complex fractal patterns. In the toy un iverses of 
cell ular automata, we see that t he process can run the other way. 
By pressing CIT), you can seed any of these simulations with a com­
pletely disorderly start condition, and then watch how the disor­
derly start slowly evolves into the chaotic order of the BZ-scrolls. 

-
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Things To Try 

The program seems to suggest that chaos exists as a kind of inter­
face between order and disorder. 

Things To Try 

Select the F3 Rules button to cycle through four different kinds of 
cellular automata. When you select a new rule, it is a good idea to 
re-seed the screen by pressing (ill to randomize it. 

Try pressing a!D+CD to get a zoom box and then left-click the 
mouse or press the ~ key to zoom in. You can speed up the 
zoomed-in toy universes by turning on the Fast option on the 
Options menu. 

You can also zoom out to a slow, but very high resolution mode by 
right-clicking or pressing @ill. It is interesting to let the Eat rule or 
the Tube rule run for an hour or so in this high resolution mode. 

Starting the Program 

Run, Stop, and 
Step buttons _ 

When you start the program, you see this screen: 
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Exploring the Program 

The main image area of th screen shows a cellular automaton (or 
toy universe). Cellular automata are self-generating, ever-growing 
computer graphics with cells whose colors change according to 
different rules. 

At the bottom of the menu area, you see the Run, Stop, and Step 
buttons, which make each toy universe start moving, stop moving, 
or move one step at a time. 

Exploring the Program 

180 Chapter 7 

Have fun exploring the cellular automata in this program before 
you work with each feature in deta il. You learn more about the fea­
tures of Toy Universe later in this chapter. 

Begin by cycling through t his program's four different rules: 
Hodge, Eat, NLUKY, and Tube. Here's how to display and run the 
rules. 

1. Watch the Hodge cellular automaton change for a while 
after you first start the program. 

2. Select the Stop button or press the spacebar to stop the 
growth of the cellular automaton. 

3. Left-click the F3 Rules button or press CIT) to display the 
next rule. 

4. Select the Run button or press ( Shift) and the spacebar to 
start the cellular automaton's growth, and then immedi­
ately left-click the F5 Randomize button or press GD to ran­
domize the new rule. Watch the new rule run for a while. 

S. Cycle through the remaining two rules-NLUKY and 
Tube-by repeating steps 2-4. 

6. Finally, press the spacebar to stop the Tube rule and press 
CIT) to display the Hodge rule again. 

Note: After you change to each new rule and start it running, 
always randomize the cellular automaton. Randomizing starts cell 
growth from scratch and helps keep it going. 

You might enjoy experimenting with colors in the program as the 
toy universes change in the image area. 

1. Display the Eat rule, start it running, and randomize it. 



Zooming In on a Cellular Automaton 

2. Press a!D+GJ to start colors cycling continuously while 
the rule grows. The cycling colors bring out different 
shapes as the cellular automaton changes in the image 
area. 

3. As the colors cycle, press a!D+(I) to overlay a diamond 
shape in the cellular automaton. The color-cycling cellular 
automaton "eats" toward the center of the diamond that 
the program overlays in the rule. 

4. For a shimmering effect while the colors are still cycling, 
press the Stop button or the spacebar. 

5. Press a!D+GJ two more times to turn the continuous col­
or cycling feature off. Press a!D+® to return to the de­
fault palette. 

Zooming In on a Cellular Automaton 

You can zoom in for a closer look or zoom out to see a wider area. 
In Toy Universes, you can zoom to four different resolutions-low, 
medium, high, and very high. The program starts in high resolu­
tion. (If CHAOS detects that there is not enough memory in your 
computer the first time you try to zoom out to very high resolu­
tion, the program displays a warning message. After that, the pro­
gram ignores any attempts to zoom out to very high resolution 
until it detects enough memory to do so.) 

Note: If the cellular automaton is stopped when you zoom, the 
image area will turn black. If this happens, select the Run button or 
press ( Shift) and the spacebar to start the cellular automaton at the 
new resolution you just zoomed to. 

To zoom with the mouse 

1. With a cellular automaton running and the cursor any­
where in the image area, left-click to zoom in. (Since you 
zoom on the center of the image area, cursor location with­
in the image area is not important.) 

2. With the cursor anywhere in the image area, right-click to 
zoom out. 

To zoom with the keyboard 

1. With a cellular automaton running and the cursor any­
where, press ~. 

2. With the cursor anywhere, press @ill to zoom out. 
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Examining Growth in Steps 

You can also us a zoom box that lets you choose the center of the 
image you want to zoom on. You can zoom with the zoom box 
only at medium or high resolution. You cannot resize the zoom 
box in Toy Universes. 

1. Press CID+GJ to display the zoom box. 
2. Move the zoom box to the location you want to center 

your zoom on. 
3. Left-click or press ~ to zoom in on the specific area. 
4. With the zoom box displayed, you can also zoom out by 

right-clicking or pressing CQill. 
S. If you change your mind while you're working with the 

zoom box, you can press ~ to cancel the zoom box. 

Note: T move the zoom box around the image area wi th the 
keyboard, use the arrow keys, as well as~, ~, (Home), and 
(End) . 

Examining Growth in Steps 

You can examine a cellular automaton's growth one step at a t ime. 
When you look at the growth in steps, you get a better idea of the 
color changes that are happening. 

1. Select the Step button or press the spacebar to stop the cel­
lular automaton's growth in the image area. 

2. Select the Step button or press the spacebar repeatedly to 
examine the growth one st p at a time. 

3. When you're through watch ing the growth in steps, select 
the Run button or press Q!illD and the spacebar to go back 
to free-running growth. 

Note: If you randomize while you are examining cell growth one 
step at a t ime, you must select the Step button or press the spacebar 
once for randomization to take effect . 

Understanding Cellular Automata 
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Though the patterns look complicated, the logic of the toy uni­
verses is simple. Each type of cellular automaton is made up of cells 
obeying a single rule. A rule changes the color of each cell. 



BZ-scroll 

Understanding Cellular Automata 

A cell 's neighbors are the eight cells that surround and touch it on 
all sides. In this program, a cell makes its next color change on the 
basis of the present colors of itself and its neighbors. 

Three things characterize cellular automata: 

• They are parallel . All cells compute their new colors at the 
same time. 

• They are homogeneolls . Each cell obeys the same rule for 
color changes. 

• They are local . Each cell looks only at its close t neighbors 
in deciding what color to change to. 

In addition, many cellular automata evolve into images with a 
common theme. Aftei a cellular automaton runs for a while, you 
often sea shape like the double-spiraled scroll at the top of an 
Ion ic column. People who work with cellular automata call these 
shapes BZ-scrolls, after two Soviet chemists, Beluzov and Zhabotin­
sky, who discovered the shape in chemical reactions. (You can see 
photographs of these chemical reactions in James Gleick's Chaos: 
Making a New Science, page 287.) 

Here is an example of the Eat cellular automaton with BZ-scrolls: 

The following section lets you examine one rule and how it gov­
erns color changes for cells in a cellular automaton. 
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Understanding the Hodge Rule 

Understanding the Hodge Rule 
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In the Hodge rule, each cell sums the values of its eight nelghbors, 
averages that total, and adds the value stored in the Increment 
parameter. The result is the cell's new color value (the number 
assigned to a particular color) . When a cell 's new color value 
exceeds the value stored in the Number parameter, the cell stays at 
the color value of the Number parameter for one generation. Then 
the cell drops back to zero, which is black. The cell changes color 
value again when the sum of its neighbors exceeds a certain 
threshold value. For details of the calculations in the Hodge rule, 
see liThe Mathematics of the Program" on page 202. 

To help you understand cellular automata rules, you can examine 
the Hodge rule at work and the color changes in one cell. 

Important: Be sure you are working with the default Hodge palette 
as you do the exercises in this section. If you are unsure what 
palette you have for the Hodge rule, exit the program and reenter, 
or, with the Hodge label displayed in the menu area, press 
@ + CQJ to load the default palette. 

Start by simplifying the Hodge rule's color changes. Make the fol ­
lowing changes in the Hodge rule's parameter buttons and then 
start the rule running: 

1. Select the F3 Rules button or press (fl) until you see the 
Hodge label in the menu area. 

2. Enter 6 in the Number fie ld, and press 8. 
3. Enter 2 in the Inc field, and press 8. 
4. Select the Run button or press ( Shift) and the spacebar to 

start the rule, and then immediately left-click the F5 Ran­
domize button or press CID to randomize the new rule. 

When you set up these parameters and start the rule working, you 
see cells of just a few colors (orange, brown, dark red, blue, and 
green), in the default palette. The color areas grow and merge on 
screen. 

You can get a closer view of color changes in individual cells by 
zooming to medium resolution. At this resolution, there are grid 
lines around each cell. 

• With the cursor in the image area, left-click once to zoom 
to medium resolution. (You can also press ~ with the 
cursor anywhere to zoom to this resolution.) Then 



Understanding the Hodge Rule 

immediately select the F5 Randomize button or press CID to 
randomize the cellu lar automaton again. 

Even after you zoom to this resolution, you probably find that the 
color changes happen so fast that you cannot comprehend all the 
changes. 

You can get a clear view of what is happening to cell colors by 
watching the rule run in single steps. At the same time, you can 
find out what the color values are for the five colors in this setup 
of the Hodge rule. 

1. Again, select the F5 Randomize button or press CID to ran­
domize the rule, and then select the Step button or press 
the spacebar right away. Cell growth pauses. 

2. After that, select the Step button or press the spacebar re­
peatedly and note each different cell color as it comes in . 
As each new color comes in, assign 0 to black, 1 to the fi rst 
color that comes in, 2 to the second color, and so on, 
through s. The color values in this default palette are 

0= black 
1 = orange 
2 = brown 
3 = dark red 
4 = blue 
5 = green 

Now you're ready to focus on one cell and watch how the Hodge 
rule changes the cell's colors. Follow these steps: 

1. With cell growth still paused in the Single-step mode, 
choose a non-black, non-green cell. 

2. Sum the color values of the cell's eight neighbors. 

3. Divide by 8 and round down to the nearest whole number. 

4. Add 2 (the value stored in the Inc parameter) . 

The result of this computation should be the color value for the 
cell the next time you press the spacebar. 
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For example, look at the following configuration of color values 
for the neighbors of one cell : 

7 2 3 

2 cell 4 

7 2 3 

To und rstand how the Hodge rule works, perform the computa­
tion in the fo llowing steps: 

1. First, sum the color values of the cell's eight neighbors. The 
result is 18. 

2. Then, divide by 8 and round down to a whole number. The 
result is 2. 

3. Finally, add 2, which is the value stored in the Inc param­
eter. The result- 4- gives you the cell's next color value. 
Looking back at the color values you observed for all five 
colors in the cellular automaton, you see that 4 = blue. So, 
the next time you press the spacebar, the cell in this illus­
t ration would Change to blue. 

Changing the Hodge Parameters 
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[f Hodge is not already displayed, left-click the F3 Rules button o r 
press CIT) until the program displays the Hodge parameters in the 

I 
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Hodge parameters { 

Understanding the Hodge Rule 

middle of the menu area: 

Hodge Rule image 

Use the Hodge parameters to change the Hodge rule. In general, 
the best BZ-scrolls appear if the umber parameter is about six 
times the size of Inc. If Number is very large relative to Inc, 
smoothly averaged contour lines emerge. 

You can increase or decrease both parameters the m or G but­
tons next to each entry field. 

Suggestion: Try using a large Number parameter and a small Inc 
parameter and turning off screen wrap by pressing ®. If you set 
up the rule this way and let it run for a few minutes, you see 
patterns like those in hooked rugs. 

Number 

• 

Keyboard shortcut: (Shift) +CID to increase; CID to decrease 

The Number parameter sets the maximum number of color states 
that cells can change to in the Hodge rule's computation. The 
default number is 3l. 

• Enter a value between 1 and 255 and press 8 . 
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Inc (or Increment) 

Keyboard shortcut: (Shift l+OJ to increase; OJ to decrease 

The Inc parameter sets the value to be added in each computation 
fo r the Hodge rule. The default increment is S. 

• Enter a value between 0 and 255 and press 8 . 

Understanding the Eat Rule 
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In the Eat ru le, each cell changes color based on whether its neigh­
bors' color values are cyclically one unit h igher than the cell's own 
color value. Cells can change from color values 0 through one less 
than whatever value you set in the MaxEat parameter. Thus if 
MaxEat is 3, the cells can become color values 0, I , or 2. If you 
th ink of these values as being in a cycle, with MaxEat set at 3, then 
o can be eaten by I, 1 can be eaten by 2, 2 can be eaten by 0, and 
so on. In general, (MaxEat - - 1) can be eaten by O. 

A cell looks at the color value of either one neighbor or four neigh­
bors, depending on whether you are running the rule with dete r­
ministic mode set to No or Yes. 

With deterministic mode set to No, the rule has a random compo­
nent. Each cell randomly looks at the color value of just one of its 
eight neighbors. If the neighbor's color value is cyclically one unit 
higher than the cell's, the neighbor's color value "eats" (or 
replaces) the cell 's. If the color value of the neighbor is any value 
other than one unit cyclically higher, the cell stays the same color. 

With deterministic mode set to Yes, each cell looks at the color val­
ues of four of its neighbors-the neighboring cells directly to 
either side of the cell , and directly above and below it. If anyone 
of their color values is one unit higher than the cell's, that neigh­
bor's color value "eats" the cell's, just as when the deterministic 
mode is set to No. If the color values of the four neighboring cells 
are all values other than one unit higher, the cell stays the same 
color. 

For details on the calculations in the Eat rule, see liThe Mathemat­
ics of the Program" on page 202. 



Understanding the Eat Rule 

Changing the Eat Parameter and Mode 

Left-cl ick the F3 Rules button or press em until the program dis­
plays the Eat parameter and mode in the middle of the menu area: 

Eat Rule image 

Eat Mode - I 

Eat Parameter -

Use the Eat parameter and mode to change the Eat rule. In general, 
be sure to randomize the rule by selecting the F5 Randomize button 
or pressing (ill whenever you increase the MaxEat parameter. 
Increasing the Max Eat parameter above 20 makes it difficult for 
the rule to get started. The Eat rule reaches equilibrium much 
faster with deterministic mode set to Yes. If you then set determin­
istic mode to No, the rule looks fuzzier and more organic. Eventu­
ally, BZ-scrolls appear. 

Suggestion: A good way to start the Eat rule is to overlay a shape. 
Press alD + CD to overlay a square, alD + CD to overlay a diamond, 
alD +CD to overlay a circle, or alD+(]) to overlay the Autodesk 
logo. You might also enjoy zooming out to very high resolution 
and letting the cells eat outward to a blank background. 
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Understanding the NLUKY Rule 

Determ (or Deterministic) 

Keyboard shortcut: [[) 

The D term mode lets you run the Eat ru le with or without a ran­
dom component. When you set th is mode to No, a cell randomly 
looks at just one neighbor in making its next color change. When 
you set t he mode to Yes, a cell looks at neighboring cells to either 
side of it and directly above and below it in making its next color 
change. The default condit ion for the Eat rule is Determ mode set 
to No. 

• Select the No or Yes button to run the Eat ru le wi th or with­
out a random component. 

MaxEat 

Keyboard shortcut: (Shift l+CD to increase; CD to decrease 

The MaxEat parameter sets the maximum number of color states 
that cells can change to in the Eat rule's computation. The default 
value is 9. 

• En ter a va lue between 1 and 255 and press 8 . You can 
also increase or decrease MaxEat with the CD or 8 but­
tons next to the entry fie ld. 

Understanding the NLUKY Rule 
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In the NLVKY rule, a cell can be in one of three kinds of color 
states: the state for of(, the state for on, or in one of a range of resting 
states. The value you set for the N parameter determines the num­
ber of resting colors in the NLVKY rule. 

The values you set in the L and V parameters determine when a 
cell goes from off to on, and the values you set in the K and Y 
parameters determine when a cell goes from on to a resting state. 
To make use of these parameters, each cell counts the number of 
its eight nearest neighbors that are in the on state. This quantity, 
called the stimulus, can range between 0 and 8. 

If a cell is off and the stimulus from its neighbors lies between L 
and V, then the cell turns on. Otherwise, the cell stays off. (If L is 
not greater than V, stimulus being between L and V means that L 
is less than or equal to stimulus, and stimulus is less than or equal 
to V.) 



Understanding the NLUKY Rule 

If a cell is on and the stimulu from its neighbors lies between K 
and Y, then the cell remains on. Otherwise, the cell will move into 
the lowest resting state. (If K is not greater than Y, stimulus being 
between K and Y means that K i less than or equal to stim ulus, 
and stimulus is less than or equal to Y.) 

If a cell is in a resting state, it always moves into the n xt resting 
state, until it reaches the highest re ting state. At that point, it 
moves back down into th off state, and the cycle restarts. 

It is also possible that L might be greater than U or that K might be 
greater than Y. If so, the stimulus is "cyclic," bent into a circle. 
Thus if L is greater than U, the program considers stimulus to be 
"betwe n" Land U if stimulus is greater than or equal to L or less 
than or equal to U. Likewise, if K is gr ater than Y, the program 
considers stimulus to be "between" K and Y if stimulus is greater 
than or equal to K or less than or equal to Y. 

For details on the calculations in the NLUKY ru le, see liThe Math­
ematics of the Program " on page 202. 

The Life Version of the NLUKY Rule 

The NLUKY rule has two famous versions: Life and Brain. In the 
Life version of the rule, you set the NLUKY parameters to 03323 
(N=O, L=3, U=3, K=2, Y=3). When you run Life, there are no resting 
colors; a cell's color is either off or on. You see a lot of seething 
activity in Life, but eventually most of the activity dies out. The 
shapes you see in Life have names given by people who work with 
cellular automata. For example, you can see blocks, gliders, blinkers, 
and so on. 
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Understanding the NLUKY Rule 

Here's the Life version of the NLUKY rule shown in the image area: 

Blinker 

Block 

Glider 

Blinker 

The Brain Version of the NL UKY Rule 
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In the Brain version of the NLUKY rule, you set the NLUKY param­
eters to 12299 (N=l, L=2, U=2, K=9, and Y=9). When you run 
Brain, cells cannot stay on because K and Yare set to 9. (Because a 
cell has only 8 neighbors, there is no way that it can have 9 neigh­
bor cells on. You cannot count a cell as being a neighbor of itself.) 
You see a lot of horizontal and vertical movement in Brain. The 
shapes in Brain, like those in Life, have names. For example, you 
can see Jacob's Ladders, haulers, outriggers, butterflies (the only 
shapes that moves at 4S degrees), and so on. 



Jacob 's ladder 

Hauler + Outrigger 

Butterfly 

Understanding the NLUKY Rule 

Here's the Brain version of the NLUKY rule shown in the image 
area: 
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Understanding the NLUKY Rule 

Changing the NL DKY Parameters 

NLUKY parameters 

N 

194 Chapter 7 

Left-click the F3 Rules button or press @ until the program dis­
plays the NLUKY parameters in the m iddle of the menu area: 

NLUKY Rule image 

Use the NLUKY parameters to change the NLUKY rule. You can 
also increase or decrease NLUKY parameters with the m or 8 
buttons next to each entry field. 

Keyboard shortcut: (Shift l+ OD to increase; OD to decrease 

The N parameter sets the number of resting color states that cells 
can change to in the NLUKY rule 's computation. The default num­
ber of resting color states is 7. 

• Enter a value between 0 and 127 and press 8. 



Understanding the Tube Rule 

Land U 

Keyboard shortcut: (Shift) +CD to increase L; CD to decrease L; 
(Shift )+CJD to increase U; CJD to decrease U 

The Land U parameters det rmine when a cell goes from off to on. 
If a cell is off and stimulus is between Land U, the cell turns on. 
Otherwise, the cell stays off. The default setting for L is 2; for U, 3. 

• Enter a value between 0 and 9 and press B . 

Kand Y 

Keyboard shortcut: (Shift) +00 to increase K; 00 to decrease K; 
( Shift) +CD to increase Y; CD to decrease Y 

The K and Y parameters determine when a cell changes from the 
on state to the first of the resting states. If a cell is on and stimulus 
is between K and Y, the cell remains on. Otherwise, the cell moves 
into the first resting state. The default setting for both K and Y is 2. 

• Enter a value between 0 and 9 and press B. 

Understanding the Tube Rule 

The Tube rule gets its name from the behavior of colonies of tube­
worms in coral reefs. Tubeworms live in holes and are easily 
alarmed. They hide from their neighbors, coming out to eat only 
when their neighbors are not out. 

In the Tube rule, a cell is hiding, or in an even-numbered color 
state, for the number of color-change steps stored in the Hiding 
parameter. The cell turns on to the first eating color state only 
when it is "safe" to do so. The cell considers it safe if it finds fewer 
eating neighbors than are stored in the Alarm parameter. If it is 
safe, the cell stays in the first eating state. Otherwise, the cell 
begins moving through the successive eating states. The cell 
changes to each eating color state in succession, up to the number 
of eating color states stored in the Eating parameter. Once a cell 
gets to the largest eating color state, it returns to the first hiding 
state, and the cycle restarts. 

The Jazz condition affects how accurately a cell checks against the 
Alarm parameter. When you turn this condition on, you see fuzz­
ier edges to the shapes. 
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For details on the calculations in the Tube rule, see liThe Mathe­
matics of the Program" on page 202. 

Changing the Tube Parameters and Condition 

Tu,", parom,re" { 

Tube condition --
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Left-click the F3 Rules button or press em until the program dis­
plays the Tube parameters and condition in the middle of the 
menu area: 

Tube Rule image 

Use the Tube parameters and condition to change the Tube rule. 
In general, the Tube rule is quite sensitive. Many parameter 
changes might not look good in this rule. With]azz turned off, the 
rule works best with Hiding set to 4, Eating set to 3, and Alarm set 
to either 2 or 3. With]azz turned on, the rule works best only with 
the default settings for Hiding, Eating, and Alarm. 

You can increase or decrease the Tube parameters with the C±J or 
G buttons next to each entry field. 

Suggestion: You can clarify the action of the Tube rule with the 
Palette Editor to set all the hiding states, which are all even­
numbered colors, to black. To do this, think of the top leftmost 
color square in the Palette Editor numbered as 1, the one to the 
right of it numbered as 2, the next one numbered as 3, and so on. 
Change all even-numbered squares to black and change color 

-
-

-

-



Understanding the Tube Rule 

square 1 to some other color. Then randomize the Tube rule and 
watch the hiding states. (You might want to save this palette for 
later use .) 

Hiding 

Keyboard shortcut: (Shift HOD to increase; OD to decrease 

The Hiding parameter sets the number of color-change steps fo r a 
cell to remain in an even-numbered color state. The default is 4. 

• Enter a value between 1 and 127 and press 8. 

Eating 

Keyboard shortcut: (Shift) +CD to increase; CD to decrease 

The value in the Eating parameter controls how many color 
changes a cell makes in the eating state. The default is 3. 

• Enter a value between 2 and 127 and press 8. 

Alarm 

Jazz 

Keyboard shortcut: (Shift) + m to increase; m to decrease 

When a cell looks to see if it's safe to change to the first eating 
color state, it checks the number of neighbors that are out, which 
is stored in the Alarm parameter. If the cell finds that the number 
of neighbors out is greater than or equal to the number in the 
Alarm parameter, it considers it unsafe and does not change to the 
first eating color state. The default alarm number is 3. 

• Enter a value between 0 and 9 and press 8 . 

Keyboard shortcut: Q) 

Turning Jazz on "jazzes" the border where alarm sets in, and you 
see fuzzier shapes. Normally, a cell is alarmed if the number of eat­
ing neighbors is greater than or equal to the number stored in 
Alarm. If Jazz is on, the cell is no longer alarmed by Alarm + 1 
neighbors. The rest of the alarm conditions stay the same. The 
default condition for the Tube rule is Jazz turned off. 

• Select the Off or On button to run the Tube rule with an ex­
tra alarm component. 
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Using the Options Menu 

With the Options menu, you can turn on color options, grid lines, 
fast mode, and screen wrap, and you can set a background for very 
h igh resolution, set a mode for timing changes to parameters and 
options, and load various shapes. 

To select options, left-cl ick the F4 Options button at the upper-left 
corner of the screen, or press @. The Options menu appears: 

Palette: 

Grid lines: 

Fast ftOde: 

Sea t~pe: 
Wrap: 

F1 for HELP ESC to Cancel 

Color Options 

• 
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The following color options are common to five of the CHAOS 
programs. For details on these options, see "Using Color Options" 
on page 214. 

• Color Cycle Once 

• Auto Cycle 
• Palette (Default, Random, Preset, Edit) 

• Monochrome 



Grid Lines 

Fast Mode 

Sea Type 

Using the Options Menu 

Keyboard shortcut: m 
Turning on this option lets you see black lines between cells when 
you zoom in to low and medium resolutions. The default is grid 
lines turned on . 

• Select the Off or On button to turn grid lines off and on for 
low- and medium-resolution zooms. 

Suggestion: Use this option when you want to see color changes 
more closely. 

Keyboard shortcut: CD 

This option tu rns fast mode on and off at low and medium resol u­
tions. With fas t mode turned off, the program calculates color 
changes fo r both off-screen and on-screen cells.With fas t mod 
turned on, the program calculates color changes on ly fo r on­
screen cells. So, if you zoom in with fast mode on, and later zoom 
back out, t he center area of the screen is more evolved than the 
outer area . The defaul t is fa t mod turned off. 

• Select the Off or On button to turn fast mode off or on fo r 
low- and medium-resolution zooms. 

Suggestion: For some rules, zooming in with fast mode on I ts you 
get a BZ-scroll started quickly. The BZ-scroll can then grow 
outward into the less evolved outer areas when you zoom back 
out. 

Keyboard shortcut: m 
Before you zoom out to very high resolution, you can choose a 
blank sea (or black background) that will appear around the small 
cellular automaton, or you can choose a noisy (or randomized) sea. 
The default sea type is blank. 

• Select the Blank or Noisy button to set the background for 
very-h igh-resolution zooms. 
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Wrap 

Changes 

Suggestion: A blank sea works well with Eat and Tube rules; a noisy 
sea works well with Hodge and NLUKY rules. 

Keyboard shortcut: CID 

This option affects whether cells wrap off screen at the top, bot­
tom, and sides of the cellular automaton. Turning screen wrap on 
makes cells wrap around at the sides and top and bottom. Turning 
screen wrap off freezes cells at the current values they have. The 
default is screen wrap turned on. 

• Select the Off or On button to turn screen wrap off and on. 

Keyboard shortcut: (2) 

This option sets whether t he program implements changes you 
make to parameters and options instantly or after one generation. 
If you choose instant changes, the program might show half­
completed screens when you change to different cellular automata 
or different resolutions. If you choose delayed changes, the pro­
gram shows more coherent images but gives slower responses. The 
default is instant changes. 

• Select the Instant or Delayed button to set a mode for tim­
ing changes to parameters and options. 

Suggestion: The distinction between the two sett ings for this 
option is most obvious at very high resolution. 

Load Shape 

Keyboard shortcut: CD 

When you select the Load Shape option, the Shape menu appears: 

Shape: 

Mode: Replace 

Fl for HELP ESC to Cancel 

200 Chapter 7 



Using the Options Menu 

Selecting a Shape 

This program has four shapes you can load into a rule. To load the 
shape you want, select one of the following buttons on the Shape 
menu: 

• Square 
• Diamond 

• Circle 
• Logo (loads the Autodesk logo) 

Selecting a Shape Mode 

When you load a shape, you can select either the replace or overlay 
mode. In the replace mode, the shape you've chosen is substituted 
for the full -screen image of the cellular automaton. In the overlay 
mode, the shape you've chosen is added on top of the full -screen 
image of the cellular automaton. In both modes, cells within the 
shape obey the current cellular automaton rule for color changes. 
Replacing a shape works well for the Hodge and NLUKY rules. 
Overlaying a shape works well for the Eat and Tube rules. To get 
the shape mode you want, select one of the following buttons on 
the Shape menu: 

• Re place 
• Overlay 

The following table summarizes the keyboard shortcuts for over­
laying and replacing each shape: 

Shape Overlay Replace 

Square 
Diamond 
Circle 
Logo 

a!D+CD 
a!D+CI) 
a!D+W 
a!D+0 

a!D+ffi 
a!D+0 
a!D+0 
a!D+® 
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Saving and Loading Files 

Use the options on the File menu to save and reload parameter files 
and .giffiles. For details on saving and reloading files, see "Saving 
and Loading Files" on page 209. 

The Mathematics of the Program 
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Most cellular autom ata (CAs) seem to meet one of four fates: they 
die out, they start repeating t hemselves, t hey t urn into st ructure­
less seething, or t hey break up into gliders that bounce off each 
other forever. But there is a fifth option: the BZ-scroll CA reaction. 

In the two-dimensional BZ-scroll CAs, the scrolls organize them­
selves from seeds found at random in the starting pattern. Existing 
scrolls spin off small child-scrolls that resemble small vortices 
spawned by large vortices. The boundaries between competing 
scrolls' terrains are flu id and under constant revision. 

In the Toy Universes program, we show four different famil ies of 
BZ-scroll rules: NLUKY, Hodge, Eat, and Tube. The NLUKY rules 
are Rudy Rucker's discovery; the Hodge rules were discovered by 
Martin Gerhardt and Heike Schuster; the Eat rules come from 
David Griffeath and Bob Fisch; and the Tube ru les come from Nor­
man Margolus and Tommaso Toffo li. 

All the CAs to be discussed use a two-d imensional grid of squares. 
The resolution of our grid can be set to very high: 480 by 344, high : 
240 by 172, medium: 120 by 86, or low: 60 by 43. Given an arbi­
t ra ry cell, let C be the positive integer representing the cell's state, 
and let the new value of the cell that the CA rule calculates be 
calied NewC. 

With the exception of the Eat rules, in the ru les to be discussed 
NewC depends on two th ings: the cell's value C and the value of 
the sum of the cell's neighbors. Rules of this sort are called "semi­
totalistic" by CA theorist Stephen Wolfram . 

As is customary, we think of the cell as having eight neighbors: the 
northwest, north, northeast, west, east, southwest, south , and 
southeast neighbors. We will be interested in two different ways of 
summing up a cell's neighbors' values to get numbers called the 
FullEightSum and the FiringEightSum . 

-
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The FuliEightSum is simply t he sum of the eight neighbor states. 
If the highest usable state is, say, N, t hen the FuliEightSum will be 
a number between 0 and 8*N. We also define the FullEightAverage 
as FuIlEightSum/8. 

The idea in forming the FiringEightSum is that a cell' s state can be 
thought of as a bin ary number, and we can give special signifi­
cance to certain bit positions. The FiringEightSum focuses on each 
state 's lowest b it. If a neigh bor cell 's low bit is I , it cont ributes 1 to 
th e FiringEightSum, otherwise it contributes O. The FiringEight­
Sum, in other words, is the sum of the lowest bits of the eight 
neighbor states. Put d ifferently, the FiringEightSum counts the 
number of odd-state neighbors that the cell has. The Fi ringEight­
Sum will always be a number between 0 and 8. 

Hodge Rule 

The Hodge rules are formulated.in terms of two positive integer 
parameters: N and I. N can be arbitrarily large, and I should be less 
than N. Typically a value of I approximately equal to N/6 works 
well. The rule is specified in term s of the FuliEightAverage 
(= FuliEightSum/8). 

1) The cells have N+ 1 possible states: O,I,2, ... N. 

2) If C = 0 and FullEightAverage = 0 then NewC = O. 
If C = 0 and 0 < FullEightAverage ~ I then NewC = [1 /2] + 1. 
If C = 0 and 1< FullEightAverage ~ 2*1 then NewC = 1. 
If C = 0 and 2*1 < FullEightAverage then NewC = [1/2] + 1. 

3) If 0 < C < N and then NewC = FuliEightAverage + I, 
un less (FullEightAverage + I) > N, in which case NewC = N. 

4) If C = N then NewC = O. 

The details o f part (2) of the defini tion are un importan t; many dif­
ferent ways of passing from state 0 to a nonzero state seem to work 
just as well. [1/2] means lithe greatest integer less than or eq ual to 
1/2." Note that the Hodge rules are closely related to the simple 
Rug rule in which NewC = (FullEigh tAverage + I) MOD N. The cru­
cial difference between Hodge and Rug is that wh en a Hodge cell 
value gets larger than N, it is set back to N, and then in the next 
cycle to 0, whereas in a Rug rule a cell value larger than N is 
wrapped around to the amoun t by which N is exceeded. No dou­
ble-scrolls ever arise in Rug rules. 
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Eat Rule 

The Eat rules are formu lated in terms of a single integer parameter 
N, wh ich our menu calls MaxEat. N can be arbitrarily large. There 
are two kinds of Eat rules, the deterministic and nondeterministic. 
The nondeterministic version requires the use of a randomizer to 
repeatedly select one of a cell 's neighbors. 

1) The cells have N possible states: O, I ,2, ... ,N- 1. 

2) Deterministic If any of the cell's neighbors has state 
(C + 1) MOD N, then NewC = (C + 1) MOD N. Otherwise 
NewC = C. 

or 
NonDeterministic If the cell's randomly selected neighbor 
has state (C + 1) MOD N, then NewC = (C + 1) MOD N. 
Otherwise NewC = C. 

The deterministic Eat rules quickly converge to tight, small spirals 
that are somewhat monotonous to look at. The nondeterministic 
ru les are more exciting, although the higher the N value, the larger 
will be the size of the cell grid required for the rule to get started 
from a uniform random initial condition. With the high resolu­
tion grid of 240 by 172, a value of N = 12 is about the largest for 
which action spontaneously develops . One can, however, force 
action out of a rule with a large N value in various ways. One trick 
is to randomize the screen and then set a disk or patch of cells to 
some single state. You can do this by pressing (]]D + CD to overlay 
a square or (]]D + CIl to overlay a diamond. Alternately, one can 
randomize the screen in high resolution mode, then zoom out to 
very high resolution in the blank sea mode, and see the scrolls 
grow out of the central spot. 

NLUKY Rule 
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An NLUKY rule is specified by five positive integer parameters: 
N,L,U,K, and Y. N can be arbitrarily large; the other numbers can 
range from 0 to 9. (Actually, these numbers could range from 0 to 
8; the value 9 is simply used as a signal that a certain possibility is 
being excluded.) The rule is specified as follows: 
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1) The cells have N+2 possible states: 0, I, and the N even 
numbers 2,4,6, ... ,2N. 

2) Case a) In the case where L $ U: 
If C == 0 and L $ FiringEightSum $U then NewC == l. 
If C == 0 and not(L $ FiringEightSum $U) then NewC == O. 

Case b) In the case where L> U: 
If C == 0 and L $FiringEightSum OR FiringEightSum $U 

then NewC == 1. 
If C == 0 and U < FiringEightSum < L then NewC == O. 

3) Case a) In the case where K $Y: 
If C == 1 and K $ FiringEightSum$ Y then NewC == l. 
If C == 1 and not(K $ FiringEightSum $ Y) then NewC == 2. 

Case b) In the case where K> Y: 
If C == 0 and K $ FiringEightSum OR FiringEightSum $ Y 

then NewC == l. 
If C == 0 and Y < FiringEightSum < K then NewC == O. 

4) If 2 $C < 2N then NewC == C + 2. 

5) If C == 2N then NewC == O. 

The state 0 is called the dead state, state I, the firing state, and 
states 2,4,6, ... ,2N are called the refractory states. The well-known 
Game of Life rule is the NLUKY rule 03323. Brian Silverman's Brain 
rule is the NLUKY rule 12299. Rudy Rucker invented the NLUKY 
categorization to find a common setting for these two rules. (See 
the CA Lab manual for a detailed discussion of these rules.) 

Life, on the one hand, seems to gain much of its power from the 
fact that a firing cell can sometimes keep firing. Brain, on the other 
hand, gets its richness from the fact that it has a refractory or rest­
ing state. Arbitrary NLUKY rules can have both these features. 

It was surprising that many of the NLUKY rules are in fact BZ-scroll 
rules. The simplest example is NLUKY rule 72322,called RainZha. 
In practice, it seems that almost any rule of the form N2U2Y pro­
duces a BZ-scroll pattern, so long as U is greater than 3. 

The NLUKY rule N2222 (called Faders) is not a BZ-scroll pattern, 
but what it does is unique: the pattern grows firing gliders, which 
come in either a right-handed or a left-handed form. As a right­
handed glider moves along, it shoots right-handed gliders out to 
its right, cumulatively leading to fractal patterns that attempt to 
become spiral, as the "children" right-handed gliders send out 
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Tube Rule 

206 Chapter 7 

"grandchildren" right-handed gliders, and so on. Spirals fail to 
develop because a glider's great-grandchildren run into its trail. 

The Tube rules are specified in terms of four positive integer 
parameters: E, 0 , A, and Jazz. E is the number of even (hiding) 
states, 0 is the number of odd (eating) states, and A specifies a 
th reshold value. We require that 0 22 and E 21. Jazz is either 0 or 
1. The rules are formulated in terms of a boolean SafeCondition : 

SafeCondit ion H 

(FiringEightSum < A) or (Oazz=1) and 
FiringEightSum = A+1) . 

The tube ru les can now be specified as fo llows: 

1) The cells have O+E possible states: 1,3, .. . ,(2*0)- 1 and 
O, 2,4, ... ,2*E. 

2) If C = 1 and SafeCondition then NewC=1. 
If C = 1 and not(SafeCondit ion) then NewC = 3. 

3) If C is odd and 1<C«2*0)-1 th en NewC = C + 2. 

4) If C = (2*0 )-1 then NewC = O. 

5) If C is even and O:S;C < 2'~E then NewC = C+2. 

6) If C = 2*E and SafeCondition then NewC = 1. 
If C = 2*E and not(SafeCondition) NewC = 3. 

Margolus and Toffoli discuss three variations on this rule. The first 
two variations take Jazz to be 0 and set EOA to 432 and 433. Their 
third variation takes EOA to be 433, but changes Jazz to 1. The first 
of the three reactions converges rapidly to small, square spirals; the 
second converges more slowly to rounded, octagonal spirals; and 
the th ird rule makes very n icely rounded, fuzzy spirals. In general, 
if E is either 0 + 1 or 0 +2, and A is 2 or 3 and these rules will pro­
duce BZ-scroU patterns. 
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General Comments 

The main th ing that all these rules have in common is 1) the exist­
ence of a cyclic sequence of states that the cells can move through, 
and 2) a mechanism that can tend to bring the states of nearby 
cells into synchronization. The sources of synchronization are as 
follows : 

In the NLUKY rules, a firing cell urges neighboring cells to fire. In 
the Hodge rule, cell states sit and wait for their fellows for one 
cycle each time they shoot past the maximum value. In the Eat 
rules, certain values get copied into their neighbors. And in the 
Tube rules, a state 1 cell can wait until more than A of its neighbors 
enter odd states. 

Why do the BZ-scroll rules form double scrolls? A double scroll is 
really a line segment that is radiating a stimulation out of one of 
the line's sides. The stimulation is more intense at the line's inte­
rior points, so the central part of the scroll emanates there. At the 
line's ends, the stimulation falls off, so the stimulation dies down 
and gets rounded off in a spiral. 
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Chapter 8 

Saving Files and 
U sing Color Options 

This chapter documents featu res common to all or most CHAOS 
programs. The features described here are 

• Saving and Loading Files 

• Using Color Options 

Saving and Loading Files 

Most CHAOS programs have a File menu that lists options for sav­
ing and loading files . 

To display the File menu 

• Left-cl ick the F2 File button or press Cill. 

The File menu in each CHAOS program includes some or all of the 
File options described in the sections that follow. 

Using File Menu Dialogue Boxes 

All Fil menu options use dialogue boxes like this one. 

list box drive buttons 
I 

Wildcard: 

.. 
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Existing files with the extension appropriate for the current file 
type and program appear in the list box at the left. The Wildcard 
field shows the default extension used for the list box. For exam­
ple, if you're saving a GIF fil e, *.gif appears in the Wildcard fie ld 
and on ly files with the extension .gi{are listed in the box at the 
left. The Dir field shows the cll rren t d irectory. The Fil ename field 
is active and ready to accept your entry. 

Working with a Mouse 

With a mOllse, you can do the foll owing in a File menu dia logue 
box: 

• Scroll through the parameter files displayed in the list box 
at the left. 

• Left-click on an existing fi lename in the list box to move 
that name to the Filename field. 

• Double-click on a file name in the list box to immediately 
complete the save o r load operation . 

• Left-click on a directory button to change to that directory. 

• Left-click in the Di r fi ld to enter a new path. 

• Left-click Fl for HELP to display the help window fo r this 
d ialogue box. 

• Left-click ESC to Cancel to cancel your entries and exit the 
dialogue box. 

• Left-click OK or press 8 to confi rm your entries and exit 
the dialogue box. 

Working with the Keyboard 
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Using the keyboard, you can do the following in a File menu dia­
logue box: 

• Press ffi or ~ to scroll down through the parameter 
files displayed in the list box on the left, or press (f) or 
~ to scroll up . 

• Enter a name in the Filename field and press 8. 
• Press (Tab) to move from the Filename, Dir, Wildcard, and 

Filename Fields. 

• Press CID to display the help window for this dialogue box. 

• Press ffi0 to cancel your entries and exit the dialogue box. 

• Press 8 to complete the save or load operation and exit 
the dialogue box. 
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Saving Parameters 

Keyboard shortcut: @ + CD 

In each CHAOS program, you can save an image as a set of param­
eters. The advantage of saving parameters is that the parameter file 
is small and saves disk space. You can store about one hundred 
parameter files in the space that one GIF file uses. Also, when you 
load a parameter file, you can work with that file in the current 
program. When you load a GIF file, you cannot modify the file or 
use the program menus or options. 

When loading a parameter file, the program recomputes the image 
from scratch, which can take substantially longer than loading a 
GIF file. 

The parameter files for each CHAOS program have different exten­
sions . For example, Fractal Forgeries parameter files have the 
extension .for, and Chaos Game parameters have the extension .ifs 
(for Iterated Function System). This table shows the programs and 
their corresponding parameter file extensions: 

Program Name Parameter File Extension 

The Mandelbrot Sets .frp 
Magnets and Pendulum .mfg 

Strange Att ractors .sap 

The Chaos Game .ifs 

Fractal Forgeries .for 
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To choose the Save Parameters option, follow these steps: 

1. Select the F2 File menu button. 
2. Select Save Parameters on the File menu. The Save 

Parameters dialogue box appears. Existing parameter files 
with the extension appropriate for the current program ap­
pear in the list box at the left. The Wildcard fie ld shows the 
default extension the program uses to save parameters in 
the current program. 

To save the parameters with a new filename, follow these steps: 

1. Enter a name for the parameter file and press 8. (You 
don't have to add an extension. The program adds the ex­
tension displayed in the Wildcard field.) 
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2. Left-click the OK button or press B to save the file with 
the new name and exit the dialogue box. 

To save parameters to an existing file, follow these steps: 

1. Scroll through the parameter files displayed in the list box 
at the left . 

2. Left-click on the existing parameter filename in the list 
box to move that name to the Filename field, or enter the 
name in the Filename fie ld . 

3. Left-click the OK button or press B to save the parameters 
to the existing file and exit the dia logue box. 

Loading Parameters 

Keyboard shortcut: aiD + m 
To load a parameter file, follow these steps: 

1. Select the F2 File menu button. 
2. Select Load Parameters from the File menu. A dialogue box 

appears listing the available parameter files for the current 
program. 

3. Scroll through the parameter files displayed in the list box 
at the left. 

4. Left-click on the parameter filename in the list box to 
move that name to the Filename field, or enter the name 
in the Filename fie ld. 

S. Left-click the OK button or press B to exit the dialogue 
box and load the parameters. 

Note: Each CHAOS program has several sample parameter files 
that you can load to see additional examples of images or layouts. 
The parameter files for each CHAOS program are saved with an 
extension unique to each program. For a list of the parameter file 
extensions, see "Saving Parameters" on page 211. 

Saving an Image or the Screen as a GIF File 
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Keyboard shortcut: aiD+(]J save image; aiD+CHJ save screen 

You can save any CHAOS image as a GIF file. GIF files are large 
(they take up about 30K each) but they load quickly. GIF files are 
a common graphic file format compatible with many software 

-
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programs. You can also bring a GIF file to a graphics service com­
pany and have them make a slide or poster out of it. 

In many CHAOS programs, you can save a GIF file of the image 
area, or of the entire screen. 

To save the entire screen as a GIF file, follow these steps: 

1. Select the F2 File menu button. 
2. Select Save screen as GIF from the File menu. A dialogue 

box appears. 
3. Enter a filename and press 8. (You don't have to enter the 

.gir extension.) 
4. Left-click the OK button or press 8 to save the screen with 

the new filename. 

To save only the image area as a GIF file, follow these steps: 

1. Select the F2 File menu button. 

2. Select Save image as GIF from the File menu. A dialogue box 
appears. 

3. Enter a filename and press 8. (You don't have to enter the 
.gir extension.) 

4. Left-click the OK button or press 8 to save the image with 
the new filename. 

Viewing a GIF Image 

.. 

Keyboard shortcut: aiD + CD 

To view a GIF file, follow these steps: 

1. Select the F2 File menu button. 

2. Select View GIF image from the File menu. A dialogue box 
appears listing the available GIF files. 

3. Scroll through the GIF files displayed in the list box at the 
left. 

4. Left-click on a filename in the list box to move that name 
to the Filename field, or enter the name in the Filename 
field. 

s. Left-click the OK button or press 8 to exit the dialogue 
box to display the GIF image on the screen . 
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When you view a GIF file, you cannot modify the file or use the 
program menus or options. When you've finished viewing the GIF 

-
file, follow these steps to rehlrn to the program: -

1. Press any key to return to the View GIF image dialogue 
box. 

2. Press ffiD to return to the program. 

Using Color Options 

The following olor options are common to most CHAOS pro­
grams and appear on the Options menu. 

Color Cycle Once 

Keyboard shortcut: CID +QJ cycle forward; CID + IT) cycle reverse 

The Color Cycle Once option lets you change the colors in the 
image one step at a time in a forward or reverse direction. 

To change colors one step at a time, select one of the following 
buttons next to the Color Cycle Once option: 

• Forward 

• Reverse 

Auto Cycle 

214 Chapter 8 

Keyboard shortcut: CID +GJ change to forward, reverse, none 

The Auto Cycle option spins the colors continuously in a forward 
or reverse direction. The default setting is color cycle turned off. 

To cycle continuously through colors, select one of the following 
buttons next to the Auto Cycle option: 

• Forward 

• Reverse 

To turn off Auto Cycle, do one of the following: 

• Select the None button next to the Auto Cycle option. 

• Press CID +GJ until Auto Cycle is off. 

-

-



Palette 

Using Color Options 

The Palette option gives you several ways to use different sets of 
colors for CHAOS images. 

To change the palette, select one of the following buttons next to 
the Palette option: 

• Default 

• Random 
• Preset 

• Edit 

Each palette option is described in the following sections. 

Default Palette 

Keyboard shortcut: @ + m 
The Default palette option resets the default display colors or the 
palette saved in the .pal file for the current program. (For more 
information about the .pal file, see "Changing the Default Palette" 
on page 218.) 

Random Palette 

Keyboard shortcut: @ + m 
The Random Palette option sets random display colors. 

Preset Palettes 

Keyboard shortcut: @+0 

The Preset Palettes option lets you cycle through the preset pal­
ettes of display colors for the current program. 

Edit Palette 

Keyboard shortcut: @+CD 

In addition to letting you select random or preset palettes, CHAOS 
lets you create your own palette of 16 colors. CHAOS uses the pal­
ette for the image and other screen elements. Use the Palette Editor 
to edit palettes and to save and reload them. 
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To use the palette editor, foll ow these steps: 

1. Select the Options (or Opts) menu button to display the 
Options menu. 

2. Select the Edit button next to the Palette option. The 
Palette Editor appears: 

Current colors -{ 

RCB sliders -{ 

216 Chapter 8 

I. , S to Saue 

ESC to Cancel 

To change the colors in the palette, fo llow these steps: 

1. Move the highlight box to the color you want to change 
by doing one of the following: 

• Left-click on the color. 
• Press m or (1) to move to the row of colors. Press 

8) or CB to move to the color you want to change. 
Then press B. 

2. Move the RGB Slider to the value you want by doing one 
of the following: 

• Point to a new location on a slider bar and I ft­
cl ick. 

• Press m to move down to the next slider bar or 
press (1) to move to the previous slider bar. At the 
slider bar you want to change, press 8) or CB to 
adjust the slider bar to the color-mix you want. 

The h ighlighted color changes as you adjust each slider 
bar. You can also see the effect on the program screen. 

3. Repeat steps 1 and 2 fo r each color you want to change in 
the palette. 

4. Select the ACCEPT button to accept the changes and return 
to the Options menu. 



Using Color Options 

Note: To cancel ail changes, select the ESC to Cancel but­
ton, or right-click, or press ~. 

S. Select the ESC to Cancel button, or right-click, or press ~ 
to exit the Options menu. 

Saving and Loading a Color Palette 

When you change a color palette, the new palette exists in mem­
ory and won't be available after you quit the program unless you 
save the palette. You can save any nu mber of palettes to unique 
files that have the extension .pal. Then you can load t he palette at 
any time. 

Note: For additional information on using save and load dialogue 
boxes, see "Using File Menu Dialogue Boxes" on page 209. 

To save a palette, follow these steps: 

1. Select the Edit button next to the Palette option on the 
Options menu . The Palette Editor appears. 

2. Press IT) or left-cl ick the S to Save button . The Save Palette 
dialogue box appears. 

3. Enter the name of the palette file you want to save and 
press 8. (You don't have to enter the .pal extension.) 

4. Left-click OK or press 8 to save the palette with the new 
name. 

To load a palette, follow these steps: 

1. Select the Edit button next to the Palette opt ion on the 
Options men u. The Palette Editor appears. 

2. Press CD or left-cl ick the L to Load button . The Load Pa l­
ette dialogue box appears listing the available palette files. 

3. Scroll through the palette files displayed in the list box at 
the left . 

4. Left-click on a palette filename in the list box to move that 
name to the Filename fi eld, or enter the name in the File­
name field. 

S. Left-click the OK button or press 8 to exit the dialogue 
box and load the palette. 
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Changing the Default Palette 

Each CHAOS program (except Fractal Forgeries) has at least one 
defaul t palette. Toy Universes has four default palettes. You can 
change the default palette in any program by editing a palette and 
saving it to the default palette filename. The default palette fil ena­
mes for the CHAOS programs are: 

Program Name Default Palette Filename(s) 

Mandelbrot Sets mandel.pal 

Magnets and Pendulum magnets.pal 

Strange Attractors a ttract.pa I 

The Chaos Game game.pal 

Toy Universes hodge.pal 

eat.pal 

nluky.pal 

tube.pal 

Suggestion: Before you change a default palette, you might want 
to save the original default palette file to another name such as 
mandel1.pal. That way, you can always rename that file to the 
original default palette filename for the program. 

To change the default palette, follow these steps: 

1. Select the Edit button next to the Palette option on the 
Options menu. The Palette Ed itor appears. 

2. Change the palette as described in "Edit Palette" on page 
215. 

3. Press (Dor left-click the S to Save button. Th Save Palette 
dialogue box appears. 

4. Enter the default palette name of the CHAOS program 
you're using. 

S. Left-click OK or press B to save the palette as the default 
palette. -

-
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Monochrome 

Keyboard shortcut: alD + (}D 

If you have a VGA monitor, the Monoch rome option lets you 
change the screen color to black and white (or another two-color 
combination if you've edited your color palette) and then back to 
multiple colors. The default setting is Monochrome turned off. 

• To toggle between monochrome and multiple colors, se-
lect the On or Off button n xt to the Monochrome option. 

Suggestion: You might want to use a monochrome black and white 
setting when you save a .gifi mage that you want to print. The 
printed black and white image might be crisper than a color one. 

Extending the Color Palette 

Keyboard shortcut: alD+CD to toggle on and off 

The default sett ing for all CHAOS programs (except Toy Universes) 
reserves five colors for the program menus and buttons. These 
reserved colors ensure that menus and buttons remain readable 
when you randomize the palette or use color cycling. However, 
these reserved colors are not available fo r CHAOS images. 

You can "unlock" the reserved menu colors to extend the palette 
of colors available for CHAOS images. If you unlock these colors, 
you might find that menus and buttons are difficult to read in 
some palettes. You might wa nt to wait until you're familiar with a 
program (and its keyboard shortcuts) before you experiment with 
extending the color palette. 

• Press alD + CD to extend the palette. 

After you extend the palette, images can use all available colors 
ex ept black, which is reserved for the background. You'll notice a 
change when you use color cycling options or when you random­
ize the palette. Extending the palette in The Mandelbrot Sets pro­
gram produces the most dramatic change in the images. 

• Press alD+CD again to return to reserved menu colors. 

Suggestion: If you're not sure if palette extending is on or off, press 
alD+([) to randomize the palette. If the menu buttons change 
colors, then palette extending is on . To quickly return to the 
default palette (with readable menus), press alD+®. 
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The Genesis of James Gleick's 
CHAOS: The Software 

I met James Gleick in Septem ber, 1987, at the fi rst-ever workshop 
on Artificial Life, held in Los Alamos. He was covering the confer­
ence for the New York Times, and I was there as both a San Jose 
State Universi ty mathematics professor interested in cellular 
automata and the author of two cyberpunk science-fiction novels 
about in telligent robots. 

Chaos: Making A New Science was published the next month . I hap­
pened to be assigned t he job of reviewing it for the Washington 
Post Book World. I en joyed the book very much; I found that it 
made a lot of frighteningly abstruse concepts understandable. Like 
many people, I'd been wan ting to start th inking about chaos, and 
this popularly written book gave us the courage to t ry. Presciently 
enough, my review said, "Chaos could well prove to be something 
of a scien tific best-seller. /I 

A year later I was working for Autodesk, Inc., helping develop a 
software package tha t would be called CA Lab: Rudy Rucker's Cel­
lular Automata Laborato ry. James Gleick phoned Autodesk with a 
proposal for a software package illustrati ng some of the chaotic 
processes described in his book. To my delight, Autodesk agreed. If 
all goes well, CA Lab and CHAOS: The Software may be Autodesk's 
first two products in an ongo ing Science Series . 

James Gleick and I met near Disneyland in the spring of 1989 to 
discuss the kinds of programs we wou ld put in, and then I spent 
most of the next year writing C and Assembly Language code fo r 
five of the programs: The Mandelbrot Sets, Magnets and Pendu­
lu m, Toy Universes, The Chaos Game, and Strange Attractors. 
John Walker supplied the code fo r the Fracta l Forgeries program. 
Starting late in 1989, Josh ua Gordon began putting interfaces onto 
the programs and, where necessary, reworking the code, some­
t imes quite extenSively. Throughout 1990, Chaos the Software 
continued to evolve, with Josh and I spa ring no effort to make 
everything excellent, often guided by Ja mes Gleick's many valu­
able suggestions. 
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Introducing Rudy Rucker 

The present manual is a hybrid work. james Gleick wrote the 
beginning of the chapters, and I wrote the mathematics sections at 
the chapter ends, with Autodesk technical writers creating the sec­
t ions that lie between . Many other people at Autodesk helped on 
this pro ject as well. 

Being involved in such a complex software development project 
has been an amazing experience fo r me. One after another of our 
chaotic simulations has come to life and become fu lly interactive, 
and each one has in turn taken over my consciousness for weeks 
at a time. One month everything looked like a cubic julia set, the 
next month everyth ing was a Barnsley fractal, after that music 
began sounding like Henon attractors, then mountains became 
Fourier synthesized, and this month political t rends look li ke the 
oscillations of a pendulum in a field of random magnet. After 
thousands of hours wi th our CHAOS programs, I st ill keep discov­
ering new things. 

I'm happy to have helped make these wonderful mathematical 
forms easier to play with . Have fun! 

Rudy Rucker 
November 14, 1990 

Introducing Rudy Rucker 

Rudy Rucker was born March 22, 1946 in Louisville, Kentucky. He 
graduated from Swarthmore College and received a Ph.D. in Math­
ematics from Rutgers University. Rucker is best known for his pop­
ular books on mathematics and for h is science fiction novels, 
including Software and Wetware, each of which won the Philip K. 
Dick Award. Rucker is Mathenaut in the Advanced Technology 
department of Autodesk Inc. and a professor of Mathematics and 
Computer Science at San jose State University. Rucker recently 
published his thi rteenth book, The H ollow Earth, a science-fiction 
adventure novel that starts in 1836 and features Edgar Allan Poe. 
Rucker lives in Los Gatos, Cali fo rnia, with h is wife Sylvia and their 
three college-age children. 

222 The Genesis of James G/eick 's CHAOS: The Software 



Bibliography 

Abbott, Edwin. 1884. Flatland: A Romance of Many Dimen ions. 

Abraham, Ralph. 1982-1988. Dynamics (Vol. 1-4), Santa Cruz: 
Aerial Press. 

Barnsley, Michael F. 1988. Fractals Everywhere. San Diego: Aca­
demic Press. 

Branner, Bodil, and Hubbard, John. 1988. The iteration of cubic 
po lynomials. Part I: The global topology of parameter space. 
Acta Mathematica 160, pp. 143-206. 

Carpenter, Loren . 1984. Cited in Mandelbrot, Benoit, et. al. Addi­
tional Perspect ives on Fractals. The College Mathematics Journal, 
March, pp. 115-119. 

Crutchfie ld, James; Farmer, Doyne; Packard, Norman; and Shaw, 
Robert. 1986. Chaos. Scientific American, December, pp. 46-5 7. 

Devaney, Robert. 1989. An Introduction to Chaotic Dynamical Sys­
tems. Menlo Park: Addison-Wesley. 

Dewdney, A. K. 1987. Computer Recrea tions: Probing the Strange 
Attractors of Chaos. Scientific American, July, pp. 108-11I. 

Dewdney, A. K. 1988. The Armchair Universe. New York: W.H.Free­
man & Company. 

Dewdney, A. K. 1988. Computer Recreations: The hodgepodge 
machine makes waves. Scientific American, August, pp. 104-
107. 

Dewdney, A. K. 1988. Beauty and Profundity: The Mandelbrot Set 
and a Flock of Its Cousins Called Julia. Scientific American, 
November, p. 140. 

Dewdney, A. K. 1989. Computer R creations: A cellular universe of 
debris, droplets, defects and demons . Scientific American, 
Augu t, pp. 102- 105. 

Dewdney, A. K. 1990. The Magic Machine: A Handbook of Computer 
.. Sorcery. New York: W.H.Freeman & Company. 

223 



224 Bibliography 

Dewdney, A. K. 1990. Mathematical Recreations: How to trans­
form fl ights of fancy into fracta l flora and fauna. Scientific 
American, May, pp. 126-129. 

Douady, Adrian, and Hubbard, john. 1985. On the Dynamics of 
Polynomial-like Mappings. Annales Scientifique de l'Ecole Nor­
male Superieur 18:287 . 

Feigenbaum, Mitchell j. 1978. Quantitative Universality of a Class 
of Non linear Transformations. Journal of Statistical Physics 
19:25. 

Feigenbaum, Mitchell j . 1980. Universal Behavior in Nonlinear 
Systems. Los Alamos Science, Summer, p. 4. 

Gerhardt, Martin; Schuster, Heike; and Tyson, john. 1990. A Cel­
lular Automaton Model of Excitable Media Including Curva­
ture and Dispersion. Science 247, March 30, pp. 1563-1566. 

Gleick, james. 1987. Chaos: Making a New Science. New York: 
Viking. 

Grebogi, Celso; Ott, Edward; and Yorke, james. 1985. Attractors on 
an N-Torus: Quasiperiodicity Versus Chaos. Physica 150, pp. 
354-373. 

Grebogi, Celso; Ott, Edward; and Yorke, james. 1987. Chaos, 
Strange Attractors, and Fractal Basin Boundaries in Nonlinear 
Dynamics. Science, Vol. 238, October 30, pp. 632-638. 

Griffeath, David. 1988. Cycl ic Random Competition. Notices of the 
American Mathematical Society 35, pp. 1472-1480. 

Henon, Michel, and Heil , C. 1964. The Applicability of the Th ird 
Integral of the Motion: Some Numerical Experiments. Astro­
nomical lollrnaI69:73. 

Henon, Michel. 1976. A Two-Dimensional Mapping with a Strange 
Attractor. Communications in Mathematical Physics,50:69. 

Hofstadter, Douglas. 1985. Metamagical Themas: Questing for the 
Essence of Mind and Pattern. New York: Basic Books. 

jurgens, Hartmut; Pietgen, Heinz-Otto; and Saupe, Dietmar. 1990. 
The Language of Fractals. Scientific American, August, pp. 60-
67. 

Li, T.-Y., and Yorke, james. Period Three Implies Chaos. American 
Mathematical Monthly 82:985. 

Lorenz, Edward N. 1963. Deterministic Nonperiodic Flow. Journal 
of the Atmospheric Sciences 20:130. 

-

-

-
--
--
--



Mandelbrot, Benoit. 1982. The Fractal Geometry of Nature. San Fran­
cisco: W. H. Freeman. 

Margolus, Norman, and Toffolli, Tommaso. 1987. Cellular Autom­
aton Machines. Cambridge: MIT Press. 

May, Robert. 1976. Sim ple Mathematical Models with Very Com­
plicated Dynamics. Nature 261:459. 

Moon, Francis. 1987. Chaotic Vibrations. New York: John Wiley & 
Sons. 

Peitgen, Heinz-Otto, and Richter, Peter. 1986. The Beauty of Frac­
tals: Images of Complex Dynamical Sy tems. New York: Springer­
Verlag. 

Peitgen, Heinz-Otto, and Saupe, Dietmar. 1988. The Science of Frac­
tal [mages. New York: Springer-Verlag. 

Pickover, Clifford. 1980. Computers, Patterns, Chaos and Beauty: 
Graphics from an Unseen World. New York: St. Martin's Press. 

Press, Will iam; Flannery, Brian; Teukilsky, Saul; and Vettering, 
William. Numerical Recipes in C: The Art of Scientific Computing. 
Cambridge: Cambridge University Press. 

Rucker, Rudy. 1984. The Fourth Dimension: Toward a Geometry of 
Higher Reality. Boston: Houghton Miffl in. 

Rucker, Rudy. 1987. Mind Tools: The Five Levels of Mathematical 
Reality. Boston: Houghton Mifflin. 

Rucker, Rudy. 1987. Patterns of Disorder (Book review of James 
Gleick's Chaos: Making a New Science). Washington Post Book 
World. November I , p.3 and p.8. 

Rucker, Rudy, and Walker, John . 1989. CA Lab: Rudy Rucker'S Cel­
lular Automaton Laboratory. Sausalito, CA: Autodesk, Inc. 

Ruelle, David, and Takens, Floris. 1971. On the Nature of Turbu­
lence. Communications in Mathematical PhYSics 20: 167. 

Thompson, J. M. T., and Stewart, H. B. 1986. Nonlinear Dynamics 
and Chaos. New York: John Wiley and Sons. 

Voss, Richard F. 1985. Random Fractal Forgeries, in Earnshaw et. 
a!. Fundamental Algorithms for Computer Graphics. Berlin: 
Spri nger-Verlag. 

Winfree, Arthur. 1974. Rotat ing Ch mical Reactions. Scientific 
American, June, pp. 82-95. 

Bibliography 225 



.. 
226 Bibliography 

Wolfram, Stephen . 1986. Theory and Applications of Cellular Autom­
ata . Singapore: World Scientific. 

-

-
-
-



A 

A parameter, 34, 36 
Abbott, Edwin, 145 
Accept button, 16 
Accuracy parameter 

Logistic Map, 106 
Lorenz, 96 

Add Map bu tton, 136 
Affine maps, 143 
Airplanes, 94 
Alarm 

definition in Tube rule, 195 
parameter, 197 

Alt-X to Exit button, 16 
Angles display mode, 1 32 
Animation 

creating, 168 
files, 169 
parameters, 157 
viewing, 1 70 

Attraction See Basins of attraction 
Attractors 

examining in steps, 93 
exploring, 88 
Henon, 83 

adding and removing points, 90 
description, 101 
mathematics, 116 
select cu rsor, using, 90 
tweaking, 102 

Henon Horseshoe, 83 
adding and removing points, 90 
description, 103 

Index 

select cursor, using, 90 
tweaking, 104 

Logistic Hump, 86 
changing initial value of point, 91 
description, 110 
mathematics, 119 
select curso r, using, 91 
tweaking, 111 

Logistic Map, 86 
description, 105 
mathematics, 118 
select cursor, using, 91 
tweaking, 106 

Logistic Pulse, 86 
changing init ial value of point, 91 
description, 107 
mathematics, 11 9 
select cursor, using, 91 
tweaking, 109 

Lorenz, 82 
adding and removing 

airplanes, 90 
description, 94 
mathematics, 115 
select cursor, using, 90 
tweaking, 95 

selecting, 94 
steps, 93 
strange, 81 
Yorke, 83 

adding and removing points, 90 
description, 97 
mathematics, 11 7 
randomizing, 101 
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Attractors 
Yorke (continued) 

resetting, 101 
select cursor, using, 90 
tweaking, 98 

Auto Cycle option, 214 
Average coloring type, 147 
Azimuth option, 164 

B 

B parameter, 34, 36 
Bandwidth option, 38 
Barnsley, Michael, 121 
Basins of attraction, 49, 56, 69 
Batch files, 8, 9 
Beluzov, B. P., 177 
Bifurcation, 86, 105, 108 
Bi linear maps, 143 
Blank fill type, 34 
Blinkers, Life vers ion of NLUKY rule, 191 
Blocks, Life version of NLUKY rule, 191 
Bob 

capturing, 58 
erasing trails, 60 
pushing, 58 
starting, 58 
trace types, 73 

Bullseye fill type, 34,47 
Butterflies, Brain version of NLUKY 

ru le, 192 
Butterfly Effect, 82 
Buttons, selecting, 9 
BZ 

reaction, 1 77 
scrolls, 178, 183, 187 

c 
Cancel button, 16 
Captu re radius (Cap) parameter, 64 
CCM,See Cubic Connectedness Map 
Cellu lar automata, 1 78, 180 

cell neighbors, 183 
characteristics, 183 
description, 182 

228 Index 

Eat, 188 
growth in steps, 182 
Hodge, 184 
NLUKY, 190 
Tube, 195 

Center pull force, 65 
Centering 

Chaos Game, 128 
Mandelbrot Sets, 28 
Strange Attractors, 92 

Changes option, 200 
Chaos Game, defined, 121 
CHAOS Main menu, 8 
Chaoticity parameter 

and population growth, 85 
Henon, 103 
Logistic Hump, 111 
Logistic Pulse, 109 
Yorke, 100 

Charge, 60 
button, 61 
editor, 61 
random, 63 
switching, 63 

Circle Radius option, 74 
Circle shape, 201 
Clouds option, 165 
Club cursor, 58 
Color Cycle Once option, 214 
Color options, 214 

Auto Cycle, 21 4 
Color Cycle Once, 214 
Monochrome, 219 
Palette, 215 

Color palette 
default, 215, 218 
editing, 215 
extending, 219 
preset, 215 
random, 215 
saving and loading, 217 

Color value, 184 
Coloring option, 137 
Computation, 72 

lively mode, 72 
physical mode, 72 

Contour Options menu, 163 
Smoothing, 163 
Wrapping, 163 



Cubic Connectedness Map, 40, 42 
Cubic Ju lia 

option, 33 
sets, 22,43 

changing shape, 36 
partly disconnected, 33 

Cubic Mandelbrot 
option, 33 
sets, 22, 43 

changing shape, 36 
Curren t map, 130 
Cursor 

club, 58 
movement 

Chaos Game, 126 
Magnets and Pendulum 52 
Mandelbrot Sets, 25 ' 
Strange Attractors, 89 

select 
Mandelbrot Sets, 29, 39 
Strange Attractors, 87, 90 

zoom 
Mandelbrot Sets, 24, 27, 39 
Strange Attractors, 91 

Cursor Mode option 
Mandelbrot Sets, 39 
Strange Attractors, 113 

D 

Default palette, 215 
changing, 218 

Delete Map button, 1 36 
Determ mode, 190 
Determ inistic mode,See Determ mode 
Device drivers, 5 
Diamond shape, 201 
Display mode 

angles, 132 
change, 131 
matrices, 132 
triangles, 1 32 

Dither option, 1 62 
DOS, quitting to, 1 7 
DXF, saving files, 1 70 

E 

Eat 
Determ mode, 1 90 
mathematics, 204 
Max Eat parameter, 190 
parameter and mode, 189 
rule, 188 

Eating 
definition in Tube rule, 195 
parameter, 197 

Elevation option, 164 
Entry fields, 14 
Environment space, 7 
Equalize button, 1 36 
Equipment 

optional, 5 
required, 5 

Exit button, 16 
Exiting 

CHAOS, 16 
full-screen rendering, 167 

F 

Fast mode option, 1 99 
Feathers fill type, 34, 47 
Feigenbaum, Mitchell, 86, 110, 121 
Fi le menu, 209 
Files 

animation, 169 
batch, 8,9 
default palettes, 218 
DXF, 170 
FL!, 169 
GIF, saving, 212 
GIF, viewing, 213 
parameter, loading, 212 
parameter, saving, 211 
rendering to, 167 
saving and loading, 209 

Fi ll types 
Blank, 34 
Bullseye, 34, 47 
Feathers, 34, 47 
selecting, 34 

Flatland, 145 

Index 229 



FLI files, 169 
Flock, 139, 143 
Flock Size parameter 

Henon, 102 
Henon Horseshoe, 104 
Lorenz, 95 
Yorke, 98 

Fly view, 95 
Force Type option 

Inverse Linear, 72 
Inverse Square, 72 

Forgery 
Contour Options menu, 163 
displaying, 159 
image area, 159 
Mounta in Options menu, 164 
parameters, 155 
Planet Options menu, 161 
selecting type, 159 

4D Cursor Tracking option, 40 
4D Slice option, 40 
Fourier sum, 157, 171 
Fractal, 82 
Fractal Dimension, 150, 155 
Fractal forgeries, 149 
Fractal types, selecting, 30 
Frame Stamping option, 165 
Frequency (Freq) parameter, 65 
Friction (Fric) parameter, 65 

G 

GIF 
saving files, 212 
viewing image, 213 

Gleick, James, 4, 221 
Gl iders, Life version of NLUKY rule, 191 
Globe option, 162 
Grid lines option, 199 

H 

Haulers, Brain version of NLUKY rule, 192 
Height parameter, 156 
Help, 10 

button, 11 
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exiting, 12 
searching text, 12 
Technical Support, 2 

Henon attractor, 84 
description, 101 
mathematics, 116 
points, adding and removing, 90 
tweaking, 102 

Henon Horseshoe attractor, 83 
descript ion, 103 
mathematics, 11 7 
points, adding and removing, 90 
tweaking, 104 

Henon, Michel, 83, 101 
Hiding 

definition in Tube rule, 195 
parameter, 197 
setting to black, 196 

Hodge 
Inc parameter, 188 
Number parameter, 187 
parameters, 186 
rule, 184 

color changes, simplifying, 184 
color value, definition, 184 
color values, discovering, 185 
computation, performing, 186 
mathematics, 203 

Hour option, 161 
Hump, 85 
Humpspot parameter 

Logistic Hump, 112 
Logistic Map, 107 
Logistic Pulse, 109 

I 

I parameter (iteration count), 37 
Icecaps option, 162 
Icons 

Chaos Game map, 1 38 
program, 9 

IFS (Iterated Function System), 132 
Image area, moving in 

Chaos Game, 126 
Magnets and Pendulum, 52 
Mandelbrot Sets, 25 
Strange At tractors, 89 



Inc parameter, 188 
Increment button, 133 
Installing CHAOS 

floppy disks, 6 
hard disk, 6 

Inverse Fourier transform, 172 
Inverse Linear, 72 
Inverse Square, 72 
Iterated Function System, 1 32 
Iterated processes, 20 
Iteration count, 37 

J 
jacob's Ladders, Brain version of NLUKY 

ru le, 192 
jazz 

condi tion, 197 
definition, 195 

julia 
option, 31 
sets, 21 

changing shape, 36 
connected, 21, 31 
disconnected, 22, 31 
mathematics, 43 

julia, Gaston, 21 

K 

K parameter, 195 
Keyboard shortcuts, 15 
Klein world shape 

L 

illustration, 99 
mathematics, 1 1 7 

L parameter, 195 
Layout 

changing, 66 
circle radius, 74 
layout 1, 53 
layout 2, 54 
layout 3, 54 

layout 4, 55 
layout 5, 55 
layout 6, 56 
layout 7, 56 
preset, 52 

Length option, 73 
Live-action stamp, 87 
Lively mode, 72, 79 
Load Shape option, 200 
Loading 

animat ion (FU) files, 1 70 
color palette, 21 7 
files, 209 
GIF files, 213 
parameter files, 21 2 

Logistic attractors, 84 
Logistic Hump attractor, 86 

description, 110 
mathematics, 1 19 
point, changing in itial value of, 91 
tweaking, 111 

Logistic Map attractor, 86 
changing to Logistic Pulse, 91 
description, 105 
mathematics, 118 
tweaking, 106 

Logistic Pulse attractor, 86 
description, 107 
mathematics, 1 19 
point, chang ing initial value of, 91 
tweaking, 109 

Logo shape, 201 
Lorenz attractor, 82 

airplanes, 94 
airplanes, adding and removing, 90 
description, 94 
ears, defin ition, 94 
mathematics, 115 
tweaking, 95 

Lorenz, Edward, 82, 94 

M 

Magic numbers, 75 
Magnet radius (Rad), 64 
Magnets, 49 

capturing, 58 
changing charge, 60 
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Magnets (continued) 
changing layout, 66 
charge editor, 61 
circle radius, 74 
deleting, 67 
inserting, 67 
layout 1, 53 
layout 2, 54 
layout 3, 54 
layout 4, 55 
layout 5, 55 
layout 6, 56 
layout 7, 56 
moving, 67 
preset layouts, 52 
radius, 64, 76 
random positions, 66 
starting the bob, 58 

Main menu, CHAOS, 8 
Mandelbrot 

option, 31 
set, 19, 43 

Mandelbrot, Benoit, 20, 121 
Map option, 162 
Maps, 129 

adding, 136 
current, 1 30 
deleting, 136 
icons, 138 
tweaking, 130 

Math coprocessor, 5 
Mathematics section 

Chaos Game, 143 
Fractal Forgeries, 171 
Magnets and Pendulum, 74 
Mandelbrot Sets, 42 
Strange Attractors, 114 
Toy Universes, 202 

Matrices display mode, 132 
Max Eat parameter, 190 
Memory, 170 
Mesh Size, 157 
Minus buttons, 14 
Mode 

lively, 72 
physical, 72 

Mode locking, 83 
Mono coloring type, 147 
Monochrome option, 219 

Index 

Mountain Options menu, 164 
Azimuth, 164 
Clouds, 165 
Elevation, 164 
Screen Limit, 164 

N 

N parameter, 194 
Negative charge, 63 
NLUKY 

parameters, 194 
rule, 190 

Brain version, 192 
color states, 190 
K and Y parameters, 195 
Land U parameters, 195 
Life version, 191 
mathematics, 204 
N parameter, 194 
stimulus, 190 

Normalize button, 1 36 
Number parameter, 184, 187 

o 
One map coloring type, 147 
Options menu 

Chaos Game, 137 
Fractal Forgeries, 160 
Magnets and Pendulum, 68 
Mandelbrot Sets, 37 
Strange Attractors, 112 
Toy Universes, 198 

Other Options menu, 165 
Frame Stamping, 165 
Parameter Stamping, 165 

Outriggers, Brain version of NLUKY 
rule, 192 

Overlay coloring type, 148 
Overlaying a shape, 201 

-
-
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p 

Pa lette 
changing default, 218 
default, 215 
edit, 215 
preset, 215 
random, 215 
saving and loading, 217 

Palette Editor, 215 
Panning 

Chaos Game, 128 
Mandelbrot Sets, 28 
Strange Attractors, 92 

Parameter Stamping option, 165 
Parameter status line, 41 
Pendu lum See Bob 
Period doubling, 110 
Period two, 105, 107 
Periodic orbit, 103 
Periodicity, 107 
Physica l mode, 72, 79 
Pi leup coloring type, 147 
Planet Options menu, 161 

Dither, 162 
Hour, 161 
Icecaps, 162 
Projection, 162 
Rotation, 162 
Season, 161 

Plus buttons, 14 
Population growth, 85 
Positive charge, 63 
Power Factor, 156, 174 
Power scaling, 174 
Preset images, viewing in Mandelbrot 

Sets, 29 
Preset pa lette, 215 
Probability, changing, 135 
Product coloring type, 148 
Projection option, 162 

Globe, 162 
Map, 162 

Projective world shape, illustration, 99 
Pull Force, 65 
Pulse line, 107 

Q 

Quitting to DOS, 1 7 

R 

Rad parameter, 64 
Random charges, 63 
Random palette, 215 
Random Positions of magnets, 66 
Randomizing 

Chaos Game, 1 34 
Fractal Forgeries, 158 
Strange Attractors, 101 
Toy Universes, 180 

Rendering 
an image, 166 
ex iting full-screen, 167 
Screen Colors option, 167 
to fi le, 167 
to screen, 167 

Replacing a shape, 201 
Resetting 

Magnets and Pendulum, 60 
Strange Attractors, 101 

Reversing time direction, 70 
Ribbon Erase parameter, 96 
Rotation option, 162 
Rucker, Rudy, 22, 222 
Rudy 

option, 32 
set, 22,47 

Rul es 
defini tion, 182 
d isplaying, 180 

Run button 
Magnets and Pendulum, 59 
Toy Universes, 180 

Running a magnets simulation, 58 

s 
Sampling frequency, 65 
Saving 

Animation fi les, 169 
color palette, 21 7 
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Saving (continued) 
DXF files, 1 70 
files, 209 
FLI files, 169 
GIF files, 21 2 
parameter files, 211 

Sawtooth curve, 108 
Screen Colors option, 167 
Screen Limit option, 164 
Scroll bars, 11 
Scroll box, 11 
Sea Type option, 199 
Season option, 161 
Select cursor 

Mandelbrot Sets, 29, 39 
Strange Attractors, 87, 90 

Sets, displaying, 24, 29 
Shape 

menu, 200 
mode, selecting, 201 

Shortcuts, 15 
Simulation 

erasing trails, 59 
resetting, 60 
running, 58 
running in steps, 59 
slowing down, 59 
speeding up, 59 
stopping, 59 

Slider bars, 15 
Smoothing option, 163 
Sound option 

Magnets and Pendulum, 69 
Mandelbrot Sets, 39 
Strange Attractors, 11 3 

Spectral synthesis, 1 72 
Square shape, 201 
Stamping option, 11 3 
Stamps 

Chaos Game, 123, 128 
Mandelbrot Sets, 24, 26 
Strange Attractors, 87, 90 

Starting CHAOS 
from floppy disks, 9 
hard disk computer, 8 

Status line 
Mandelbrot Sets 

parameter, 41 
track, 41 

4' 

234 Index 

zoom box, 28 
Strange Attractors, 88, 93 

Step button 
Magnets and Pendulum, 59 
Toy Universes, 180, 182 

Stimulus, 190 
Stop button 

Magnets and Pendulum, 59 
Toy Universes, 180 

Strange attractors, 81 
displaying, 88 
Henan, 83, 101 
Henan Horseshoe, 83, 103 
Logistic Hump, 84, 11 0 
Logistic Map, 84, 105 
Logistic Pulse, 84, 107 
Lorenz, 82, 94 
Yorke, 83, 97 

Sum coloring type, 147 

T 

Technical support, 2 
Terminate-and-stay-resident (TSR) 

programs, 5, 170 
Terms, 157 
Three sum coloring type, 148 
Time direction, reversing, 70 
Torus world shape 

illustration, 99 
mathematics, 11 7 

Toy universes,See Cellular automata 
Trace Erase option, 73 
Trace Length option 

Magnets and Pendulum, 73 
Strange Attractors, 114 

Trace option 
Chaos Game, 139 
Magnets and Pendulum, 73 

Trace Type parameter 
Henan, 102 
Henan Horseshoe, 104 
Yorke, 99 

Track status line, 41 
Trails in Lorenz attractor, turning off and 

on, 9 7 
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Triangles 
display mode, 1 32 
editing, 140 

Tube 
parameters and condition, 196 
rule, 195 

Alarm parameter, 197 
Eating parameter, 197 
Hiding parameter, 197 
Jazz condition, 197 
mathematics, 206 

Tweak menu 
Chaos Game, 129 
Henon, 102 
Henon Horseshoe, 104 
Logistic Hump, 111 
Logistic Map, 106 
Logistic Pulse, 109 
Lorenz, 95 
Mandelbrot Sets, 34 
Yorke, 98 

Two map coloring type, 147 
Types menu 

u 

Mandelbrot Sets, 30 
Strange Attractors, 94 

U parameter 
Mandelbrot Sets, 34, 36 
Toy Universes, 195 

Universali ty principle, 11 0 

v 
V parameter, 34, 36 
View parameter, 95 
Viewing 

w 

animation, 170 
GIF image, 213 
preset Mandelbrot images, 29 

W parameter (window width), 35 

Weight, 122 
changing, 135 
editing mode, 139 
editor, 135 

Window 
changing position, 35 
changing width, 35 

World Shape parameter, 99 
Wrap option, 200 
Wrapping option, 163 

x 
X parameter, 35 
X Shift parameter, 100 
X-axis view, 95 
X-rotation parameter, 132, 144 
X-scale parameter, 133, 144 
X-trans parameter, 133, 145 

y 

Y parameter 
Mandelbrot Sets, 35 
Toy Universes, 195 

Y Shift parameter, 100 
Y-axis view, 95 
Yorke attractor, 83 

descript ion, 97 
mathematics, 11 7 
points, adding and removing, 90 
points, wrapping, 99 
randomizing, 101 
resetti ng, 101 
tweaking, 98 

Yorke, James, 83 
V-rotation parameter, 133, 144 
Y-scale parameter, 133, 144 
V-t rans parameter, 133, 145 

z 
Z-ax is view, 95 
Z-buffering, 175 
Zhabotinsky, A. M., 177 
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Zoom box 
Chaos Game, 127 
Mandelb rot Sets, 27, 28 
Strange Attractors, 92 
Toy Universes, 182 

Zoom cursor 
Mandelbrot Sets, 24, 27 
Strange Attractors, 91 

Zooming 
Chaos Game, 127 
Mandelbrot Sets, 27 
Strange Attractors, 91 
Toy Universes, 181 
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"Chaos is a feast . .. a welcome 
history and overview of this 
brand-new subject." 
-Washington Post Book World 

"Fascinating . .. Chaos is a science 
of everyday things-of art and 
economics, of biological rhythms 
and traffic jams, of waterfalls and 
weather ... Mr. Gleick is a skilled 
science reporter and his writing 
is always clear and sometimes 
brilliant." - New York Times 

"Beautifully lucid . .. Gleick has a 
novelist's touch for describing his 
scientists and thei r settings, an 

"Clear and accurate . ... Vivid 
and insightful ... An ambitiolls 
book that deserves wide 
readership:' 

- Chicago SUrl -Times 

"The first popularly 
written book about this 
fascinating, rapidly growing 
discipline:' - Boston Globe 

At bookstores now, or order by 
sending $11.95 for each copy, plus 
$1. 50 for postage and handling, 
to Penguin Books, Box 999, 
Bergenfield, NJ 07621-0999. We 
cannot ship outside the US or to 
post boxes. Allow 4 weeks. 

eye for the apt analogy, and a 
sense of the dramatic and the 
poetic." 

-Scm Francisco Chronicle 

For the best in paperbacks, look for the P£NGUIN @ 
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